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FETIL4ELTCHREAROBERMN R ONIHZEE. RIS
aﬁ’&lﬂé&*ﬂ@"‘*@ﬁﬂﬁj’*ﬂi?

o WEIFREBEENIXRINTVWBIRETIE., COEET

DRENTETIZFTEREVZUNDBRIFIITES
Th,

o AEIFHRPREDORELZBROAN/EBFRLE<REF
3’%71&)[; Ju %T@/{E%Wﬁ LT \'\353_

BETS

RINFZER

ET B
R ABOZHIIC. ERFEEICEHET.
Project 25 —49 ABH CEABMEDRELIT

WET,

& Project s 4512
Frequency/Scan Imager Scan
59.94P FF
Codec Video Format
XAVC-I 3840x2160P
Rec Function
Off
Simul Rec
Off

Title Prefix Number

000_ 0001

Shooting Mode
Custom (709)

RAW Output Format

BREE—bR

AETIE. RIFCEECREBDOEYCHNTES
FCustomE—Ry &, RRNFOFI >3V 0E
ZHiRE L. RBTIREEYEZTODRVWIT LA
HASERZFDOFEVNHTEMTESBCine EIE—RY
EYVEZTERATEET,
Project X7 —4%Z®MShooting Mode
(15R=2) TYWEZ £,

[XE]

TILAZa—DProject A = 1— >Base Setting®d
Shooting Mode(83R—) THRETEET.

CustomE—R

REE—RDCUStoME—RDETIE, IR
BERIZENTEET,

TILAZ a—DProject A= 21— >Base Setting
MTarget Display(83R—3) THIWEZ £

7.

e SDR(BT.709) : HDRED R [CHE LTRSS
o HDR(HLG) : Rt D AKX DIRIG (22 U 1=

?E =74

ZOMEFMIIS6 R—IETEIETL,

Cine EIE—R

REE—RHCne EIE—RDE&EIF, RBFES

BLUHAEBTOR- &2 EEERIRLE

9, ZZTERLEBEAMLUTZOFfICEREL

g HOBHEGY £,

TILAZ a—®DProject A= a1—>Cine El

Setting®Color Gamut(84R—<) THIY

BRET,

e S-Gamut3.Cine/SLog3 : TI9ILIXID
&35 (DCIP3) ADFAEHA LT VES

e S-Gamut3/SLog3 : VZ—#BE®ITU-R
BT.2020% H/\—¢ 3LV &1

FOMEMIEISER—IETEL TV

[TEE]
e Cine EIE—RTIEHUTOHIKMNGEY T,
o BEFHCER) TRV R
— RTINSV
—TA>
— vy —
o BREXETTFHVHEEE
—ISORE /71 >V (BEISORE CEE)
— Paint/Look* = 21— D& E(Base Look%R<)
—Scene File(#&%h)
o UTO##EEXCine EIE—RTODHERTIRETT
(58:—3),
e Exposure Index
e EZ4H—LUT

2T L ERE

Project X7 —4 XMFrequency/Scan
(15R_=3) TYIWEZFT, REMBICLOT
(F. YIWBREETT2EAHHBENICEL
BLET,

[AE]

TILAZa—DProject A Za1— >Rec Format®d
Frequency(83/R—%) THRETEXT.

[ZEE]

B8R - BAERCIRTLARBZYIVERZZLETEE
‘A,

AA=—D v —FvVE—N
AA=T L —OEME T A XL REEDER
EETVET,

Projectx5—4 Z®Imager Scan(15_—
J) TYIWEBZET,

o FF: I B4 XTHERALET,

e S35: Super35mmyU A/ X THEALET,

[AE]

TILAZa—DProject A Z 21— >Rec Format®Imager

Scan Mode(83R—) THRETETET.

[ZEE]

o R BEPIAA-Iv—IFrYVE—REYWVERS
ZERFTEEEA

o S35M&E, EFAT4—T v hIE1920X 1080 ICHIBR
INET.

dA—F w7

Project25—4 Z2®MCodec(15_—
WEZET,

[AE]

TILAZ 2—DProject A= a1— >Rec Format®Codec
(83R—Y) THRETTET,

[TEE]

KR -BEPICI-FTyIEYYBRZZLETTERA.

J) Tl



26 | 28 Efm: AMOERIEEZRETS

EFA T4~ wh

SR ITBIETA T4 —VYNDREETVET,
Project 257 —4 2 ®Video Format(15X—
J) THIWEZ X,

[AE]
TILAZ 2—DProjectA = 21— >Rec Format®Video
Format(83_—3) THLERETT*T,

[TEE]

o IR - BFERICETHIA—TyhEYIVEZBZZ L
TEEtHA.

o EFATA—TYRDEREICLDT. SDIOUTH LU
HDMI OUTIRFHh S DESEHIRINET,
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AEV—H—FK =Z&ES

AT, RELCHYE - FF%E. h—RKXOvADCFexpress Type AXE —h—R(BIFE) /=
[ZSDXCAEY—H—R(RITE) ICERFLET, Tl TOFIRER. REANBORE -SiHHLE. §
kON=T3>TPvI(VIRNIITFTPYvTTF—RN) BICEINSOAE)—H—KREFALE,

CFexpress Type AXE—H—KICDWVWT
AHETIE, THEATAT7ICDWVTY (28R—) [CEREHENDY Z—RCFexpress Type AXEY—H—
R&ZEARETL.

B AT A POEEICDOVTIE. BHAT 4 POEIRGBHAZEOA—H—BRE THERIETV,
* KETIECFexpressh—RERBELTVWET,

SDXCAE!—H—KIEDWVT

AETIE, THEATATICDVT] (28R—2) [CEREHEDSDXCAEY —H—R*&2ZFEALLLE TV,
*ARETIISDH—REREBELTWVWET,
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28 Efi: AE—-H—KFEES

WREAT A FICDWVT

EN{ERELE A (ZRec Format{>Recording

Yes : BifF = {RaE
No : fREEL7ZW

REICLO>TERYET,

EFETA -V Y CFexpress SDXC
Type A

VPG400 Class10 U1 u3 VSC VSC VSC VSC
V10 V30 V60 V90
RAW Out & 4096x% 2160 Normal mode 59.94pP Yes No No No No No No Yes
XAVCI Class300 50P Yes No No No No No No Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
24P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes
3840X%2160 Normal mode 59.94pP Yes No No No No No No Yes
Class300 50P Yes No No No No No No Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes
S&Q(60fpsAT) 59.94P Yes No No No No No No Yes
50P Yes No No No No No No Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes
S&Q(100fps. 120fps) 59.94p Yes No No No No No No No
50P Yes No No No No No No No
29.97P Yes No No No No No No No
25P Yes No No No No No No No
23.98P Yes No No No No No No No




29 28 HEfF: AEU-H—-FZ=EDS

ST+ —V vk CFexpress SDXC
Type A

VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 V90
XAVC-| 4096X%2160 Normal mode 59.94pP Yes No No No No No No Yes
Class300 50P Yes No No No No No No Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
24P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes
S&Q(60fpsATF) 59.94P Yes No No No No No No Yes
50P Yes No No No No No No Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
24P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes
3840%2160 Normal mode 59.94pP Yes No No No No No No Yes
Class300 50P Yes No No No No No No Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes
S&Q(60fpsUT) 59.94P Yes No No No No No No Yes
50P Yes No No No No No No Yes
29.97pP Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes
S&Q(100fps. 120fps) 59.94pP Yes No No No No No No No
50P Yes No No No No No No No
29.97P Yes No No No No No No No
25P Yes No No No No No No No
23.98P Yes No No No No No No No




30 28 #Efg: A®U-—H—REES

ST+ —V vk CFexpress SDXC
Type A
VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 V90
XAVC-| 1920X1080 Normal mode 59.94P Yes No No No No No Yes Yes
Class100 50P Yes No No No No No Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No Yes No Yes Yes Yes
S&Q(60fpsITF) 59.94P Yes No No No No No Yes Yes
50P Yes No No No No No Yes Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes
S&Q(100fps. 120fps) 59.94pP Yes No No No No No No Yes
50P Yes No No No No No No Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes
S&Q(150fps. 180fps) 59.94pP Yes No No No No No No No
50P Yes No No No No No No No
29.97P Yes No No No No No No No
25P Yes No No No No No No No
23.98P Yes No No No No No No No
S&Q(200fps. 240fps) 59.94pP Yes No No No No No No No
50P Yes No No No No No No No
29.97P Yes No No No No No No No
25P Yes No No No No No No No
23.98P Yes No No No No No No No




31 28 #EfF: AE®V-—DH—R%EFES

ST+ —V vk CFexpress SDXC
Type A

VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 V90
XAVC-L 3840X%2160 Normal mode 59.94P Yes No No Yes No Yes Yes Yes
420 50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No Yes No Yes Yes Yes
S&Q(60fpsITF) 59.94P Yes No No Yes No Yes Yes Yes
50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No No Yes
S&Q(100fps. 120fps) 59.94P Yes No No No No No Yes Yes
50P Yes No No No No No Yes Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No No
1920X1080 Normal mode 59.94pP Yes No No Yes No Yes Yes Yes
HD50 50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No Yes No Yes Yes Yes
S&Q(60fpsUATF) 59.94pP Yes Yes Yes Yes Yes Yes Yes Yes
50P Yes Yes Yes Yes Yes Yes Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No Yes No Yes Yes Yes
S&Q(100fps. 120fps) 59.94pP Yes No No Yes No Yes Yes Yes
50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes




32 28 Efj:AEUY-—H-—REES

ST+ —V vk CFexpress SDXC
Type A

VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 V90
XAVC-L 1920X1080 S&Q(150fps. 180fps) 59.94p Yes No No No No No Yes Yes
HD50 50P Yes No No No No No Yes Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes
S&Q(200fps. 240fps) 59.94pP Yes No No No No No Yes Yes
50P Yes No No No No No Yes Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes
1920%1080 Normal mode 59.94pP Yes Yes Yes Yes Yes Yes Yes Yes
HD35 50P Yes Yes Yes Yes Yes Yes Yes Yes
29.97P Yes Yes Yes Yes Yes Yes Yes Yes
25P Yes Yes Yes Yes Yes Yes Yes Yes
23.98P Yes Yes Yes Yes Yes Yes Yes Yes
S&Q(60fpsUT) 59.94P Yes Yes Yes Yes Yes Yes Yes Yes
50P Yes Yes Yes Yes Yes Yes Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No Yes No Yes Yes Yes
S&Q(100fps. 120fps) 59.94P Yes No No Yes No Yes Yes Yes
50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No No No No Yes Yes
S&Q(150fps. 180fps) 59.94pP Yes No No Yes No Yes Yes Yes
50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes
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28 Efi: AE—-H—KFEES

EF;TA—V vk CFexpress SDXC
Type A

VPG400 Class10 U1 u3 VSC VSC VSC VSC
V10 V30 V60 V90
XAVC-L 1920x1080 S&Q(200fps. 240fps) 59.94P Yes No No Yes No Yes Yes Yes
HD35 50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No No Yes
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AEY—h—FZANS

1 H—kzOvrBOAF«FEEEITS,

2 AEU-H—REELAG,
o CFexpressh—RDIFEIESINILEEIC

7

i,

o)

i

==t

=

SARJL
o SDH—RDZFEIESNILEGICLTYIY
REPETICT S,

T
%g-fj

E_[
fiith
YW REH

FIERSVF(6R—) HR<EITL.
FERTTRERIRREICHZ LB THRITLET,

(7

=
L

i

)

[TEE]
FUERZVTOFVRADNRSBETRRUTICAS K
WSS, —EEREVIUAE)—h—R2kREEL
TBZET BRITICBDAREMENSYET.

3 AFTEEEDS.

[TER]

o RoAITTHREICANSG L, AEU—H—RPAEY—
H—Rz20v bk, B&ET—-IDNRIBTZZENBHYET.

e CFexpress Type A/SDAh—RZOw (A) /(B) mAIC
AFAPEBALTCEREZTOIRICE. £55020Y
NZH, EBRTZ 74—y NTHLUTEMEDHRE TN
TVBATATEBALTLREETL,

AE)—H—RZEWHET

H—R2OYREBOAFT A 7EZRIT. AEU—
H—RE@ENERLTERYELET.

[T5EE]

o AEY—H—REFIERPICAEOERET>fUA
EU—H—RERVIBERIT Y IRIETNE A,
H—RERBINLTRTOT—IHNENZATREE NS
WEY., BREYIoRY. h—REKRSEEF. HTFE
BIBZAE)—H—ROFPI ISV THRTETF:
[FHTLTWBZEAHBRLTHSBRIELTLIET W,

o MM TRICAE)—H—RERYEHLEE, AEY—
H—RHBLIG>TVWBRIBENSY EFTHBETIEHY
FtA.

AEU—H—KRZTH+—T vk
(#18A1k) 9%
T4y RENTOROREY—H— R, Ek

FRIDAETTIA -y hEINEAEY—H—R
HEETDZE. AvtE—ITT53—vHRER

AFA P TCTINE1—T 7 VY —BEHEICKTT
nxtd.
TEOFEICH->TIA—IYRLTET W,

1 Iux=2—0TC/Mediax=2—0
Format Media(92R—<) #&IRT 3.

2 Media(A) (zOv RA) 7z lEMedia(B) (2
OwkB) ##RLT. 74— w~&ERI(Full
FormatzZ7z13Quick Format) Z#iR7 3,
EERAVvE—INRREINET,

e Full Format : AF ¢ 705 — 4 BB ER
R ThH<FT -9 B2 502452 1Et
L9,

e Quick Format : AF 4 7DF—49 ERE
HAEMEMELE T,

3 ExecuteZ:EIRT 3,
KTPEAYE-—IHRRREIN. PV/EXS
STHRLSAITLET,
TA—IYvEHRTTEE BTAYE-Y
NERRINFITOT, WILFT7VI¥3aY
AL ERLTHELET,

[TEE]

e ATU—H—RETF—TvhrTBE, TRINBRE
F—4. CYRNFYTI7AINREEEL, TRTDFT—
SHEEINET,

o JA—TvhDUEBREICLOTIR., BTPOAYE—
IRRRINEVMBEANABYET,

T# =YY RTETEhoTcEETF

A TERTETRVWAET)—H—RET4—T v
KTEFEHA.
ZEAYE—INRRINETOT. Avt—
ICHEoT. FRATEZAEY—H—RIIKIBLT
TNV,

AEETTA—IYRNLIEAT o 7 EA
DR THERTBICIE

HohUHN\vI7vTH#EY, BEWVICKEZHE
B/CTIA—YvhLELTHERALTLETV,

5% ) DECER T RERS ) 2 HESS
EEC

R (R /ERFEP) X, Ea—T7r>
S—EmE(11R—) OA/BROY AT AT
REBRREPT, EAOYVRNCESLEAE)—
H—ROBREAMIRTZIENTEET,
REREINTVWBETH 74— v MEERE Y
AL —K) TIRE LB (CELIRTTRE RIS &
FNENOROY MADAT 4 PDEREHSEHE
LTHHMTRRLET,

AE) —H—RORIEEFEA

o SERPIC2MDAEY —H— RORELER T HERS
BOEFNNEZYZE. BEAYyE—ITA
T+ PHREHNDHTHNTT) (Media Near Full)
MBRINER/Y) -S> TDRBETY—
BNy RKRVHA) TEELET,
EBEDHIATAPICKIBELTLEET W,

o SCERA ML T, FRECERTIBERERIDEETH0
CiBE. Avt—IN AT PREHHY F
Al (Media Full) (ZE DY EEMNMEIELF
ERN

[ZEE]

MOAEY—H—RICHWE600BETDI )y TRERTE
9.
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28 Efi: AE—-H—KFEES

AE)—H—REEETS

ASHORETAE)—H—RADTF—Y CEE
HRELEGZRIE. AEU—H—ROEEHND
BICRYZET,
EBENBBEREAE)—H—REBALEEEIE.
BEEAETIZINESIHZHEETEIAVE-—IH
Ea—T74 4 —BREICERRINET,
BE=ZEITTS
TWNFT727aVF4VILER-D) T
ExecuteZ&EIRL. VILFT7>Iavd4y
LEHLET,
HRfThAyt—IEEBIRR(%) HRRIN.
POV RS Y THRLRITLET,
BEIMRTIZE. BTAYVE-—IHNKRRINE
ER

EBETETLOIIEETT

o IS—HRELLAEY—H—RIFMEETEE
Bh, EEAYET—IHRRRIINEZTOT. Ay
T—JILROTHIDAE)—H—RICIHELT
LTV,

o IS—NMRELEAEY—H—RIF. T4 -7V
FELETEBEFRTEZHALBYET,

o —ZDIVYTDHHNEETETHVIZELHY
=9, BETEL7)y I IBERREICAYE
7.

(2]

o AMTRBINLEATATIE, A TEELTIRE IV,

o FEUATRBINLEAT A7, FLA—ET
BoTEN—TIVHEEBUBTREINLATAT
4. AR THEETTRVEANRBYET,

o QMUTOIY v T IHEETEE VA,



ERRIEF

EXRNABRTIIROFIRTTVET,

1 pEngErmyATsn. BEARES
NTWBZEARRT S,

AEU—H—REANS,

POWERZA v F%0nICT 3.,
POWERS Y FHEITLT, Ea—T7AY>
H—ICIREBEIRRINET,

4 RESTART/STOPHRY V(5:—3) %
Y,
298/ — 5> THEITUT,
VET,

B 2L oF 3

5 agsrrozexa. 15—EamE
START/STOPHKY V&3 d,
SRS AMELE L. AHEIZSTBY(SRERISHE) £—
RicHYET,
[Z5xE]
BREANTHSEFURNICERBBSTART/STOPKRY V&
HIE EER/I)—SVTHRMTUSREIREEICAY £ T H,
BIRLTWBREHR T4 —T YN Lo TIIRVIOEFB IE A
FAPICERBINLEVEENHBYET,

AE—hH—KREZYYEZS
AEU—H—RH2ZBREEITNTVWS EF(E.
SLOT SELECTRY (6 R—) #IRLTHIY
BZEY,
BREPICAE)—H—RAFLEIAEY—H—K
B) DBRENG<ZZERIIC. BEMICES—H
DAEY—H—RADEZFICTIVEDLYEI()
L—iE8R). AEV—H—RHYgIWBDLBRUIC.
ERBFHOAEY—H—REFHFLOAES—H—
RICRHaT 22 & T P2 LB ER
Fonxtd,

[ZEE]

BEFRLCAE)—D—REZYWEBRZZLFTEEEA, £
20y AEZOY "B FCERBERTETE A

o9y I (ERT—9)
RREFLTZE. FELHSFELEEFTOEEG &
BEAET—9M 1D Iy S ELTAEY —
—NICER&RINFT,

7w FRICDNT

AW TEREIBIND V) v TOERTE. TILA
Za—OTC/MediaX=Za2—®DClip Name
Format(91R—2) THREITNLFERTDOH
5NET,

7))y TOBRAEE]

17Uy T &Y 6BMETTT,
BEOEFIRT TREREG. 7y TORKE
REFEERRTY. REREHV )Y TORKE
BzBz5mE. REZBELCEIEHHICH
LWy THESNET, HLWI Uy T YL
XAOVBEE TRy TELTHRTEET,

UL —RHRTIRIERDO Iy T IERRERLET
. K24KE THEENICFIELET,

[ZEE]

o LBFOAE)—H—RERYHIBVWTLLETV, 8
BFCAEV—H—REANEZZLEFE. 2OV AD
SYTHEILTVWEZOY hDOHFIToTLIET W,

o EBRFPDOAEN—H—ROFKENPRFEOEFIC. B
S—ADZOY N CERIFITELEAE)—H—RHAST
WBE, Ayt—ITFH4<20vMEHIVEZET
MERINET, AEU—H—RXOvrHEIWEDLS
EHRET,

o AEY—H—ROBRENDKRFEOELFICELRERDS
&L UL—EBNTIFRVGEENHYET, ULk
AIELLITOICIF. CCBREABEICAT)—H—ROEE
MU EHZZEABBLTIRETL,

o AifaFE->TL—RRLUELHEIT. A LETIEY—A
LZXBETEEEA.

o KiEFEoTL—RBRLLBEAKESTIICE. VT
ko 7lMCatalyst Browsel #FERALT T,

R zE<

ERINZBEEAYRKRYTCEZIY—TFET,
AYRKRVEEF(5R—) Ay REVED
BCEEBINZEFEZEZY—TTET, Fk.
BAER(69R—) FREIE—H— (6
R=Y) FlBFIANYRIKRVTEZY—TCEFT,
EZH—FBZBEOEEOFEE. AudioX
F—42Z0OVolume(14R—), FflFTIL
AZa—®OAudioX = 1— >Audio Output®
Volume(97R—2) TITVWET,
EZA-TBFvoXILOERIE. AudioXFT—
g ZMOMonitor CH(14R—2), £lFT)L
AZa—0OAudioX = a1— >Audio Output®
Monitor CH(97TR—2) TITWVWET,

FALT—4

YA LT—R2ZERETS

ERFEINBZIALT—RIE, TIAZ2—DTC/
MediaXZa—®Timecode(91R—) T
ELET,

1—HY—EvhEZERETS

StTm16EHE 1I—H—Ew b & UTERMRIC
tTcExd, 21— -y hERERFLICER
EIBZEHAHETY, TC/MediaXZa—®
Users Bit(9MR—2) THRELET.

HALT—9%RTTD

KRRITB94LT—RIlE. TC/MediaAZa—nD
TC Display(91R—=<’) @Display SelectT
BELET.
DURATION/TC/U-BITHRED EIY TSN T
BAFTILRY Y (51R—D) 2T &, TR
MIALT—R, 2—H—-Evh, FBIEEOIE
CYIWEBDYET,

SALT—RDAN/ EN=NVEZS

TCIN/OUTEIWEZ XA v F(4R—) T,
GALT—ROAN/EAEYVEZRZZENTF
*7.

HELLENMBR=IETELRL TV,
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3% &R EFREFEFIR

BB AR TA(LY Y
LEa1—)

BERIICER LIy TOBGZEE CHR
(LysLEa—) TEET,
(23]

RRBICETA I —TyhEEELLETE, Lyl
E1—-ETEEEA.

Ly LEa—DAE

BFIC T HAFTILRY > OWTNhIcRec
ReviewxEIWHETTHTET,

L& EIELT=5. Rec ReviewhE|WH TSN
FHAFTILRI U (51IR—Y) LT,
TB&. BRIlCEBRLEIVYTOBELKREY
¥7.

Iy TOEDYETHEETSE, LyILEa—
(F#&7T L. STBY(FLE#EH) E—RICRYET,

LyJLEa—%dutd3I(cid

Rec Reviewh BV Y TESNTHAFTILIKY
> F1zIZCANCEL/BACKRY > & LE T,

Lyl LE1—DHKRTE

Technical A= a1—®Rec Review(99R—

J) OFRECLY., BEMBAEEZXROWVWTNH
CRETTET,

o )y TDREDIF

o 7w IFDOREDION

o JYyTDEBEMS

[AE]

RELEEHOI )y THSERD I )y THIER LIV

5&1F. THUMBNAILKRY VA BLTHLRAILEEHLS
Iy TR BRUTBEARBRT I ENTEET,
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2~ L E TS

BREBRORRCIELT, Z—L%Z2RHMHLET.

BEIA-LLYXREELREE JUvTUE
AVFEFNYRILBOI—-LLN-TI—LIE
ENRTEEXT, LN—2BLATCERISLTZ—
LZE—RHZELLET,

AL, DEIRBHEEVSERLERAIC L
BA-LEEEABELTVEYT, SERBER

NTEBLICHYET, Fleo BEEZA—-LLY
A TRIARERBENSISICHFRENTEE

ER

PEFRERBRIA-LORKERI, CREKRE
CEWERYET,

o SCERMMBREQFHD/AKDEE 1 1.568

o SLIFFRREHDDEE : 21

X—LDTERZFE S

TILAZ a—®DTechnical A= 21— >Zoom®
Zoom Type(99R—3) TA—LDTEFEE K
ELET,

EETZLUVXDBEICL - TUTOLSICEL
YET,

EETSE Zoom TypeDHRE

L>X Optical Zoom  On(Clear Image
Only Zoom)

HESL LN—-C&EX— 2EZREHE

YX/FE LBFETELR A-LHNTES,

Z=LLY W,

=z

BEIA—L NEA-LDH HEI-LERE

L>X RBBREI—L1

NTE3,

[TEE]
o UTDIRE, 2ERBHREI-LIEIEZEFEA.,

- ZIAZa—DShootingA = 21— >S&Q Motion®
Frame Rate (81R—3) hi60fps%##BZ B & &

- TIAZa—DProjectA Z 21— >Rec Format®
Codec (83R—) TRAWZX /zIFRAWE F A T2
BIREK & BRER

o LYZXMOSERVO/MANUALYIVEZ 21w FAEYIVEZ
3L, REREBREA-LOBZRIMMECIEY RN

EXB

o DEFRBHF{EI—LFRIE. TH—HXT)F7HWidelc

BYFET, Fle. BE/IERBAFIEMCHRVET,

I\ RIVZA—L%ERETS

TILAZa—®DTechnical A Za—®OHandle
Zoom(99R—) T\ Y RILEBD X — L L/\—
DFREEITVET,

=L > DEER A% &
T3

—BOEY IRV TR, =LV VI DHE
EAMEMICTEIIENTEFET,

TILAZ a—®DTechinical A= a1—>Lens®
Zoom Ring Direction(100R—%) THREL
*7.
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T4 —HhRX %I S

BERORRICISGLT. 74—hHRzB8F
FHTHELET,

T4 —h2%FEALHT3(<
Za7ILTA—HhHR)

TA—hAEFHAETSZICE. FOCUSRAyF

(4R—2) #TMANJ ICRELEF T,

BERRICELT. FETI4—HIEDED

T*ET,

UTRoLSHBEFTHEVET,

o KEDL VB

o HEREIAVISZAMDFVEHER

o MM T A —HAZEFRIOREERNSERD
WERITEBZEE

[AE]

FHRAGEREAIRL—23VELT, F—hTA—h2%E

BYHCHHEZZEETEET,

o AFEYBYRERTER1(Locked)lcT3

o FOCUSRAwF%TAFIIZRET S
o TA—HRI DT HIRIETB(AF Assist, 41R—)

JA—h2&=B8EA8 93
(A—kT#—H2R)

AL, EREICENZMEEZEAFARE. UL
BETIF—hAEahE3ILICENZIV L
SAMAFARZRALTWVET,
INSD2DDAFARZEHEDESZZET. &
HE - SREAMIILcA— NI —h XAEER
LTWET,

T —h2=EEFHETSICIE. AEDFOCUS
R F(4R—Y) #TAUTO) [CERELF

T, LYZXCTA—AZRYVBZZA(vFhH3
IBARIFHSMEHTAF/MF) FFTAF ICREL
TLEEEW, TRull MR £2IFTMF OF&. LY
ZEAREENS DT+ —hIETREZHFTE A
(24~—2),

[AE]

TILAZ a—dDShooting A = 21— >FocusDAF Assist
(81R—) ZOnICH/ETBL. F—hIT#—HRFT
BLYADTA—HRAV VT TIA—HAEEHTIENT
R

[ZFE]

o F—hI7F—HRCHELIZLYIHBETT,

o RERRCLIVEBENHEWGENBYET,

o ARIVKLYZXTIR74—H2%ZBEAMTIH A,

F—RT#—HZDOXMRMEE /B %
BETB(T3—HZT)7T)

TILAZ a—dShootingA = 1— >Focus®
Focus Area(81R—) TH—RIT#—HZAD
WRETZBHERECTET.

Flexible Spot:
BUEOIBELIMBIC T+ —HREEDLEET.

BIR%E. YILFELYY— (TR—) T
BEIEELET,
VILFELII—ARIBLIZEHRDOMABICR
YEd,

AF

Zone:
BELRY-—VANSEEITI4—hREEHYE
BABEZELET.

BIR%. YILFELIY— (TR-Y) T
BEEELET.
VILFELII—%2RBLITZEPROMEICR
YET,

AF
r il
L J
Wide:

BFREN ST+ —H RGO EIUEERLE
¥, BERRINELA

AF

[AFE]

Focus Area% Y YTl 7 HAFTILKY > (51—

D) THEREBROEENFIRETT,

TILAZ a—DMonitoring A= a1— >Display On/Off®
Focus Area Indicator(93R—%) T, 74#—HhZ T
THRERTREON/OffFZ2ENTEET,

[TFE]

o JA—HI T THIEDISPLAYRY > TIFIERRICHY
FtHA.

o TERBMEIA—LFIF. WidebBYET,

TA—HIATVPHTIEPOLKEETS
(ZA—HhZtvR)

PHAFTILIRY > (51R—) ICFocus
SettingZ&|WH T3 L, REFLEICT—K
T#—hZADORRBFH(T+—HZAITVT) OfIE
PARETETEPLKEETEIENTEET,
TA—HAITVTOREICLVEMHENZE DY F
.

TILAZ a—DShootingAZa—
>Focus®Focus Area(81R—) H

Flexible SpotFfzl¥ZoneDF5E :
Focus SettingZE|W S TIFHAFTILRY >
EgE. ILFELIY— (TR-D) T
T#—HAIVTPDUBEREETZIENTEFE
ER

MBEEXERICIIINFELII—%TE, T+—
HZTVT7OMENPRIZRYET.

Focus SettingZE|W Y TIE7HAFTILRY >
HERBLIZETA—HAIVTFORFTTR2EE
FTRIENTEFET,

RKETEZLER. JILFLLI/I—%BTE
THA—HXITVTPDOAERFRELET,
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BREDEEHIRT LIS, Focus Setting%E|
WY TRETZYAFTILRY v EBLTITOBEEIC
RYUZET.

TILAZ a—DShooting A= a1—
>Focus®Focus Area(81R—) H
WideDig & :

Focus SettingZEIW Y TP HAFTILKRY >

DEFLICLZTA—HIATVTFOREETEED

HE[HET Y, TERI%Flexible SpotxfzldZone

CEEITNIE, BRI TUEZEELFRETT,

[XE]

o J)LAZa—mdShootingA = a— >Focus®Push AF
Mode(81XR—2) hiSingle-shot AF(AF-S)mD.
FOCUSZA v F(4R—3) KMFDIBA . Focus
Area(AF-S)(B1IR—=Y) DT #—HRTUTFPMERE
EIRIENTEET,

o PEXRBRBEA-LEREL. J4r—HIXAIVFORE
IFEINICARY ., PREEBELLAFBEICEYET,

o JA—HAIVT7DMUBEENTRELZEIF. 74—
AIUTERNALY VEBTRRINET,

TA—HAIVT7REY Y FIRIETH
TR YFIA—HIIV7)

Focus Setting%E|W Y TRT7HAFTILKRY >
(BIR—) R THRELTIA—HITUT
DERREZALYOTVICLIEESE, v FRIETRS
TEFT,

Sy FUIBFRET#—hA TV FOHLEL,
T#—HAITVT7DUEZBELET, KovJ
T3E. TH—HATIUFPDABIFIEDEEICE
rLTBHLETO0R-),

[AE]

IRIREE TldEFocus Setting&#BW Y TR YA+ TILKR
IYDBRIET. FyF I —hXBEOE - EhELY
BR3IENTEET,

FROMNEZYI YT TS

AT LIcBR T A#—HATUTFDHRLELT

UEZ%ETS

RSw I THREZBRL. 74—HRXTUTD

UEZ%ETS

<

<

e

[ZEE]

o JwTFEIFRSYI LEMBN I+ —HA T 7D
BEORTEHEEBRIZER. 74—HATVT7OMERF
HEHENO L TEERICEEINET,

o LUTDIRE, COMEEREZEFEA.

- ZIAZ a—DTechnical A = 2 —®DTouch
Operation (99 —) HOffDIRA
- THA—=HhATITRNT L —FIERROBZE

F—RI#—hZDEMEDF %3
(AFRS YTy aviRE, AFEYBY
)

AFRNS YOI avEE

TILAZ a—DShooting A = 31— >FocusDAF
Transition Speed(81R—3) T, WEHH
BUEDZIBEO T —HABHORTZHRET
BIENTFET,

ERAICERET B EWBEROBYEDYEIC
oY ETA—HZEY L. EIRIITERIFRIR
ZAREICLET,
BIRMAICERET D EWERBDT # —H XY
NTIEPLIEYVET, TL—LICATEBHEBEIRIC
ITLIETA—HADESOT, TIEPVWIF—H
AEDEHRERINZRFaAVI)—REHE
IR TYT,

BOWEKRICEELTWVWS

o N
[

FBYH
TER) : 74 —HZADD > WEL

NBE) : 74 —HANT EB LB

A%

FHIOWERICEE

L —
il
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AFEYRBYRKE

TILAZ a—DShooting A= 21— >FocusDAF
Subj. Shift Sens.(81R—%) T, WEHD
RUBYREARETZIENTETET,
MBRCHRETZETA—HADE>TVWEEE
EOFICRIDWBENRTHT 4 —HIANBYIC
<KLiY), BMRAAICERE T2 EFHIlCRIEEER
EBELTIA—HADBYPTIHRYET,

[AE]

AF Speed/Sens &Y YT 7HAFTILIRY > &IRT
U, AZBEOLANILN—DBUTDIETR I N, AF
RSV IVavRELAFRYBYREDOREAZEECEE
ER
AFRSY I3V RESAFRYBYRESERT - - -

AF Subj. Shift Sens.: 1(4-3)

o N
I

ROWEIRICT #—HZA DT <\

AF Subj. Shift Sens.: 5(&U&)

i

ROWERICT # —HZADFEYHTN

FENTIF—HAHREE
9 3(AF Assist)

TILAZ a—DShooting A = 21— >Focus®DAF
Assist(81R—3) #OnICERET B &, 4—
NIA—HZFTELYZADTA—HRI VT %
ELTEROWEERIC T —hREEDESRZE
NTEXT,

TF—hZAV VI DRFEILDDE. TH—HR

VY TEDLEIEHERICA— NI+ —hRALZE

T(AF7 R NREE).,

TILAZ a—DShootingA = 1— >Focus>AF

Subj. Shift Sens.(81R—2) MREICED

57, TA—HAVVTRFRIE T+ —hADFE

WRBYICKKBYET,

UToma. AF7YZANRESBEIRINET,

o JA—HAUVITELEEERERL S
&F

o Y- aTINTHr—HRICLIEEE

o REBRLIEE

[XE]

e Push AF/Push MFAEIW Y TSN=F7HA1FTILiKS
Y(BIR=D) HES & AF7IRANRERRELE
PRTEET.

o JA—HAVVIRBIETEE. BREDERIERS
nxvd.,

o B/IBREAFDIZE. T4 —HRIVIEEHETBE—
FIEVERICA—RT 4 —HALET,
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—BEICFEETIA—HIE
BbhtE3(FTvav=arIL
TA—H2R)

ZF—bh7#4—hXHIC, PUSH AUTO FOCUS/R
G R=J) =RTE, ZORY VERL
TWABIEFYZa7IT4—hRICHEYET,
RIS IERRETE. A—RT74—HRIZRY
¥7.
WEAROFHIZRENRTHEVLOHEYZ &
FRER, —RHICA— T A—HhREILHTF
ETCIA—HhRAEGDERIENTEFET,
[AE]

Push AF/Push MFOEIW L TESNETHAFTILRY >
(51R—=%) THERABOHENTRE T,

—BFRNICEE T4 —HX
HEhbE3(FTyvyaxa—b
T4+ —HhZ(AF))

TILAZ a—DShooting A= 1— >Focus®
Push AF Mode(81R—%) TAFEZEIRL.
JZa7IT7A—hZHICPUSH AUTO FOCUS
RYV(AR-Y) BRTE, ZORY V&R
LTWBREIEA— T4 —hRICEYET,
TILAZ a—DShooting A= a1— >Focus®
Focus Area(81R—>) TRELIET7#—H
AIUPRHNTIA—HZAZEDEET.

R UhSigEHTE. YZaTPINTF—HAIC
RYZET,

YZa7NT+—hARIC. BEIEEAERHSHIOD
WERICH>KWETA—HREYTBLD45
BICETT.

[AE]

Push AF/Push MFREIW Y TSN 7 HAFTILRY >
(51R—2) THLREFKOEELETRETT,

[ZEE]

LYXBITIZaFITA—HACRETNTWVE E, Ty
SaFd—RIF—hAIEIELEEA.

ALRICEBFTIA—HAEE
HbE3(Fyvoatr—KTx4—
HZ(AF-S))

TILAZ a—DShooting A= 1— >Focus®
Push AF Mode(81X—%) TSingle-shot
AF(AF-S)%&2RL. TILAZa—dDShootingA
—a— >Focus®Focus Area(AF-S)(81R—

V) TITA—HREHHOEBMERRELET.

YZaF7ILT#+—HhXHICPUSH AUTO FOCUS

RYVERTE, RERTA—RT+—HREITV

£9, b, SEFICHIERIELET,

TA—NAA Y IT—H—RRICTITA—HAE

DEORITEHRRLET,

o FUT: 7A—HAWEELEMABETEEINT
WET,

o [ TA—HANE>TVWEHA, BEIT
TA—HAZAEEHLESNZVDOT. BRP
TA—HAREREZTBLTLETV,

R UhOIERBTET_aATILTA—HRITERE

VET,

BETRAICTIA—DRET>EGDLETHEEL

WEFICESEERTT,

[AFE]

e Push AF/Push MFOEIW Y TSNI=FHAFTILKS
Y(51R—=2) THRKOEENFRETT,

o PHAFTILIKRY > (51_—2) [CPush AF Mode%
BYYTRZEHTEET,

o PHAFTILRY > (51R—2) ICFocus Area(AF-S)
HE|WYHTZZEELTEET,

o J)LAZ a—®OMonitoringA=a1— >Display On/Off
MFocus Area Ind.(AF-S)(93R—2) T. 7#—h
2TV FPRERRZEON/OffTBENTEET,

o EVMERPILEARRLTVWBMUBICTA—HA%EE
bEEd,

[TEE]

o LYZXRITIZaFIINTA—hHAICREITNTVDS L,
TvIaA—RNTr—hZAFEMELEEA.

o T4—HhXITUTFHIEDISPLAYRY TIFIERRICHY
FtA.
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KRR L‘C77r—731%
BhtE3(EY MEX)

TipHwEEEEs )y 7 EIVDASSIGNS
RY > &NV RILDASSIGN77R4 > IFocus
Magnifier X3/X6MEIWHTENTVWET
(51R=3),
ASSIGN47R% > £ 7=1ZASSIGNTRY > %19
& BEa=T 7MY —EEMNE Y MEXBETEIC
YWwEbHY., BEBPRNAIBICHATNET,
P5—EHTENGEBICAINES, 714—H
ZAME>TVWBH EMHERT B EFICEFTT,
E25—EHTETICRYET.
EYMEARCTILFELIY— (TR-Y)
TIKMBEABETEET, YILFELIY—%
BIELhRICRYE T,
EVNEXRPICTYYad—RTx—hZ(AF)%E
ET9BE. TIAZa—DShootingA=a1—
>Focus®Focus Area(81R—) TERELE
T#—hAITIVTPATIA—HAEEDLEET.
EYMEXFPICTY>ad—RT+—hHZ(AF-S)
EETTZE. EVMERRRLTWARMEIIC
TA—hREEDOEET.
[TEE]
o EVMEATRRINTWVTH., SCRINZEFRPSDI
7. HDMIEADEKIFIEATNE A,
o EVMIEATRIE. MENURY UAREGE. BMICKZER

B YET,
o HAMERIAROERZYZLEEFRICRYET,

BvIEZRH LTI —H2
=B 3 (BR/BERHAF)

ANYOBEPEARELT. 74—HXTYFPRIC
HIEPEICTA—HREEDEZIENTEE
7.
TA—HhZRAMDPAFE—RFFE Ty ard—bk
T+ —HhAFOHERTEEXT,

BEAERET 3L MEDRE/ERERNRRIN.
F—RT#—HAAJEEL KT N ERDAEEIC
BYET, TSICEZRELIA—HIDES L.
BEICER/BER R AIRTRINE T, EHROAY%E
BHLEEFF, ELHEEEIIEENICREL
*7.

[AE]

o J#—HhHAT)FhHZoneFx zlEFlexible SpotlcFRET
NTWaEEE, BRELIETA—HIA T POEHICER
PENELO TV LT, B/IERERIBEICTY.
FOEEVOEBADA NI+ —hZINEREE B X T,

o JyIat—hT#—hR(AF-S) RITHE T#+—HhHAN
BolB/ERERIREICHYET,

Shooting A= a1—®MFocusDFace/Eye
Detection AF(81R—3) T, BA/BEHRHBAF
OEEERELET,

Face/Eye Only AF:

(BA/BEFREAF] HASHEER(AY) DEEIE
ERHLIEE. ADBEDECTr—hREED
TEY, BEOEARELZVEIL. AFN—EE
IEU(MF). BE/BERREAFHDAF—BEHEIE T3
Y@ MAR=Y) RRRINET, EEVESR
(FIETA—h2EEGDOEIVWEFCEMLE-N
T4,

Face/Eye Priority AF:

(BE/BEBSEAF] HASTHRER(AY) OEEE
ZRELEE, ADEPEICBENCT 4 —
H2EEHEET, EPrEERELLGZVETE,
AFE—RICEVETRIHRTE).

Off:
B/ ERHAFREZBEUCLET,

[TEE]

e Face/Eye Only AFICRRELTVZEFTH, Tyda
A=K7 #—hRAEFTHI(E. Face/Eye Priority AFIZ7:
YET,

o FOCUSRAYFHIMAN) DE&F(E. BE/EERBAFTE
FHA(TY a2 Fd - T+ —hRAETHERL).

e Face/Eye Only AFICERELIZIRETABDEF%
Ylolzima. RICERAANDS EBFHIICFace/Eye
Priority AFICZZW £ T,

o PERBREBEA—-LFIE. BE/IEAFTETERA. BED
AFEIRWET,

BR/BERNZHYT

B/BEMRHERORT/ERTIE. TIAZa1—
MMonitoringA = a1— >Display On/Off®
Face/Eye Detection Frame(93R—) T
BECTTET.

[ZxE]

DISPLAYR% > TIERR. FfldFace/Eye Detection
Frame&OfflcRRELTCWVWRELETH, Fyvart—b

T4 —HZ(AF-S) TTA—HZANE LEEDECIERED
F/EREBRNRTRINET,

BERLEARICTr—HRZEDHES

BR/IERBAFDOEER. TA—hRzEDLEE
WIRER(AY) OBREERITZIENTETET,
BECTBHIINDOT. BICBRINTVWSRIHES
F. EEFTINZFT,

BAR BIRT % LB/ IR AN B (B REER)
(Z7Y, BRNTTIT2LEZEHY 7> @
MR=) hERINZET,

BA/IEMHAFIE. BRERLER/IBREAFOEE
E-REDEFEDLEICLDT. KOESICENE
L£T.

Face/Eye Priority AFBF:

(BREBBEAF] BEEEZRELLEZE. 20
BRICT7A—HhREEDLEET, ERENRLEIN
WIS, BR/EEEAFELTEMELET,

Face/Eye Only AFB¥:

(ZREAREAF) ZREAARELIBEEDH. Z
DOHE/BEICT7A—hREEDEET, BRENE
HINZVEIE. AFD—BEIEL(MF). BE/EE
FREAFROAF—EELE7ra> @ (MR-

I) NRRINET, BRLEALCOHFA—
TA—=HALTEWETICHWRE—RTT.,

EREADRTE

TILFELIY— (TR—Y) TERERD—

WALV IEBDOTHR) 2 ERITBERICHELT,
VILFELIY—=HLAHET,
DB/ BER (IR E)

J_ SRR
(BEe_H)

—wb(z“w:/)

ER#EIR D
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B EREADFRIR

TILFELIY — (TR—) TEBERIC
BIRA—-VILEBELT, YILFELIS—%HR
LIAHET,

BEREHER TN, B/ERERN—FERER
Y., BREHYTAIVHEIET,
EREEINGVESIE. B/EABREL. BE#
RO—VILA LY D) RERINIRETIILF
CLUY—%2ERT LT, BREENERIN
ESCR

[T3EE]

o AF7YRMNREE(NIR—) LB E. BIREBITAER
INET,

o TERBHEG{I—LFERRT. BE/ERBAFIIFEZ X
Bh.

o BEBRED, WEADRE, REICLOTIE, BELE
ERHTETRVWCELBYET,

o BEEIBICL-TIE. ELLVHIRNESNAVIEED,
NN EBEELTRETZHELNEVET. COBRE
%, BE/BERRHAFBEEZOFfICERELTSIET L,

o BADERIT. ERCHEETIAMOBELIRTEERICE
BIZIEHBENDHLET,

o BEADERIFIC. BRIDEM. FEABVTVWERWGE
DEHICLY. BENAETLRVWZEABYET, 20
#a. B/EREREZERCRYETH. BRETA
IVERRING, BRELZLOMELGYET,

o BIICEANERINTWVWZIHESE. —BEREHERLT
hoBRTZILEBENSDHLET,

FPYAFTILRY > T/ BEREHAFD
BF=tIVEZS

PHAFTILRY 2 (51R—2) (CFace/Eye
Detection AFZE|WH TR L. ZORI V%
W9 UIC. BR/IEREAFOEEDFace/Eye
Priority AF. Face/Eye Only AF, Off@IEIC]
WEDYET,

FALIMAZ21—TRETS

H/BEREAFDOEEIL, AL I RAZ1—
(5IR—) TEYWEZZZENTEET,
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BA% T ZEHEN 9 %

>

A~

o©
R
(>3

ND ND
PRESET ¢ VARIABLE

24
@N:%o 5

N—

mon w
gl
@® @

LS

CANCEL/ THUMBNAIL =FULL MENU

10 O

=]
@
<
S
=

[©

F ISO/GAIN ~ WHT BAL  SHU||TER
H—— & O >CD

—| (e ]

FAVR, T4V, dvvd—AE—RERHLE
Y. NDT7AIILY—=FE>THELRFAMLILY LT,
B2 c A TCEET, BEFAMISZILETSE
F7.

B2 TA2E8AMITZETOBEELANIEF. T
AZ a—®mShootingA = 21— >Auto Exposure
(7T9R—2) DLevelTRELZFY, 7HrF
TILRY D OF7HAFTILIALYIL(51IR—)
ICAuto Exposure Level #EIWH T2 LT
RE R

[TEFE]

Cine EIE—RTRYI V2R TETE LA, BEREICE
EINFT, Fleo YvvI—RE-RICLBHZTOEEH
AR TEERA, PAUIPNDT ALY —ICLBBHBE
DEEFAMISARETT,

BEEREZEIRTS

AW TI2BEOEERELZBIRTZIEHNT
FET,

CustomE—KRTIlE. Main25—492(14
R—3) £flFCamerax 57 —49 2(14R—2)
MBase ISO/Sensitivity, £rIETIAZ 21—
MDShooting A= a1— >ISO/Gain/El®DBase
Sensitivity(78 R—) THigh%fzZLowh
SEIRLET,

Cine EIE—KRTIl¥. Mainx5F—4Z(14_R—
) £zldCameraZF—42(14R—%) @
Base ISO/Sensitivity, £E7IAZ21—0D
ShootingA = a— >ISO/Gain/EI®Base ISO
(78 R—) TISO 12800 % /=1£ISO 800 »
SEIRLET,
BEORATClELowE(EISO 800, ERE
DEHTIEHIghF 1XISO 12800 % #IRL T
P AN

* AT—YZABETHRETHE.

[AE]

FHYAFTILKRY > I(cBase ISO/Sensitivity=E|Y TS
ZERTEFET(5IR-),

A %z HE TS
PAURETHLT, HESABHTEET,

71 2= BEHRAT S

WEMRICIELTHS T ZRBELET. WIETBL
YZANRETT,

1 L>XICAuto IrisZ2A v FHRDOVNTWBIE
&. AUTOIZT 3,

2 RIST7>4>avikd >V (E) #RELLTY
ALIRMAZa— (5IR=) AERRTE.
Auto%EE 3,

[XE]

FHAFTILRY VICAuto IrisEEIWYETZZELT
FFET(GBIR-Y),

[T3EE]

ATV LY TRTA UREEBBBHTEE YA,
AR FEHFE TS

1 RISTrvoo3vRe(E) 2ERLLTSY
ALORAZ 2— (BIR—T) BRI,
Manual% &3,

2 RISTPY53av ke (E) BBLT. 74
DZEHNAETRCRRINIIRREICT S,

3 TUFTIUIY IV YILEE TR
3.

[AE]

o VILFTPYIIaVHALVILIZIRISEEIYYETS
s RNFTPYI3 VL VILEERIRISELT
EESTEZ L TEET(BIR-Y),

o PHAFTILILVILICIRISEEIVLE TR ELTE
£FF(51R—),

—REICEENFRETT 2

Push Auto Iris& &Y Y Tl=FHAFTILKRY >~
(IR=3) #RLTVB/H. P1U2%EEH
AELET,

E2BTEFRTIINCRYET.

[TEE]

L>Z®MAuto Iris21vF2MANUALICT &, AEMS
MAuto Iris¥Push Auto IrisE R HFH <RV ET, £
feo AENSOTA ) IFERAEIRIEL R (HTFH <R
E

A VRT3

CustomE—RTIIF 1 V& AMLT, BZT%
FETEET,

T4 = BEHET S

ISO/GAINZ 7> avihyd V(H) #RIBLLT
GALYIRAZa— (5IR=) ERRTH.
AutoZ B3,

[AE]

e Shooting*=a—®MAuto Exposure(79R—) ®
AGCZONICLTHRIBRDFAMMNITHETT,

o PHAFTILRI VICAGCREIWYTRZELTEET
(51%—2),

TA U EFHHRETS

TAUREBEELEEFEFBEEAELVWEED,
AGCIC LB TA Py T B ITWKIEWEEHE
ICEARALET,

1 1s0/GAINT 7Yoo 3V (H) £ ER
LLTYILIRAZa— (5IR=D) %
RIRTHE. Manual&&ES3,

2 ISO/GAINZAy F(I) TH/M/L%ZEIRT 3,

[AE]

o 7HAFTILRY VIcPush AGCREIV Y TR E, FD
RYUEBLTVWBELIFAGCZONICTEFET,

e CameraZx7F—4%2ZMISO/Gain<L>/<M>/<H> (14
R—3), FFTIAZa—0DShootingA=1—



3% & BB TZHETS

>|SO/Gain/EIDISO/Gain<H>/<M>/<L>(77R—
I) TRAAYFRIYav0T )ty MEZEETTF
ER

TA VBT

1 1S0/GAINT 7> 5> a3 HkE U (H) &L
T A ABHEE B TRRS NI
¥3.

2 wFTIIIS
2.

[AE]
ISO/GAINZAwF() DEREICKLIT1> Ty NME
EEELET,

T4 U e—RNICHAE TS

FHAFTILTALVIL(BIR—) [ZISO/
Gain/El=E|Y Y TB &, ISO/GAINZA Y F(I)
TRELEDSIIVILTHAETZENTSE
E
WERREZEZZTICHI—SBEHEEBVIAHL
feWEEICEFTY,
—BFR(CHEAR LR, ISO/GAINZ ALY F
() BLUBREREDOYIWEZPAGCEON, E
BREOfICTZEBMICHRYET,

V1YL &EIL T A

[AE]

o JILFTFVY
F(51=_— /)o

o PHAFTILIRY VICPush AGCERE|YYHTEE, FD
RY VEBLTVWBEEIFTAGCEZONICTEXT,

VHAVILICEIYE TR LB TESE

Exposure Index% A9 3

Cine EIE— R TIEFMLUTZ OffICER E L 7z BR1%
HAZFRELTRBITZIEZBELTEY,
EMEICEHETMLUT Onfll DB DB S & 22
ez LT. KRNSO 3> NETD
BRHRLEBEREZRTRCHERT22LNT
TET,

EMEDZEE (. ISO/GAINZAwF(I) TH/M/L
EEIRTBZIETITRET.

[AE]

CameraxF—42ZMISO/Gain/EI(14R—-). %
felF7IAZa—dDShootingA = 2—>ISO/Gain/EID

Exposure Index<H>/<M>/<L>(77R—%) TEZA v
FRIYVIVOEMEREETEET,

Exposure Index%z A% 3%

1 1S0/GAINT P> 5> 3y ke S (H) &L
T. EMEANBEER TR INIIREICT B,

2 w7y
T3,
[AE]

ISO/GAINZ Ay F(I) DEFEICISCIZEIT Uty MERZE
BELFT,

V1YL =RBIL T A

D AV A | 1 IS
v vy —HFARLT,

vy —=BEHRHETS

SHUTTERZ 7> a>viRg U (F) #RIELLT

'94 LY kA Za— (51R—) hSAuto%
EAE, MEOBEZTCIGLTEFHTI v vy —

REFCIIHAEZARTTET.

[AE]

TILAZ a—DShooting A= 21— >Auto Exposure®

Auto Shutter(79—) #0n(C LT E R OAMN
ARETY,

vy —=FEHRHH TS

e T 2R TEET,

—_—

SHUTTERZ 7>% > a>ikg V(F) #RIBL
LT, 94L I MAZa— (BIR=) H
5SpeedFzIFAngle&E 3\,

2 SHUTTERZ 7345338 UF) 58 LT,
Ty v —EHNAETR TR NIIREIC
T3,

3 FTFIIY IV L ERLTS vy
5 EEE AT,

[XE]

o EXHEEAETIL—LBEHICE
Off & BIRL £ T,

o BETRHRELLY. BEETHENIKEETIILETE
£T(78R—-2),

DEBZHEER. FIE1T

ﬁ‘é%)’a“:ﬁﬁﬁﬁ?’%(ND7»r)L
;9_

REKAHINAZTEZLEE. NDTAIILY—%
ZEELCEYIGEZSICTRIENTEET,
AHEE2DDNDTAIILY—E—REHRZTVE
F,2DDE—KRIIND PRESET/VARIABLEZ A v
FTYIWEZET,

TUtEyhE—RTHETS

ND PRESET/VARIABLEZ v F(A) %ZPRESET
DOMIEICLT, ND FILTER POSITION LK% >~
(B) THIWEZ £,

Clear : ND#zL

1: 7 AZa—mdShootingA=a1—>ND Filter
DPresetl(78 R—) THRE LB AR,

2: I AZa—dShootingA=a— >ND Filter
DPreset2(78 X—Y) THRELLEBE,

3: 7IAZa—dDShootingA=a— >ND Filter
DPreset3(78 XR—3) THELIZE B,

NUTPTILE—-RTHEATS
ND PRESET/VARIABLEZA v F(A) %
VARIABLEDHIE(CL %Y. ND FILTER

POSITION_E R4 >(B) TCLEAREONnZ Y
B2%9.

KEZEFRAMITS

ZF—KNDT74ILF—%0nlCcdBE&. NDT«IL

Y—EE-EBBERASETVET,

1 ND FILTER POSITION_ETF+4% >(B) ®+%
LT, ND74)LY—%0OnIZT 3,



47

2T %ZHETS

3% I’

2 ND VARIABLE AUTO7R% >(C) &Autolc
RBETRTLT S,

HEZFHHFHETS

1 ND FILTER POSITION_E TR > (B) O +%
LT, ND71ILY—%0nICT 3,

2 ND VARIABLE AUTO7R% >(C) ZManual
CIZ2ETRABLY S,

3 ND VARIABLES1/¥7JL(D) #EILT 7 1)L
Y—DFEBRERH TS,

[AE]

FHAFTILYLVILICND Filter& B HTZZEHTE
FT(51R—),

—RICEENFREN T3

Push Auto NDMEIWYTSN7HAFTILKR
92(BIR=) #BLTVWEE., #—kNDT«
LY —HONICHYET, 55 BTEA—MND T«
LY —HOffICRYET,

ND FILTER POSITION ETRR4 >(B) O +%3$#HL
T. NDT7AIILT—%20ONDIREICLTHEVWTLE
T,

[TEE]

REAPICCLEAREE W TND 7L —&YIWER &
FEEANICNDT ALY —DBRDAY. BECEEEHA
YET,

[AE]

e ND VARIABLEY'147JL(D) #ND1/4Hh5F 5(CTFICE
d&. CLEARICTZZENTEET, Ff. CLEARMD
S5HZEELICETE, NDI/AICTRZENTEET,
TIAZ a—DTechnical A= a1— >ND DialOCLEAR
with Dial(99R—3) T, ZOEFEEMICTZZE
NTEET,

e ND FILTER POSITIONETRARY >D bYW IC. ND
Filter PositionhEIW Y TSN 7Y AFTILRY >

BIR=) AL TREEAEEITZILELTEET,
7t v hkhE—NR:Clear>Preset1->Preset2—>
Preset3—>Clear- - -
NUFPFIE—R:Clear-0n—>Clear- - -

e Auto ND FilterB&IW Y TSNP HAFTILKRT >
(51R—2) #LTA—INDT 1LY —%On/OFf
FTBHZELTETET,

e HRZVWHEBRERTETREE. PAURERIFICKZE
BEIFRKMNEC T+ —HANELLZZZENBYET(E
FAHASTIF—HRMICRZIZERTT) NDTAIILY—
EESCETIORKEMZ. LYRFLREERER
BIENTEET,



o
%2
(>}

LE

IRIS

@@ @

PL,

CANCEL/ THUMBNAIL =FULL MENU

0 0=

ISO/GAIN WHT BAL SHUTTER

G G

1=
>
=

[©

o/

BERARICHUTHBE-FEEIRTEET,

ATW(BERERKRTA KNS
V)

BICEYARTA MNSYRITIEZ LS ICEEM
ICFHELET,

KROERENETEE. RIS U%
BEMICEAELELET,

WHT BALZ 7249 23> R9 AG) #RIFL LT,
ALY RAZa— (51R=) hBATW%
BELET.

TILAZ a—®DShooting A= 2— >White
Setting®ATW Speed(80R—3) T, 5B
OB RERBIRTEXT,

[AE]

FHAFTILRYG > (51R—2) IZATW HoldigaE% 2|
YUTTHELE, ZORYVERTZEICLDT, ATWE—

RTH—BEMICATWEEIES B, KT/ MNSUREEE
TBIENTEET.

[TxE]

o CineEIE—RDEE, ATWIHEZ FHA.

o BAPHEROFHFICLOTIE. ATWAFEHALTEE
YRBICHABTEEVWCENBYET,
i
- 2 B WE. BB CE—EORERNKED &

HHZHEE

- BEREHNIERICEV/IERE TEVETOEER
ATWOHEBROEAEVGE D, BUIANRENE
SNBWEEIF. Z—hROAMSUIEETLTLE
T,

RO A NNS > 2% F B
EEC

T koa RS 2 BRATWE—RizEoTVS
EFIF. WHTBALZ 773> h9 v (G)
ERBLLTICILIMAZ 21— (51R—
J) hSW:PERIFW:A, W:BZEN,

2 WHT BALZ v F(J) TB/A/PRESET % 3
RT3,
B: XE—BE—R
A: AEU—AE—R
PRESET: Ut wvhE—R
[AE]
TILAZa—DShootingA = 21— >White Setting®

White Switch<B>(80_—3) TATWAEIRT B &,
AEY—BIZATWHABUETSNET,

AEV—A/AEJ-B E-F
AEY— AFREAEY - BIERETNIARTA
MSURICREBLET,

AR ES W TA(RTA NS R)

Tty hE-—R
EREZ )ty ME(TIHHER : 3200K) I
HAETZE-RTY.

BREOCT )Y MEICEETS

TR E—RTEBEEDT )y MEICERE
EETRIENTEET,
WHT BALZ 7> 733> R9 AG) #RIBLLT.
FA LY MAZ1—TUTHSREIRT 3.
Custom £— K : = 3200K, — 4300K,

- 5600K, — 6300K
Cine El E— K : - 3200K, — 4300K,

— 5500K

[AE]

Preset White Select &IV Y TSNP HAFTILRY >

(BIR=) L TCREREEITZIEHTEET,

CustomE—K: 3200K—=4300K—=5600K—6300K—
3200K - - -

Cine EIE—K: 3200K—4300K—->5500K—=3200K - - -

FEDEREICEETS
T WHTBALZ 7> 3vH82(G) &L

T. BREVBEERTRRINIRECT
3,

2 ULFTFUHYIVG L EE L TRE
3,

[AE]

e JUtYRE—RTIHIOOKEMTHRETEET.

o AE—FE—RTIE, 2000K~ 5600KI%20KE {1 TR
ETEXT, 5600KLY EDEIE. 5580KH55600K
DEFRE(ZLYR) HELLKLGZBRTHRETTET,
Ffe. FILAZa—DShooting A= 1—DWhite(79
R=3) TTiNtOAMHATEEHT,

F—=bRTA NS VZZETTS

AEY—A/AE)—BE—RTRETZRIAL
NSV 2%=BETHRELET,

1 AEU—AE—REEEAEU—BE—R%
BIRT 2,

2 WEGORELELALREOLZSICH
WS EEBE, Z— LTy UTEEICH
AT,

3 Bz aBEETs.
FP ) 2=FHEH T3 (45—
CHEoT. PAUREFELT LT,

4 WBSETHY > (4~—) £1T,

o AEY—E—RTEFTLEZEIL. FAEE
FFIE1TREIRLIEAEY— (AX7I3B)
REINET,

e ATWE—RTEITLIEHZESF. FARHIK
DhBEATWE—RTORITA RS VA
BIZRYZET,

(23]
ERCRT Lol E X FEECRBHEIS — Ay t—
SHERINET, BUELHEARITEIS— Ay t—
IRERINB LT, Vo—0Y—EIBHEC IS
CRETW.



49

38 I®¥

N ERd

BRZ

FEDANHEF PR Y F. FAVILIRERFE,

T BEFZRELEFT,

AEBREFEDA AR F LNV BEZ XA Y
9'_

INPUT IR F(7R—2)
INPUT2i%F(7_—2)
VIWFAVH—T1—RAYa— (TR—-2)
INPUT1 2w F(LINE/MIC/MIC+48V)
(TR=2)

INPUT2 2w F(LINE/MIC/MIC+48V)
(7R—3)

BELANILORERZIMYF

CH1(AUTO/MAN) 21w F(6R—%)
CH2(AUTO/MAN) 21y F(6R—)
AUDIO LEVEL(CH1) #147JL(6 R—2)
AUDIO LEVEL(CH2) 41 ¥)L(6 R—%)

F—=FTAART—Y AEHE
D Audio

INPUTA
MIC +48V

INPUT2
MIC +48V

Int MIC

CH1 '
cH2 I

0dB

CH3
T
CH4
A
AL o) P

evel HDMI Output CH Volume

CH1/CH2 0

INPUT1
MIC +48V 320d8 off
Monitor CH

CH1/CH2

5XE 9 %

BRANRK R ZE S

1 z—5<#25—92mEDCHI/CH/
CH3/CH4®MSource(14R—2), %1
[ZT7IAZa—DAudioX = 1— >Audio
Input®CH1 Input Select ~ CH4 Input
Select(96 R—) TEEANETIVEZ
%,
> a—34Y. XLR74 T4 —FfIZUWP
(UHFOAYLZARA 07 1>) %#ESHE
[*. Shoe CH1%x7IxShoe CH2%E&EL F
9. XLRPY TSI —IcoWTIH A —=F 17 A
NiRFEEFR TS (50R—) #ZEL
TV,

[ZxE]
o 49— JULLYIE—R Z20-&IAYIE—
TaviRE TR, BREERRINEEA.

o FERRBEFNEAOFL -3 VY17 %2REL
TWET, tEREDI IV IabERECTF)

BAUWrEITxY, 205 EInternal MICZEREL

E3

. /\>H)L%éﬂ%m\yH)Lmavm(m—&“)
OHHEHICRHEY., BELZNFTEES, /\VRIL
RE %H-’fl:ﬁk#éd)f—iﬁ INSRAFL—>3 0910
(6R=D) AFERATEIIENTEET,

e CH1Input Select&CH2 Input Selecth
Internal MICIZEREINTWBHE. CH1ECH2
DEFEEL ANJLIFFHICAUDIO LEVEL(CH1)4 1+
JUER=) IEELTHEINE T, CH3
Input Select&CH4 Input Selecthilnternal MIC
[CREINTVWSIHE. CH3LCHADRELAIL
[FHICCH3 Input Level(96 R—2) (TEBILT
FEINET,

2 ANTREREE.
INPUT1/INPUT 2l F (CHEfe I 21488 1C
AhHtT. INPUTI/INPUT2(LINE/MIC/
MIC+48V) ZAy FERELET.

s 21y F DB
NEREEIS(S+Y -4 LINE

&)

GAFIWIIALTPEMR MIC
BOI17

+48VER(7 7Y LEIR) MIC+48V
HEEDIAY

o MIC+48VIC LIz £ T+HABVEIRICXEL
TUWERWLWHSRZERTZ L. ERUES
OWEORREICRYET, EiRaTlc R
<FEFW,

o BELEWVIRFOHEBNRICRBZ EFIL,
INPUT1/INPUT2(LINE/MIC/MIC+48V)
ZAWF&TLINES ICLTL L,

BRELANILZzBFHETT S

BEIAE T3 F v XILDCHT/CH2(AUTO/
MAN) 2w F%#TAUTOL [CLZF T,
CH3/CHADIZEIE. A—FTAZXAFT—4 XA
m(14R—), FllFTILAZa—0DAudio
AZa—>Audio Input®CH3 Level Control.
CH4 Level Control%Autolc5RELE T
(96—,

BE LN Z2FEHE TS

CHI/CH2DOBELANILEFEFAETZHEE.
LUTOFIETITWET.

1 mws3a7v>xaocH/cHAAUTO/
MAN) 21 v F%#TMAN] [T 3,

2 BERERERIVACHE, BEHTEFv
> ZJLOAUDIO LEVEL(CH1) /(CH2) 4«
VI ZELT. BEA2REHTS.

o CH3/CHAMIZEIE. Z—FT«4FXFT—%
ZE@EDCH3/CHA(14R—-Y), Ff:
[EFT7IAZ 2a—DAuUdioA= 21— >Audio
Input®CH3 Level ControlFfzI&CH4
Level ControlZManuallcs&EL. CH3
Input LevelF fzIZCH4 Input Level T#R
ELARNILAERHLET,

o CH1 ~ CHAA—1ELTLANILAE TSR
&£ TEET, Audio Input LevelHE|
WY TENETHAFTILI1YIL(5
R=I)P, F—FA4F AT -9 XE
. FE7IAZa—DAudioA=—1—
>Audio Input®Audio Input Level T
BLET,

[>L£J
BAHAL AL OB
E%IJU:‘(M/\ ),

[TixE]

o AudioAZa1—DFEDMHHFEDHICLYAudio Input
Level DERENEMICRZEENBHYET, Fll
BIR—TYORZZELI LT,

o AETREHEDLRICLIWTEIELRENTETET,
HREBIR-YORETEI LTV,

ASlE. A —F« AT —9 XBEEH



50

3% BR  NBIZEFZRETS

A—T 1 FANHFZIER
%

XLR74 749 — XLR-K2M(BI58) . XLR-K3M(H!
50) BES &, BERFICARBOXLREFESI &K
ISR TRIENTEFET,

TINFA VI —T 1R a—IcXLRFPY TH—

BERELTC. A—FT4ART—9XEE(14

R—) DCH3DSource®Shoe CH1IC, CH4

MSourcexShoe CH2ICERELTL TV, F

feld. ZILAZa—DAudioA = a1— >Audio

Input®CH3 Input SelectShoe CH1IC.

CH4 Input Select#Shoe CH2ICERELTLE

T,

AAECXLRFPY T4 —%FIRLI=F v X ILT

(&, BEETEAHOEEETEINCEVET,

XLR7Y TH—D2Ay F P VILTHRELTL

EE0,

[TEE]

o KHEIIXLR-KAMOF S 4)L2chA—F 4 A A V4 —
TI—-RICHBLTWET,

o AudioXAZa—®Audio Input®CH3 Levelt>CH4
LevelZAudio Input Levellc 5 ELI=HmE &, XLR7
4T —THRMLIELRILICABEDAudio Input Level
MEMFEDINET,

XLR74 79— D21y FHAUTOICRELIHES
Audio Input Levelh"BXICEYW £ T
ThroughlcSELEZSE. XLR7PY 79 —CHRLE
LARLTREBEINET(132R—2),



51

38 I®¥

ELNPAN S 3515

FALYURAZ 2—184F

Ea1—7 74V —BEICKRRINDAEDIRE
PEREE EEERLCEETZIENTETET,
BRETTFZHEER., UTDOEHBYTY,

e Face/Eye Detection AF

e SteadyShot

e White Mode

e Color Temp

e Scene File

ND Filter Position / Auto ND Filter

ND Filter Value

e Auto Iris

e [ris Value

e AGC

e Gain Value

¢ |SO Value

¢ El Gain Value

e Auto Shutter

e Shutter Value

e Auto Exposure Mode

e Auto Exposure Level

e S&Q Motion Frame Rate

1 wnForrrvavsrvn, sri
Direct MenuhElW Y ToSn7 Y1+
R V%&ET,

HALYIMAZ 21— BIEOTETZBERAOVY
NAOCALY SOH—VILHREREINET,

2 TINFT7o72 3V VILTRIELIEV
BRICH-VILESHOE JIILFTF7VI T3
L VILERT,
AZa—MRRINZH\
ERTERRINET,

FBREDLH

3 TILFT7oI2a>vFILVILTREERU.
WIWFT7202a>vd1VILERT,
AZa—FEEAERNEIT. FLLEE
NALYIDOH—YILTRREINET,
BUDirect MenuhElWHToN7HA
FIWKRG VBT H, ALREELLEWVWT3
BWRBITZE. YALIRAZa—HDRTL
¥T7.

[AE]

o BEI7VIYaVKRIV(ER-) #RAL
LT, EERTETIRECTEZELTEET,

e HERTERRINLRETIH., YILFTIFPVIY3
VHAVILETHAFTILIALVILDOLSICES T &
MTEET,

o EIRBEIITILFELIY—
ZET,

(OR—2) THIT

FPYHAFTTILRY /T 1YV

RIS, BEEREIWVETTERTE27H1+7)L
R UHE6, 7. 9IR—I) BYET,
EEDIILF T 7T a>FTALVIL(ER—
D) ENVRILONYRILFHAFTILGAYIL
(TR=), JUwTIVEIA>DIIYTT
YAFTIFIALVILOR—) [CHiEER T
YYTRIENTEET,

RV OWEEERET S
TIAZa—DProject A Za—®DAssignable
Button(85_—2) #fERLE Y.
ElYYHTONTMEEIZ., FHAFTILRIVR
F—HZBEE(15—) THRTZIIENT
FFET,

TIHHEERIC T YA FTILRI U IICEIY Y

ToNTVS1¥EE

R 21 S&Q Motion

RG22 AF Speed/Sens.

KRG >3 Focus Setting

Ko >4 Focus Magnifier x3/x6
K9 >5 Direct Menu

KT >6 Off

KRG >7 Focus Magnifier x3/x6
"9 >8 Direct Menu

"5 >9 Video Signal Monitor

Focus Hold/R4 > Focus Hold

ZWHTENDHEEE

o Off

Base ISO/Sensitivity
e AGC

Push AGC

ND Filter Position
Auto ND Filter

Push Auto ND

e Auto Iris

e Push Auto Iris

e Auto Shutter

e Auto Exposure Level
e Backlight

e Spotlight

e Preset White Select
o ATW

e ATW Hold

AF Speed/Sens.
Focus Setting

Focus Area
Focus Area(AF-S)
Face/Eye Detection AF

Push AF Mode

Push AF/Push MF
Focus Hold

Focus Magnifier x3/x6
Focus Magnifier x3
Focus Magnifier x6
S&Q Motion
SteadyShot

Rec

Rec Review

Clip Flag OK

Clip Flag NG

Clip Flag Keep

Color Bars

Tally [Front]
DURATION/TC/U-BIT
Display

Lens Info

Video Signal Monitor
Marker

VF Adjust

VF Mode

Gamma Display Assist
Peaking

Zebra

Volume

Thumbnail

Touch Operation
Handle Zoom

NFC

Auto Upload (Proxy)
Direct Menu

User Menu

Menu



52

3T; IRR EFAEAE

FAVILDOWREEZEE T S

AEOVILF T 7o avsd1vILE, Ty
TTPHAFTILGALVIL. \NYRILFHAFTIL
AV DOWEEEZEF T ENTEET,

CILFT7I>avd1v)LIEProject A
— a—®Multi Function Dial(87R—%) @
Default FunctionTsREL £ T,
TiGHERICIOfABIVETENTWVET,

TILFT7202a>54ILICEIYYT

5N BHEEE

o Off

e |SO/Gain/El

¢ |RIS

e Auto Exposure Level

e Audio Input Level

[ZEE]

AZa—REERRLTVBEFE ARERJIEMICARY
E3E

FHAFTINIALVILIE, TILAZ 2—DProject
A= a—®mAssignable Dial(87R—2) T
ELET,

TiZEERE. WEFNEIRISHEIVETESNTW
N

[AE]

RM-30BP(BI5E) P HAFTILYAvILIE. Grip/
Remote Dial DEREICEWVE T,

INYRIVPZHBAFTILIAVILICEIVHET
5N B HEEE

o Off

ISO/Gain/El

ND Filter

IRIS

e Auto Exposure Level

e Audio Input Level

e Multi Function Dial

Ty T TPHAFTILIAVILICEIVET

5N 5H%8E

o Off

e |SO/Gain/El

e ND Filter

¢ [RIS

e Auto Exposure Level
e Audio Input Level

By Y TOENTAEEIL. FHAFTILRI VR
F— Qlﬁﬁ(&\_ﬁrﬁﬁ?égtmf
£,

A0—-&7AvIE—>3>

LT A —T Y NBIR—Y
TL—LL—hEBHEBEICHRETRIIENTEET,

) R FERICREINTVWR EETE, BEFOTIL—LL—NEBEED

E/TF—< v IL—LL—hk
2T LRERE AA—Iv—2F+y TI-—FTv ETAT74+—3vhk
YE—R
59.94/50/29.97/ FF RAW 3840%2160P 1-60
25/23.98 RAW & XAVC-l  3840%2160P 1-60
XAVC-| 4096 % 2160P 1-60
3840%2160P 1-60. 100, 120
1920%1080P 1-60. 100. 120.
150. 180. 200.
240
XAVC-L 3840%2160P 1-60. 100. 120
1920%1080P 1-60. 100. 120.
150. 180. 200.
240
S35 XAVC-| 1920X1080P 1-60. 100, 120
XAVC-L 1920X1080P 1-60. 100, 120
24 FF XAVC-| 4096 % 2160P 1-60
S&Q MotionhBEIW YT NP HAFTILKRY [ZFE]

(5IR=) Z|TE, 2O0—-&IAVIE—

$3VE—REON/OFf TEET.
RS ERIMUTBE, BEBOTL—LL—F
ERETEET,

o RFP. BEH. YLAXMLRTHE, RO-&I1Y
JE-—YavE-—RICTTERA,

e RO—&JAYIE—Y3aVE-RTH
TEEA,

¢ 20—&VAYVE—YaVE—RTR. #—hT72—2
ZAHBEE A — b7 A U RBREE, #A— b vy S —HEED
B|MCRYWET, 2L, TL—LL—IDUTICRE

BFEIFELET

INTVBHAE, F—hT7—hRMEEERTEE
7.

27 LB IL—LL—h
59.94/29.97/23.98 30, 60. 120, 240
50/25 25, 50, 100, 200

e RAWHADFERAEIFSIR—IZZEBIIETL,



53

3T; IRR EFAEAE

IR (CBRIZEDIR T (A
25 —/VLL Y U HEE)

AEDOAE) —%FIH L TERHIICER&ZEY) A
F. BRI BAVI—NILLy I HEEIR. EICH
FOVRVWEEGRLZBRETREFCEUMTT.
SRR ERBTZE RELETL—LE(Number
of Frames) 2 DB &E, FEROA>5—/NIL
(Interval Time) THEIECRTEET,

B 0B (Interval Time)

1Bl T ZEERTL —LE
(Number of Frames)

AVF=)NILLy 7 ZBMLTWBEFG, IR
SBAIARTICE T 74 S+ RHVL-LBPC(RI5E) 28
BHNCRITTE. XE, BREARET LR
ETREATSIIENTEXFT(FTUSATrY
JHEEE).

[T5EE]

o A9 —)NILL Y775 EDYTFRELIRIERE A IR BRI BF (CfE
BATExtA.

o AV —/NILLy 7 ERPICMDISTRECRIEREET I
T3 AVF—=NILLy I IZEENICERINET,

o EFATA—TYNEEDIRTLREREET B,
A= NILLy Y E—-RIZBEMICHERINET,

o RLRPVPELEH, YARSIBERRPICA>Y—-/INIL
LYy DRELEEETZILIITEEEA,

BRETBICIE

TILAZ a—DProject A= a—®DInterval

Rec(84R—<2) TSettingZ0OnIZ/EL.

Number of Frames&interval Time%&EL

TLLIEEW,

E5 754 NHVL-LBPC(RI5E) 2RI 21HE

(&, HECKLTProjectA=—a—mInterval

Rec®Pre-Lighting T REIBRTIOET 74 S5«

MRITEFEZRELTLRETL,

[TEE]

o EFASANERBRIICRITTEZHEZSF. ETHS
ARDZAYFHEAUTOICERELTLETV, ZDEF
Technical*=a—®Video Light Set(100R—%)
DREICHO>TETASA MHEBRIT/EILET,

o EFASANDIAYFEONICRETRE. EFFSA
MNIEBSITLET, (ETFS0MNIESSRITETL
FtA.)

o BERTFEICLVHEITEFEASHUTCRZEZSE. ETH
SANIHEITLEEA.

AEOEFAYZEA V9 —/NLLY I E—
RIZFEBR TN FE TN, Number of Frames,
Interval Time, Pre-LightingMa&EIFRiFE
nxd, REA>Y—/NLLYy T E-RTRS
BEFICHRETIHLEFHYEEA.

R TBICIE

FREISTART/STOPKRY > &9 L s NFaLA
TN, Ea—T70 05 —EELICTNINt@ORec &
Mnt@Stby) MR EICRRINET,
TUSAT14 VTR ERT a1,
MBEZHICETA S A MRITLET,

ot

RR 2R T I3

SRFLEORIFZITVET,
BRERTIZE. ZOBRBETAEY—ICER
SNTVEBRIGEHAT A FICEERINE T,

A2 —=INILLy T E—R=ZfEFRT 2
(I

ROWT NI EETLUET,

e POWERZ 1w F&OFffIcT 3,

o SLEFMAIC, Project A= a—dInterval
Rec?dSetting% OffICERET 3.

e, AEHBEBLIEHZEEL VY —/ULLY

JE—RIIERINET,

SCERR DENFH PR

o ERIFEBINE LA,

o LyJLEa—BEGFITAE A,

KIEDOEFEHNYINIIHZE

o KHEDPOWERZA v F&Offlc LIcIZHIE.
ZOBBETAEY—ICBZON TV &%
LRI B, ATATICTIEALTHS,
BEEMCERNINET,

o SERPICNyF)—EEWI LY. DCER
J—R%EB|FRWEZY., ACPYTH9—RIDE
FEEY-Y LIS . FOBRBLUFICE
gLz avhRXI10W) NERINEWS
EhBYET, NyTU-—KBOBRIIFERTE
BTV,

AE)—H—RAEAE!) —
H—RKBOWAICEEERT BIC
[F(22 0w ~EIBEFECER)

Project 25 —4 Z®Simul Rec(15—)
FFTIAZ a—DProject A= a— >Simul
RecdSetting(84R—) ZOnlc g3 &, A
E)—H—RAEAEY —H—KBOMEAICREFIC
ERTEET,



54

3T; IRR EFAEAE

BRIESE=Y —

Monitoring A= a2—®Display On/Off®
Video Signal Monitor(94R—<) T, Ea—
T7A VY —HEICRTT BRGESOERE
DI-TT74—L. RIMNLZI-T XIS
LOWFNHICERETEET,
ZLYSOREIEITSLARILOREEERLE
ER

EZA—WROEXT

Cine EIE—RDEFE, EZI—WRERTE
LT, BERERSAR-Y) FLIFEZYI—
LUTOERE(B1R—Y) NEEZTEZI—D
GLEICRTRINET,

78001234667890128456
ND AEH0.78

gI)wT 7545

Clip Flagihg > (5R—2) %83 &, Add

OK KEFTI NIV wFICOKD T ) w T TSI H
FlFonxtd.,

265 T g & Delete Clip FlaghZEiTE 1.
OKDI VYT ITSTNERET,

[AE]

o JUYTITSTHEREIVETIETYAFIILRY V&
BALTIVYT 750 %322 TEET(51R—
).

o JILAZa—DOThumbnailA=Za1—®Set Clip Flag
(98R=D) TIVYT IS0 %[ FTBZLETEET
(TOR—-%),



55

JOF>EREd 5

FREBREEDOS VS FILT —9 OEEZ A
EV-H-REERLENS, BRGECTOF
ST ERRICEERTTET.

& ERTELBAE—H— KD AEY—H—ROT 7~

Ty hAE BREBOHRAEICDVWTEIAEY —
H—REES) QIR=I) RZELILETW,

E

K

RRAID

1 Projectx5—4 ZMProxy Rec(15R—
D). FrlFTILAZ 21— DProject A= a—
MDProxy RecT. Setting(84~R—) %
Onlc 93,

2 AE—h—KR%CFexpress Type A/SD
H—Rz2OvkER—) ICELRAL,
o CFexpressh—RDZFEIEINILEEIC
g5,
o SDH—RDIFEIFSNILEAICLTYIY
REBAETICT S,
[ZEE]
JOFIVERFF. RO—&IAYIE—Y3>, 429N

Ly I EEBEICONncT3zEldTEEEA,. TOFVE
FEONICT B L. INSDEEEIFEHIAICOFfICIRYET,

TOFTEBR TR TS

BEAICBBELGREN D o5, RESTART/

STOP/RY V&I LA RIRLE T,

[T5EE]

o AEY—H—RECPIERAPCAEOEFEY>WA
EV—H—REKRVIBERT—YFMRETNEEA.
AEU—H—RICEBINLEIRTOT—IHIENST
BEENBYET, BREEVI- LY. AEV—H—REK
LEFF RITFERATEIAEI—H—ROT7IEISVT
MHEITLTWR Z L AEHRRLTHSRIELTIET W,

o HUANBCIEAEY—H—RORUHLICTZELE
T,

BREZRTIBICE. TRFLEDEBFZITVE
R

FOFSRBEOF—F 1 F
FoYRINERETS

TILAZa—DProjectA Za1— >Proxy Rec®
Audio Channel(84~X—¥) T, 7O+>5—
SICRRBI A —TAAF v UXINERETEE
ER

EERINSET7AILICDVT

YERFIE . mp4, TY,
A4 LD—RERBICERINET,

T77A1ILDREFFLICDODVT

ERLLET7AILE. UTOFALIRI—ITfR
FEINFT,

SCRAT AT TAILGINZ

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub

T7AILAICDWVNT

AEY—H—RICEBRINZ V) v TE+S03T
EP

JVYTRIEDVTIE, TIAZa—D
TC/MediaXAZa—®Clip Name Format
(INR=) ZZELETW,



56

38 I®¥

HHDILY I Tlera: T3

AEDCUStomE—RTlE. BEXILyIAER—-Z  [*F]

CTSvIPIRII 2B EDREZMZTILY

o TIZHFEEFE. UTFHATUEYRENTVET,

IEBRLET, Shooting Mode Custom
— Target Display SDR(BT.709) HDR(HLG)
<RI Scene7 7L 1 S-Cinetone HLG Live
: SceneZ77AJL 2 Standard HLG Natural
TS5 SceneZ77AJL 3 Still RER
Ly — Scene7 7L 4 ITU709 RBH
Scene7 7AIL 5 ~16 XREHR KB

HEKILvY

INSDHREAESCcene T 7AILICRET B &
T. REDERBZILY I ABEICBRIZENTSE
3

Ailix, 0TV hDIILYIERELT
WET,

JLw %325\

1 meEmEcwLFI7 Yoo 3V 8 1vLE
e,
SCNFAIVERS.

IINFIT7oI2a>vd14vILERT,

—hSFHDILY T EFEIRL., TILF
TP avFdLVILERT,

Main2F—4 Z2®MScene File(14R—2) . £t
TILAZ a—OPaint/Look X = a1— >Scene File®
Recall(89R—) TEI VI EBEIRTZEMNTE

9. B, FUtEvhDILyTIEScene File®Preset
RecallCHUHEET.

W HDERIY J%&A > R—
R

AL, PCRETERLEEID LUTT7 7 (L%,

BRIy IELTRKIEETIVR—NT32

ENTEET,

o 774)LHR : Catalyst Browset>RAW
Viewer, Blackmagic Design Pty. Ltd. &
DaVinci Resolve* TEM T NBITIRFEIF

331 FDCUBEZ 71 JL(*.cube)
* Resolve V9.0, V10.0B8&LUVI.0ICTHERR

o AAhig/H 7 S-Gamut3.Cine/S-Log3
F7zES-Gamut3/S-Log3

1 pchecaBAz+POREDNT ALY L.
3D LUT 7 7AILERET S,
BBAT(T  TALIIR

SDXC /PRIVATE/SONY/PRO/
LUT/

CFexpress /SONY/PRO/LUT/
Type A

2 3D LUTT P L ERELLRRATA 7%,
CFexpress Type A/SDA—RZ0Ov ~(B)
ICELRAL,

3 TILAZa—®DPaint/Look X~ 1— >Base
Look®Import(89R—) #EiRT 3,

A ok—henERT 2.
5 o k—rT23DLUTT 7L e IR .

BEEOERCESTET WV, A%(E3D LUT
T7AINEERILY 7 ELTRYRVET,

6 TILAZ a—®dPaint/Look X = 1— >Base
Look®Select(89R—) THa vik—k
L7e3D LUT7 7ML ARIRT 3,

[ A4YH—FLE3D LUTT 7ALOB’EA
HHET. FIAZa—DPaint/LookA=a1—
>Base Look®Input&Output(89R—

J) ZRET .

BT EZHRE TS

AVR—NLEERILY I ZFE->TCEEZELZL
eEFCBETROERL S ZHEE. Paint/
LookAZa1—®MBase Look®DAE Level Offset
(89R—Y) THRMLTL YT

[ZEE]

o 3D LUTT77AMIL%A ViR—bM LT TIIMKICRILS
NFEtA. ZILAZa—DPaint/LookAXA=1— >Base
Look®dSelect(89R—¥) T4 »R—KkL7=3D LUT
TP ERHFELTIET,

o INPpUtZIELKHRELAVE, AKDILYIICHYEE
hoo

e :XFIEBInput. Output. AE Level Offsetld.
Select CERETNERILY I ICERINET, &
BO3D LUT7 70L&« ViRk—bhLIEHmEIE. &3D
LUTZ 7 )L%Select T##IRL. Input. Output. AE
Level Offsetx ZNZNHRELTI LTV,

o ZFELInput. Output. AE Level Offsetld. 3D
LUT 7 7AILZEIREINE T,

o A>iR—KkL73D LUTZ7A)LIx. SDR(BT.709)/
HDR(HLG)/Cine EIE—REBDEARILw 7/LUT:EIR
FEERYETN. INSOE—RICRURE@E - H>7
THFTVEEA.

e MaintenanceX = a1—MAll Reset®ResetE#E{TLT
+£3D LUTZ7 7/ ILIGHIBR T NE A,



57

3T BE  HFHOILYITERITS

WY HHAIIAZX TS

TILAZ a—0DPaint/Look A Z a—®MMatrix#:
EDEHJREIRBT. ERINvIRE[CIYIED
ZAGIARXTRENTEFET, KRTEBDH
MFBIR—IHZBEBLTKET,
RETZEFF, AETLEDPEZY—CDR
WT. BE§EERLAHNSHAMLTIIETV,

[TEE]

3DLUT7 7L EA YR— MU TRRRICER LIz &,
Paint/LookA = a—®OMatrix B EDEKIL Y IS DR
BRENEEINTWVWSE, 3DLUTTZPAILICERI N
BYDILY VIRV ERA. TILAZa—DPaint/Look A
Z a1— >Reset Paint Settings®Reset without Base
Look(89R—) T. hAY VA XETNIHREMBEREFE
HTIEYRTEET,

W RETS

TILAZ a—OPaint/Look A= a1— >Scene
FiledStore(89R—3) T, REDILY I %
Scene7 7AILELTARBAE) —[CRETEE
7.

REBENSIAL I 21— DRETHEIC
HUHEZLSCHYET,

[TEE]

LI EREFEETICIEIDILY I ERIRTZ L. RERD
Ly I IIHEINE T,

[AE]

Tty hDScene7 7 AILE EEETTEET,

Tty bhDScene7 FAILEBITLTBICIF. FIAZ 21—
MDPaint/Look XA = a1— >Scene FileMPreset Recall
(89R—I) TEELIEWILY I EZGHFH LIzSH L.

Scene File®StoreTScene7 7AILICRTELTSEET L,

RELEILY I ZHIBRT S

TILAZa—®DPaint/Look A —a1— >Scene
FiledDelete(89R—) T, WEBAE—IC
REINTVBScene7 7MILEHIRTEET,

[AE]
HIBfT3E. YALIMAZa—[CRIRINGBLLRYET,

BRIV ZHIFRT S

TILAZa—OPaint/Look A= 1— >Base
Look®Delete(89R—) T, 4 VR—kL
723D LUT 7 7AILEHBIBRTEET,
TILAZa—OPaint/Look A= 1— >Base
Look®Delete All(89R—) T, TRT®D
3D LUTZ7 7ML ZHIBRTE£ T,

[TEE]

o HIBRTBZRIIC. ZOEKILYIHSceneT7 7AILTHER
ITNTVWIRWZEETHERLETV, FATNTVSE
ALy 7 ZHIBRLUIIHE. %X T 5SceneT7 71ILDILY
JIERBEYREDICHYET,

o AYR—KL3DLUTT 7AILIE. TILAZa2—D
MaintenanceX — a—®All Reset®Reset(105R—
D) AERTLTHEIRINEBA,

o HIBRLEAXIL Y, Cine EIE—RTELUTELTHE
ZELLIEYET(58R—-),



58

38 I®¥

RARNT

A#DCine EIE—R%ZEV, BEMSHEET
EAAMECRRTZE. RANTOYI VI
TRAHICEECIHEOEAZET T EM
MWRAETSTENTEET,

LML, CORERMEETEDE=I—TRZ L.
&Y NSIARDMEWZS., TH—HPEE
HiZEDHRMNE# T,

AETIE, TV —BRICLUTAER LTRSS
BHOKERAMEHTIENTEEY, £k,
BEMRICLUTEER LT AW A RT3
EETEET,
LUTIEUToRBERICERINET, =20,
BRYNBLUTIRIESETY,

e SDIEAB L UHDMIE A

e VFEXUProxy, XhJ—=24

o SCBRAT A FICEEBRINZ MK

VFERRICLUTZE AT 5

1 MENU7R4 >%# L TMonitoringx5—%4
2HERRT B,

2 VFTMGamut/Gamma¥ % &3,

= Monitoring 5/13

Signal Info.Disp. Gamut/Gamma

SDI 1920x1080P(Lvl A) ||Off [SG3C/SLOQ3

HDMI 11920x1080P On SG3C/SLog3

Stream Off [ MLUT

VF MLUT

Base Look / LUT Gamma Disp. Assist
Off

s709

3 OnEiEOffEES.

57173

[ZFE]
o VFOLUT On/Offg&EIX. ProxyZ 7AILBRKJ—=
SUBURICEERLET,

o EVMNEKRFIE, HYIRRTIZANMIBYET,

[AE]

o JJLAZa—®dShootingA=a1—>LUT On/OffOVF/
Proxy/Stream(81R—) THRETETET,

e SDI/HDMIEVFEERRICERETEE T,

o SEERATATOBURICDOVTIE. TIAZ21—D
Shooting A= a—>LUT On/Off®dInternal Rec
(BIR—Y) TRETTFET,

LUTZZE T3

1 MENUR% > %3 LT. Monitoring X5 —
Y2 ERTT B,

2 Base Look/LUTHI%Z 3.

=@Monitoring 5/13
Signal Info.Disp. Gamut/Gamma

SDI 1920x1080P(Lvl A) ||Off [SGSC/SLog3

HDMI 11920x1080P On SG3C/SLog3

Stream Off [MLUT

3 MLUT

Base Look / LUT Gamma Disp. Assist
Off

3 EALvIOUZ DS, BRTELUTAR

JASYS

[AE]

e IDLUTT7 7AW EAYR— L TERBTZZLEHTEE
9, BRIy IIE, s709. 709(800%). S-Log3hisE
RATRET T, FL<IF. MFHOERILYIEAVR—
K21 (56R—) BLUTEXRILYIEHIRT S
(57R—=3) BB IZT W,

o JJ)LAZa1—®MPaint/Look A= 1— >Base Look®
Select(89R—%) THRETEXT.

>TCILY O %A T BHIIE CIRRs 9 5

ELER T B BRIRIB $E®H%n
BREBDEC 2 E R

BAER LW BEERDERAEBELLVWZERE,
Exposure IndexaBEERENSEETZE.
B - AR OB AEZEZLIRENTEXT,

1 VFBME(CLUTA BT 3 (58 R — ),

2 MENUARY>%ELT. Camerax>—42
ERTT5,

3 Exposure Index®L/M/Hif%#RET 3.
FNEFNOMED. ISO/GAINZA Y F
(5R—) OL/M/HRTY Y avIcElY)
YToNET,

4 AT BExposure Index%ISO/GAINZ
Ay 9:_6%/3‘\‘0

5 VimghEEcsz LS cmmREET 3.

[TEE]
EYMERFEA VYRR IRAMNRYET, HIvE
NP YZAKNICIZEXposure Index(HEATNE A,

[AE]

e J)LAZa—®dShootingA = a1—>ISO/Gain/EID
Exposure Index(77R—) THRETEET,

o FRTEMBOBEBOEEIL. BAE(18% T L —DEEER])
[CABNOBEBREEIVHTEINERLTVET, &
N&YWBEZVWEEBIIERULET,

) T400El / 5.0E1 :5.0 D= mBEAICEVYTS.

o IREHPICEEER - BAEROEA LR T ZENTESC LD
TEET, EZEMRY Y avIcEERE., L'1'//E|
VIC2BYAF R HIRI Y IVI2BR TSR DERR
LTHE ISO/GAlNZ'fJ?’&tﬂ”)gxfﬁﬁaﬂbiﬁl

BER%. MR YavCRUENGWEDS. TERLLE
T,



RAWE) Bz ECER T 5

A DSDI OUTERF M5 HALRAWENEE S
., WISTBINBLI—F—CERBETTET,

1 AmRAWLI—&—%AOSDI OUTEH T
RT3,

2 Project 257 —49X(15R—-Y), Fi
[FT7ILAZ 2—DProject A= 1— >Base
Setting®Shooting Mode(83R—3)
TCine EIZ:&IRT 3,

3 Project A5 —4 XMImager Scan. 7z
[ZTILAZ a—DProject A= a1— >Rec
Format®Imager Scan Mode(83~—
Y) CEAFFO#H) #EIRT 3,

4 projectzz—92. FilETIAZ2—
MDProject A= 1—>Rec Format®Codec
(83R—%) TRAWAEIRYT 3,
RAWEXAVC- 172 E&FE &, HMEBRAWL
J—4—TORBERBIC. EOAE) —
H—RICEEERLIRTEIIENTEXT,

5 Projectzz—92z. FrETAAZ1—
MDProjectAZa1— >Rec Format®RAW
Output Format(83/R—3) THRIKE%:
#IRT 3,

O AEmLI—5—DBENASTVNBZ LA
SAL. RO BSTART/STOPKRY > %48
ER
[TFE]
A DFESTART/STOPRY V& EH T ICHERL
JI—4—THRERFEEITOE. EBCEBINGVE
= DETR

HR—hELTWBRAWH AT #—< v NI
DEEYTY,

227, Codec RAW Output
JERE Format
59.94/ RAW 4096X%2160
50/ 3840%2160
52}97/ RAW & XAVC-l  4096X2160
23.98 3840X%X2160
24 RAW 4096X%2160
RAW & XAVC-I 4096X2160

SCERIARER TN

TILAZ a—OMonitoringAZa—®Display
On/0Off(93R—) T. RAW Output
Control StatushOnICFREINTVBIHE L.
Ea—7 74 >4 —BEHEICRAWEIE D ERIARE
NPAIAVTRREINET,

[ZEE]

A% 13SDI OUTIRFH SERHEESZHALETH.
AL —4—DREERGTE2 LB TTERA. Z0
feé. AETRAWEIEDREREPERTLTVWTH, EH
ICERBLTWRWZ EASBYET, ERTE/FKREIINE
LO—4—LORTRTHRLTILETL,

[A¥E]
RAW Output FormatDsREEELRIRINE T,

AO0—=&TAMYvIE—>3Y
Sl

Shooting A= a1—®MS&Q MotionT. Setting
MONCH/EINTWVRIFEEF. RO—-&T71Y
JE—YavE-—RTCRAWHE %R LET.
BREARER L —LL—NE2R—-VEZE
<IExW,



60

48 Xy bhT—UHEE

T/\A X ELANE R T 5

AEOLANKREZFER LT, AX—KTA4> DY
TLYRGEDTNAREREEZLANZER TS
ENTEXT,

LANESR I N=T/\A R EREOBTIE.

FContent Browser Mobiley 7 74— 3>

ZRAWVWT. UTORENTIRETT,

o LANBHTOYE—MNEME
AHEELANBER I NIRRT 420D T
Lybk, OvEa—49—hoxEaE)E—NE
ETBENTEET,

o LANBHTOD T 71 )LERX
AEOAE)—H—RICEBELETOF>T7
TIVUERRE) B74 )T FIILT 71IL(E R
E) #. LANBBRTY—/N\—[CEETZILH
T*%£d,

o LANZHTOBGEEE=S)>Y
KOO ATBIRPBEEBRENS IR —
L(H.264) #{ER L. TContent Browser
Mobiley 77U —>a>&E>TF/NA A
SHUREEZIIVITEIENTEET,

Content Browser Mobile; 771
T—>3v

FINA ZDEE TAEDOMIGEE=F) VT LK
Mo, VE—NEEOAIEDOREETZEN
TEBTIII—VavERAELTWET,

@ Content Browser Mobile] 7 7 U4 —< 3> ([CcDWw
TlE, BEVWEFEFZFY -0 —-E2ROZ
R EEL,

2A—H—ZENRT—RER
EI3

Xy D —Ui%EeA CFIRDOBEIE, £ AR
A—H—ZENNXT—RERELTLRETL,
1 TILAZa—DNetwork XA — 11— >Access

Authentication®User Name(101R—
V) BRET D,

2 TILAZa—DNetwork XA — 11— >Access
Authentication®Password(101R—
D) BRET S,

JAY LZLANT7Z 2R
4>, E—R(Access Point
E—R) TiEHT B

AgETFICZRAVRNELTTNRNAIZEDTAYL
ZLAN EHLET,

AI—=KT#2/FTL Yk

NFCIHEERREHD T /INA AT I VY v F
E5d3

FINA ZHBNFCEHGR—KMLTWBIBEICIE.
NFCERIELET VS Yy FIEENTTRETT,

1 srszorme ses L zomoR
E15EU. INFCO/BYALITT—945%F ]

DINFC R/W P2P] 7= (x'Reader/Writer,

P2PJICF I v/ EANS,

2 ABOTEFEEANZ.

3 NFCEEREMICT S,
NFCEEIWYTRPHAFTILRI VAR
BLTA) 33h. NetworkAZa1—0
Wireless LANONFCEEfTUT, NFCHES:
E—-RlcLTLEET W,

BElC NHARRINTVZETDHNFCHE
BEEZFEATEET.

4 kesnazu99F55.
FINA ZH A TS TN, TContent

[Z5EE]

o« —ZD (n__) MFVWTWBF/INA ZIENFCITHRS L
TVWET, FHULLEIFTNA ZOEIRRAZ TR
<rExw,

HEMLHTNAZOR) —TELUBEEROY I %
BRERLTSIET W,

)\« 2 Content Browser Mobile) h\#2&h g
BETON~2MEH T T ICYYFLET TR TV,



61

48 Ry bhD—UHEE  T/\A ZELANER T3

WPSHERERB S D T/\1 A TR I 2

FINA ZHBWPSE B R—KLTWBIHEITIE.
WPSTOEHEMNATEETT,

1 Jut=2—oNetworkt=2—
>Wireless LAN®MSettingT. Access
Point Mode#%&{R9 3.

2 TILAZa—DNetwork A Za1—
>Wireless LANOWPS%ZE{719 3,

3 /s 2ONetworksE e/ Wi-Fisg % B
F. Wi-FiZOnlc9 3,

4 \Wi-Fi Network®SSID—E M5, i
OSSID%EZERL. H#MOptionkE &KL,
WPS Push Button%z:&IRL &R I 3.
[TEE]

o FRATRMEERICLOTIE. BIENELZHZEEHSHY
E3C

o KiEMDSSIDH L UPasswordld, TIAZa1—
DNetwork A= 1— >AP Mode Settings®

Camera SSID & Password(101R—%) THR
LTZTHRLET W,

5 Content Browser Mobile7 U4 —> 3
THERT S,

FI\A ZTSSID. Password= A AL
TR I3

FINA 2 TSSIDEPassword% A A LT
LET,

1 TIAZa—DNetworkA=1—
>Wireless LAN®DSettingT. Access
Point Mode% iR 3.

2 714 2DNetworksEE /Wi-Fisk % B

F. Wi-FiZOnlZd 3,

3 Wi-Fi Network®SSID—Eh 5. AED

SSID%®IRL. Passwordz AN LTS
ER-R

AtEDSSIDH L UPasswordlE. Network
AZa1—®DAP Mode Settings®Camera
SSID & Password(101R—%) TZHESR
TNV,

[ZEE]

EATBMBICL TR BRENELZHZENHYE
ER

4 Content Browser Mobile? U4 —< 3
VTHERT 5,

JAVLZLANZ T —> 3>
E—R(Station®—R) T
w93

AEEISATYNELTHEDOT AV LZLAN
DFIEARAVMNIERLET, TIRAREF
FORARAY MEBETERLET,
ERLL7IERr Y NOBEIE. BE104
FTREINZET,

EBEREBEEFZALL PAIILICRESNETH, 77
TZDNRAT—RIRETNGEWH, ALLT 7
TILOFHAHEOBIEFROBRICE/NRT—R
DANDBEELRYET,

2A7—KI7#>/ AVEa1—4—

STLwvhk

FORARALUN

WPSHREZE>T 77 ZARA U ~IC
&fid 2

T EIARA Y MHWPSHERIEDZE (F. F
HERECTERTSIENTEET,

1 wrezmsvromEEANS.
2 ABOEFEEANZ.

3 TILAZ a—DNetworkA=1—
>Wireless LAN®MSettingT. Station
Mode% EiRT 3,

4 TILAZa—DNetwork A= 1—>ST
Mode Settings®Camera Remote
Control(101R—%) T, Enable% ;&R
93,

5 TILAZa—DNetwork A Z1—
>Wireless LANOWPS#%£179 3,

O oA FOWPS K5 v EET,
WPS K9 > DRFEICDWTIX. 77 ERR
1Y NOEREHBAE R ZELC LT,
BENRETIRE. Ea—T7aA V9 —EE
DRy NT—TRERROT7A IV HEE1
B ETHITUETY,
k=34

BRICEAMLIEGEEFIEIDSPYELTI TV,

[ SRAzZETIRIRA Y NCEET 3,
BEHEOUNEICONTIE. SIROIURS
REECE LT,



62

48 Ry bhD—UHEE  T/\A ZELANER T3

8 Content Browser Mobile7 74— 3
VU THERT 3,

Xy RI—JBEBREFFIFHTY
JEZRA VNIRRT B

TIAZa—MSERLEVWFIEZRI VR
ERREITIIENTEET,

ZnEERy T BEEEEREEFERALT.
BHRLEWPIEZRA UM EBRE L. BRERE
TBRIENTEET,

Xy hDO—UBEBREEEZERLTE
l‘/:bbg—%

T rwestgesEoT 7o uAA Y MR
931 (61R—) OFIET ~ 3%#1T3,

2 TIAZa—DNetwork A= 31— >ST
Mode Settings®Scan Networks(102
R—) T. Execute%:EiR9 3.
AEHNEREOREERBLET,
BEREOBRBNRONZE—BRTINE
EP

3 —EhcEREERRTS,
XY RD—=0(PUERRA V) SR EE
ARERENET, SSIDICHERLI B
EMERINET,

4 Password&BIRL. /X27— RANEET
INRAD—REERET S,
BRI 5 3SSIDERIRT 3 &, /27—
RESARBEBHEBNICEEINET,
INAT—RERELES, XRvhD—2(74
L 2AA YN FEREEECRYET,

5 urommmEsss,

e DHCP
DHCPZEELF T,

Onlc 93L&, BEMICABICIPPRLRE
EWHTET,
FETAEDIPTRLAEAATZHE
. OfflCLZET.

e [P Address
AEDIPPRLRZANALET,
DHCPHAOffO & EICHMTT,

e Subnet Mask
RO TRy NIRIEAALET,
DHCPHAOffO & EICHMTT,

e Gateway
FIEARLVMDT =K1/ AALET,
DHCPHAOffO & FICHMTT,

e DNS Auto
DNSEHEIERGHREEZLF T,

Onlcg%&. BEIRICDNSH—/—D7
RLZZESLET, DHCPAONDEFIC
|auTd.

e Primary DNS Server
FPOLCARAL YD TS A4<)— DNSH—
N—=EAALZET,

DNS AutohOffo & FIcHERITY,

e Secondary DNS Server
FIEIRAV DAY S ) — DNSH—
N—=EANLET.

DNS AutohOffO & FICHRITY,

O mEp=T LS ConnectaBIRL. 74
LAY EET B,

FETAALTIESR TS
1 rwesigtes got o Rey MR

2

3

31 (61R—) OFIE1 ~3%1T3,

TIAZa—DNetworkXAZa1—>ST
Mode Settings®Manual Register(102
~R—Y) T, Execute#&EIRT 3,
RETBRE RYRT—I(PUEIRAVRK)
FHREEENRTINET,

HTFo#REREZITD.

e SSID
BREDOT7IERRA U SDSSIDEAFIL
EX8

e Security
BEStAREBIRLET,

e Password
BREDTIEIARAIVEDINRT—R%E
AALET,

e DHCP
DHCPEERELET,

Onlcd3E&. BFMICAEICIPPRLAA
BWHETET,
FETAEDOIPPRLREA AT ZIHE
&, OfflcLxd,

e [P Address
AEDIPFRLZEAALET,
DHCPHIOffO & FICHMTT,

e Subnet Mask
AHEOH TRy NI EAHALET,
DHCPHIOffO & FICHMTT,

e Gateway
F=hOIADTRLREAALET,
DHCPHIOffO & FICHEMTT,

e DNS Auto
DNSEENSHREZLET.

Onlcg%&. BEIMICDNSH—/—D7
RLZ&ZEGLE T, DHCPAONDEFIC
BT,

e Primary DNS Server
T547)—DNSH—N—DFRLZ&EA
HILET,

DNS AutohOffo & FIcBZITY,

e Secondary DNS Server
thH>451)—DNSH—N—DFRLZ%EA
ALET,

DNS AutohOffO & FICBZITY,

REHMTT LIedConnect®&EIRL., 77
TARA Y NCERTS,



63

48 Ry bhD—UHEE  T/\A ZELANER T3

LANT =D)Lz ERLTT/N
A A EERTS

AHEDUSB-Clig F(TR—) [CERW T 12
BHIRLANTS 74— (BIFE) OERLANEF&
Wi-FiJL—4% — (BI5E) #LANT —TJ LTS T
BZEICEoT. FINARETEHRETBIENTE
E3

AI—=KTA2/FTL Yk

E D

Wi-FiJL—%—

LANZ—7 )L Dkt B RRLANGRE

1 smIANTY 79— nB@LANETE
Wi-Fi)L—49 —%LANS —J )L CigH T 3.

2 FHOBEEANG.

3 TIAZa—dDNetwork A= 1— >Wired
LAN®DSetting(103R—<)) Z0nICHE
ERCR

4 Network*=2—mWired LAN®Detail
Setting(103R—2) T, BHEHELZITI.
e DHCP

DHCPARELET.

Onlcg3&. BEIMICABICIPPRLA R
EWHTET,
FIMTAKDIPPRLRZANTZEE
. OffCLZET.

e [P Address
AHOIPPRLRZAALET,
DHCPHOffQ &EFICHMTY.

e Subnet Mask
AEOHTRYRIZAIEAALET,
DHCPHOffQ &EFICHMTY.

e Gateway
TF—RITADTFRLAEAALET,
DHCPHOffQ &EFICHMTY.

e DNS Auto
DNSEF#HISREEZLET.
Onlcg%&. BEIMICDNSH—/I—0D7
RLZ%ZEELE T, DHCPHONDEFIC
BWMTY.,

e Primary DNS Server
TFS547 )= DNSH—/\—DF7 KL% A
ALET,

DNS AutohOffO & FICEBZITY,

e Secondary DNS Server
tHh>H1)—DNSH—NR—DFRLZ%EA
HALET,

DNS AutohOffo & FIcEMTY.

5 sessriissetsgiRl. 2Eras
RT3,

[T5EE]

o BEHEREATELLEE. ST SetEBIRLTILTL,
SetEFIRLAEH > HZRFRELIEABNRM T N E
Hh.

o USBEMLANTY 79 —dType-CRIAZHERL TV,
FHEY A - XY MR TY TI-DZEREE TS
HLET, iEL. IRTOEBOBEARIIETZED
TlkHYE A,

o HIRLANTY 79— (RI5E) OMRE(C Lo TIFAEAR
OWi-FiBEHEECHEERIFIIENBYET,



64

48 Ry hTJ—7UiKHEE

A —XY R T D

AtE. USBTHUYY, JL4VLZLAN, B
MMLANTA VI —Ry NIRRT 22 &N TEE
ERS

USBFH > % ERLTE
IS

USBT—JILTAME T — NI A& ES L.
Z27—h7#>OERIGEFERALTA VI —Xv I
BRTEEd,

A=K7 > DBIEREZT B

AY—=h7#>OFHFI) VT BEEBHMICEEL
E3x

FHLLIF. RY—hT Y DOEREBEETEL
AR

AI— KT # &R BEICEY 5173

A#DUSB-CifF(7R—) [CUSBT—T'

LVEEHL. 27— N4V ERLET.

[T5EE]

o ZI—KI7#VOEYMFIH/BRYALIE. AEOERE
Yo RETIT o T T,

e USBIN\THENLTAY— TV ERYFFIBA.
USBFH UV FIMERATEZEA.

o USB/TILFBHF(TR—Y) ICOVEa—9—HER
TNTWVWBIHE. USBTH UV T IERTEZ A,

XyRTD—H (IS T5
1 *omEsIAnz.

2 TIAZa—DNetworkA=a1—0D
ModemT, Setting(103X—<) #0OnIC
BET S,

AI—=RIAVH DR IEEBMICT
Z)

ZAZ— k7 #>TContent Browser Mobile
FIVT—2avaEFERLUTEAE 2 =RIE
ET31EA1E. TILAZa—DNetwork A

Z—a—>Modem®Camera Remote Control
(101R—%) #Enablelcs8E LT,

JA4YVYLALANZAFT—>3Y>
£ —R(Wi-Fi Station®—R)
TiERT 5

Wi-FiJLl—4— (BI5E) £BITNAXDFHFU>

VaEERTEZIELICEST. Wi-FiIRT—3>
E-RTAVI—Xy BRI ENTESE
ER

LANT =T )Lz A LTS
EEC

AR—=KT#>/ J>Ea—49—

AN

—

AHEDUSB-ClHEF(7TR—) [CEW T

BIRLANTS T4 — (RIFE) OBRLANIGF&
Wi-FiJL—4 — (BI5E) ZLANT —JIL TSI
B2EICEDoT. 19—y NCERTZE

Wi-FiJL—4 — NTcEEd,
@ 2AI—KT#>/ aAvEa1—4—
HFTLwhk

R OZ AN

Wi-FiJL—%—

AZ—kT7HV/
HTLwvhk

Wi-FiJL—4 —ARLANT =T ILAEERALTFN
AZEEFTT B (63R—Y) OFIETELL
9.

Wi-FiL—4 —FFIEF /A ZIAE TIA4V LR
LANZXF—> 3> E—R(StationE—R) TiES
I3 (61R—) OFIETEKLET.



65

4F Ry RND—U#EE AV 9—XyMNERTS

[TEE]

o USB/VIILFIHF(TR—Y) [ca>Ea—4—biEH
INTWVWBIZE. USBERLANTPS T4 — (BIFE) 34
HTExtA.

o HRLANTS 79— (BI55) DHREIC &> T IFAIERER
OWi-FiB S CHEERIFTENBYET,



66

48 Xy bhT—UHEE

T7AI ZEXT 3

AICERLIETOF ST 7AIINDPFITFIL
T E, AI—RT I DOTIEIRA VMR
HTERELEAVI—Xy DY —/—PO—
HILRY BN EDOHY—/IN—ABX G BRI ENTEFE
ER

w95

XYRND—J(C¥ERT S

Ty —yhERT 31 (64R—) £l
FF)IX4 ZELANSES T 2] (60R—2) OF
JEICHE-T, KA AV —RXyhEflFO—h
ILRY D= ICERLET,

T 7ML DEXRFTZFIRT D

B LT 7L ZEET I —N—2FHEL
THETFT,

1 TIAZa—DNetwork A= 1—DFile
TransferT. Server Settings1(F (%
Server Settings2. Server Settings3) %
EiRT 3.
EXARTEENEZRINET,

2 EEARTEEOSERARETS,
Display Name
ERFEDIVANIRTINZY—/—Z% A
ALET,

Service
H—N—-DEEEZRRLET.
TFTP) : FTP H—/X—

Host Name
H—N—=DFP7RLRZAALZET,

Port

Y- N—[CERITIEOR-rESEAAL
E3

User Name
1-Y-a%ZAALET,

Password

IZAT—REAADLET,

Passive Mode

Ny TE—-ROON/OFFAITVWET,
Destination Directory
BXETALIN)—2EZAALET,

[T3EE]

o RER, WEFWRELNFR " " TRRINET,
ZOXFEECTALIN—AERELEBED
BRI NERA.
HUIRELTLESLIBAIR. IRTOXEEHIR
LTAALELTLETL,

o XY —N\—THERATIFEVWXF%Destination
DirectorylC AALEBZE. 77— -0
R—LFALYRN)—CEREINET, FRTER
WXFFH—N—CE>TRBYET,

Using Secure Protocol

TFaT7HFTPEREAITOINE SO EREL

E

Root Certificate

SERRE DR AHIAHPHEEEITVET,

e Load
FlE3TSet#:EIRT B &, CASIRAEZE A5
HIAHET,

* FiAHALEEBAE(FPEMAZIN T, CFexpress Type
A/SDAH—RZOvYKB) [CEALLAEY—H—K
DIL—kF 4 LUK —(Z"certification.pem”®
TFPANETEFAATEVWTET W,

e Clear
FlE3TSet#:#EIRT B &, CAGIEAEZEAR Y
DPLEY.

e None

FIAH/ HEZTVE A,

[TxE]

o CASIEREAFTHFATIRIE. ABORFRAIELLER
FLTLLETV,

e XAVC-14096X2160P/3840% 2160P
59.94/50PTi#Ed(E. LoadLBIRTEEHA.

o EBEMRICIE. CASIBAE%#Load/Clearg 32 &
IFTEEHA.

Root Certificate Status

SFRAZE DT HFIAHIREA R RLET,

Reset

Server SettingsDREAVHABEICRL

ER

BRENTT LIcSSet&EIRL, RENE %=
HET 3.

HET TR, BT SetzBIRLTI LT,
Set=BIRLIGD>mE. RELAEN
RERENZEEA.

T7AMII % EATEIXT S

AEOAEY—H—RCERLLTOF DT 740
WFVIFIINT AN —/N—ICERELET,

HLAXAILEENSAE ) —H—KRD
TOFTT7AILAEET D

1 #mez/c25lANEST 60—
S

2 TIAZa—DOThumbnailA=Za2—®
Transfer Clip (Proxy)T. Select Clip%:#
RT3,
BENIIAZ2—NSHLAXAILEEICE
DYET,

HOXRIBIEIL. YARCMIEEmEZIE T4
=RV THLRAIIBEE TTZET.

3 ERLEVIUyTEBIRL. BEICMENU
Ko RET,
EREFORREENERINET,

4 Execute##RT 3,
BIRLIT7AILICHIETZTOFTT 74
IHERXY 3 TELTERI N, XM
mENET,
BXYITAOBEBRNTETTEL. B
REENKRINET,

5 oksziRrvs.



67

48 Xy RD—UEE 77 AEET S

77\ —1EERX T B
FlE27Select ClipTld#<. All Clips%#iR
T3ET7AICRETZTOFIT7IIH—
BEEINET,

[TEE]

BEXTEZT7MILOLRIF2004TT,

YLXAILEENSAE)—H—KD
FVIFINT 7L Z2EEET B

1 Hige 511 2% LANEST2(60 <—
),

2 TINAZa—DOThumbnailAZ=a21—®
Transfer ClipT. Select Clip%:&iR9 3.
BEEAIIAZ 23— SH LRSI BEREICE
DYUET,

EOXIRIEIE. YAXCIIBEREREZIET4L
=RV THLRAIIBEETITAET,

3 EELEWIUyTEBIRL. BEICMENU
K BT,
ERETORREEERINET,

4 Executen®IRT 3.
EIRLIET 7 LAGR Y 3T LTBRS
N, EEABBRINET,
EXVITADBRIET 2L, BRE
BEHENETINET,

5 okzmirys.

T7A\ % —EERX T BICE
FlE2TSelect ClipTlE#<. All Clips%:&iR
TB3ETPAIIN—EEETNET,

[TEE]

EXTEET7LOLRIF2004TT,
TPAIVERE DR ZT 2

TILAZ a—DNetwork A= 1—DFile
TransfercView Job List(103R—3) %8R
TBE. TPAIEERORERERTIIENT
FFT,

Content Browser Mobile7 7U4s—>3>®
EEAS T PAIIEXDIRELAHETEZIELET
FET,

[AE]

TILAZ a—DNetwork A= a1 —®DFile TransferAuto
Upload (Proxy)(103R—%) #0n(CERET R E. RV
KNO—VEGIREDHZE, SRR TEICDefault Upload
Server(103R—3) TREI NI —N\—CHLTESH
MIc7O0F> 770 ERELET,

[(TEE]

o XY TF2004-FTERARETT.

e IY3TUZNIABOBREZV>THRIFINETH
POWERZ 4w F&STANDBYIcEFIC /NNy FJ—/\y &
ZRYANTRELTEREZYSLIBAICIE. &RATI0H
FNREOESFERNRET ZARMENBVET.

o NyF)—EBEETRECHILEICEBMINEY 3T
[EDWTIF, ¥YaJdURMLEICRESNEEA,

o JPAIEXPCEEINIS—(CHBE, EXEY—
NR—DBREPRECLSTIE. RALLFTOT )y THER
EKTTRBBZIENBYET, ZDHERERET—
N—DREPIREZHEELTILTL,

X2 TP EFTPELEZITOIC
=S

TR Y —/N\—E DEGEICFTPSD
ExplicitE— R(FTPES) #fEH332&T. 77
AINWEBESELTEEXTEZIENTEET,

TFa7EFTP EXDERE

TFaAFRHRFTPERERITSICIE. 77 ILERRST
H—/\—DRET. Using Secure Protocol%
ONIZEREL. FIREDFIFAHFEITVET,
BEAEILCDOVWTIE. T 7ML DEREE%E EER
T21 (66R—=) BZEIZTL,



68 ‘Sﬁ YLAXAILEER

TLXAILIEH

THUMBNAILRY > (5R—) g & AEY—H—RICPBINTWVWBR IV Y TH, SLXAILEENE) BEICRTIINET,
HLAXAIBEE CERLEV )y IO BERRIBTZCENTEEY, BEERIE. Ea—TJ7104— ABETHEZI—ICRRTEET,
THUMBNAIL/RY V&38R dE. SLAXAILBEEEZRTL. BEERICRYET,

[TE=E]

YLXALEECIZ REBRLTVE T4 -y FCIRBEINI VY TOHFDHRTFEINE T, RELLBTOI )y THRRTENBVEETE,

B E DR

BHETEICE. A—YIMHEDI )y TOBRIRRINET,

1. HLAXCIL(HE/E)

BV TORKREKRTT, RBEFICET)YTD
KEIL—LHBENCRREICREINET,
HLXAIWOTICEI Iy T/ 7L —LIERHNERR
INFET, JIAZa—DThumbnailAZa1—
>Customize View(98 R—<) ®Thumbnail
CaptionTRTANBZEE CTET,

REBRINTVBAE)—H—RE/NAS1A R ERR
(ZOF7 hENTWVWRIGEIREICOVII—IERR)

h—VIL(EE)

12 TCR00:00:00:15

TV TES/ V) v THE

(500000807

TCR00:00:00:34

m __

TCR00:00:01:56  TCR 00:00:02:02  TCR 00:00:02:35

BIRINTWBI)yTDI )y TERRTIIN
¥,

3. BBBOETAIA—TYh
BIRLEIVYTDT 7T A= v MRRRE
nv.

1 - SE e
R 00:00: TCR00:00:04:45 TCR00:00:04:57  TCR 00:00:05:21
p e (C1ip0006) 6
( | ) ( | ) ( | )
3 4 5
2. JIvT& 4., ¥R IR IR

BHERE-—RTERINZIVYTOHBEED
H. FOE—RNRREINET,
20—-&JAvIE—YavEFRInksivrs
DHZEIE. ARIICTL—LL—MRRINET,

5. 7))y 7 OUNEREERE(Duration)

ERTA—TYMETHEELETV, F AT TOT 4 -7y ML) BEATIBICITERILET L,

6. {ERLEE



69

5& HLXAILEE

1)y TDOHB

v

LIV )y TZBETS

AEMNERFLEHR(Stby) DEF(E, RIS

Yy TEBETBZENTEET,
1 B&EszrEU—H—REANS.

2 THUMBNAILAS > %187,

3 TILFELIY— (TR=2) FfIF<TIL
FIPoI2avHdAVILER=) %

BIELT, BEZRBRLEVWI Uy TDOYLA

XAILIEH=VILEZEDES,

A TLFELo9—DRERY S EFETILF

TP aVFLVILERT,

BRUIIVYTOERBENSBENBEYE

ER

BERERIRORY Y TITVET,

IUNFELII—DRERI VERIEIILFT

VI avI1LvILEL :
BEE—BEFELELET,
}5—EHTEBEICRYET.

TIFELII—DERY Y / BERY VHL
7))y TOEBELIGFRDOI ) v TICH

BLFT.

TIFELII-DERY Y /BRI VRAL:

EEBELFT.

RFLZDHZ LIREFECRY £,

CANCEL/BACK K9 > :

BEZFLEL. SBFILREICLET,

[T5EE]

o J)wFEI )y TDBERTIZ. —BHICEERNELN
Y, BIEEICRZIEAENBY TS, FZOMITIREH
TEE A,

o YLARAIIBEETY Vv T BRIRLTBERRBTRE.
)y T OREEBY OBEREHENZIFEHSGY X
9. Ty TOEBBNSENDOLGWVIRKTHET 3 ICIE.
—EBEE-—RCLEBT—RELEICL. 2ILFELY
H—DERYI VERLTY )Yy TOEBEICRLTEE .S
ToTIET,



70

58 YLXAILE

1) 7°T5E1"E

YLRXRACILEETIE. ZILAZ 2—OThumbnail

AZa—AFRLTY )y TOBREDLERERD
REEHNTTHETT,

MENUAR% > % &3 L LCThumbnail & #R¥

&, ThumbnailAZa1— (98R—) HiF

RINET,

Thumbnail A= 21— Dk
Vab:

TILFELII— (IR—) £FTILFT7
22 3VHFALVILER—) BIEELTIE
HEERIRL., YILFELII—DRERYT V&
FRULF TIP3V F1VILERLTLEY
L.

CANCEL/BACKARY > (5R—
BEROBE@EICRY £,
(3]

AZ1—ERREELEETDREICIOTRIRTELHWVIE
BhsBYET.

) BT

5y FRAEAZ 21—

Display Clip Properties
Set Clip Flag
Lock/Unlock Clip
Delete Clip

e Transfer Clip

e Transfer Clip (Proxy)

e Filter Clips

e Customize View

VY TREAZ 21— ICDVWTEELLIE,
ThumbnailAZa1— (98R—2) #ZEL 2
T,

7y TOFHMEREEZRTI S

ThumbnailXZ a2—®Display Clip Properties
(98R—2) Z#EIRT 2L, VU TOFME
BEEERIINET,

IV T TS5 %33

Iy F Iy )wFT7S5(0K. NG, KPZ—7)
BAFRE VIvTISTERBECI Iy TR
BYUAATRINTZIENTEET,

)T IS RMF TN )y TOHLRAIL
#EIRL, FIAZa—dOThumbnailA=a1—
®Set Clip Flag(98 R—) ha Uy T TS5
JHBEUET,

REME fFMENz009F 7359
Add OK OK
Add NG NG
Add KEEP KP

[AE]
o V)T IS EEERBIVYTIETHAFIILIRY VE
BALTYVY T 757 %3222 TEET(BIR—

),

e Clip Flagih¥ > (5R—3) =83 &, ERLEY
VT DY LXAILICOKD Y )T TSI hFIFoNnE
F(54R—-2),

T4IWI—RIVyTH LA EEEZ
KNI B

TIAZa—DOThumbnailA = 2—®Filter
Clips(98R—%) TERRLIEWIT ST EEL
ECEBELETSTOMVWTWE Iy TDH %
RNTBDIENTETET,
ITRTOIVwTHERRTBICIE. AllERATL
=g AN

[AE]

DISPLAYRY > TI4INY—%IBICEIVERZZLETE
9.

7)y T ZHIBRT S

AEV—H—KhE5IVyTHBIRTZIENT
FTFT,
TIAZa—DOThumbnail A= a1—®Delete
CliphsSelect ClipxfzZAll Clips&EU XY,
Select Clip :
FEEOIV) Yy TREBRLE T, 1EICIEHD
Iy TEBIRTZZEETEET,
All Clips :
KRINTVWBTRTOY ) w THEIBRL
EJ R

YLXAIEHEDFEHRZEET S

YLXANDTICRTEINZ IV T/ TL—L
BREEELET,

TIAZa—DOThumbnailAZ21—®
Customize View>Thumbnail Captionm5.
ERLEVRBEEEUET,
Date Time :

ER B E - IRREEHR
Time Code :

A4 L0—R
Duration :

U ER B E]
Sequential Number :

Y LAXAILES
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TIAZ 21— DR &R

MENURY > RIBLT 2 &, IREPBECH
BRREREETOIVIAZ2—HE1—T74
VA —BEEICRRINFTONBETFEZY —
CRRETEZZEELTEET)., TEOAZ1—
MoBEIRLTRELET,

A= a—1ER

UserAZa—
AROREEESHAZa—
Edit User Menuh SiR&ETE X,
Edit UserAZa—
UserAZa—DiR&EICRTIRE
ShootingA=a1—
Rz lCEAT2RTE
ProjectAZa1—
7OV NOERKEERE
Paint/LookAZa1—
EECET2HRE
TC/MediaAZ 21—
GALDA—RELBATATICBATRHRE
MonitoringA=a1—
EFAHAPE2—T 70 VY —-HAICET
BEE
AudioXA=a—
BRICEAT3ERE
ThumbnailAZa1—
YLXAIKRRICETS
TechnicalAZa1—
RIMTNEREDRE
Network A= a1—
XYyRND—JICETBZHE

%IT!:

EIFII
it

MaintenanceXAZ—1—

7)L>(:1_@B%E Shooting ISO/Gain/El
ND Filter
. Shutter
) Base Setting Auto Exposure
(LIBHHBEDFR  Focus White
S&Q Motion White Setting
LUT On/Off Offset White
Simul Rec Focus
Proxy Rec S&Q Motion
Interval Rec LUT On/Off
Assignable Button Noise Suppression
Assignable Dial Flicker Reduce
Multi Function Dial SteadyShot
All File Project Base Setting
Clip Name Format Rec Format
Format-Media Cine El Setting
VF Setting Simul Rec
Zebra Proxy Rec
Zoom Interval Rec
Menu Settings SDI/HDMI Rec Control
Edit User Menu  Add Item Assignable Button
Customize Reset Assignable Dial
Multi Function Dial
User File
All File
Paint/Look Scene File
Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix
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FHIRE  ZILAZ a— DR EFEfE

TC/Media Timecode Technical Color Bars
TC Display ND Dial
Users Bit Tally
HDMI TC Out HOLD Switch Setting
Clip Name Format Touch Operation
Update Media Rec Review
Format Media Zoom
Monitoring Output On/Off Handle Zoom
Output Format Menu Settings
Output Display Fan Control
Display On/Off Lens
Marker Video Light Set
VF Setting APR
Gamma Display Assist Camera Battery Alarm
Peaking Camera DCIN Alarm
Zebra Network Access Authentication
Audio Audio Input Wireless LAN
Audio Output AP Mode Settings
Thumbnail Display Clip Properties ST Mode Settings

Set Clip Flag
Lock/Unlock Clip
Delete Clip

Transfer Clip

Wired LAN

Modem

File Transfer

Network Reset

Transfer Clip (Proxy)

Filter Clips

Customize View

Maintenance

Language

Clock Set

All Reset

Hours Meter

Version
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TIAZ 2—DEIEAE

MENURS > 2 RIBLT 2 &, SFEAREZITD
INAZa—HNE1—T 74 V5 —BEREICERRT
NEFTABETAEZYI—ICRRETEZ2EET
FET).

A= 2—BESR

MENU7RY > (5 R—2)
RELIBZETIAZa—%2KRRLET, 7
WA= a—DORRPICHTEIERRICLE
R

VILFtELIY— (BAB+HRE) (TR—)
8AMARY VAERTE, h—VINLETEAR
ICRBELT. AZa1—TBEYREEERER
T*%d,
VIFELII—DRERI > ERTE, FE
RULTVWBEBEARELE T,

TIFT7o 723> 14VILER=-)
CILFIT7oIvavd(4vILzmgeEh—Y
B ETFCHBEILT. AZ1—BEPREE
EBIRTEET,
WILFT7o72a>vF1(vIL R, &
RULTVWBEBEARELE T,

CANCEL/BACKHRY > (5_—2)
1DORIDOBEEICRY X 7. EMOEEIFTF v
YEILENET,

(7]

o EVMEKR(A3R-Y) CH>TVBE, TIAZa—

HIRETEE YA,

o AZa1—ZRRFEELETDREICLO>TERTEAL
HENBYET.

AZa1—%BEITS

8AMMNY VEHTH FEVILFTIFVITT

VALV EEBILTRELEWEBICH—YILE

Eht. RERY VELEFIIILFTIZVI>aY

LY EBLTRELE T,

o FIRBEEAKRRINZHEIRE T 7(EHA8
TRRTY, BREN—EICRRTTEVEE
Bld. =YL ELEFCBRHTEERTNIY
O—-JLLZEY,

o BIRFOHEHATVIEEOIHZS
(B : —99 ~ +99) (F. BRIV 7 LR
INFLA. XEH/NATAMRRICHYRE
EENTHEGRETHEZZEERLET,

o ETIEE TExecuteZ:ERLIIFEIE. FE
TRRENETINET,

o ETAICHRNLELRERA#ERTSE. —
BAZ2-HER. BRAAvE—IHRRIN
FY, Avt—JIcHoT. ETTEhFvr>
TILTZhERIRLTLIET W,

XFINe AT

Tr7AINRRE, XFHERETBEEZERL
IBFRE. XFFNOANEENRTINET,

1

All File:File ID

Kurokawa_Scene_001 a

[@ ABC[® abc [e 123 [e 5 |

Bbcdefghi jk I m

nopgr st uvwxyz

2 3

T spmtssamen. srEwLFTr>
723y 4vILEBILTAALEVWES
A THEFERL. RET 3.
ABC: BAXZF
abc: ®IhX=F
123 : =
#S$ IR E

2 BARXFIATHEXTRBRL., RE
3.
H—VILRROMIBE L% T
Space : h—=VYILDAIEICAR—X&EA AL
%7,
AV EEBBLET,
BS: h—VIOEOXZ#HIFRLET,

3 AAHDo%S. DonekBIRL. RET
7
XFIIARELT. AHBENEIET.

AZa—00Ov T L EF

TIAZa—OFRFEOVI LT, UserAZa—
ElIaRRIERIENTEET,
25— ABEECIIREEECTLHLLEYET,

AZa—A20Ov093

1 wnszzrvovaveqrviamians
MENURY > %2R LT 2,

2 Technical A= a2—®MMenu Settings®
User Menu with Lock%:&iR9 3,
[TEE]
MENUARY > DHZRHLLTREDIIAZ1—%
FRULHE. Technical A= 2—®MMenu Settings
IZlEZUser Menu OnlyMEBERENFE TN, TIILFT7
2723V VILERLUGEHSMENUARY V% RIF
L93%&. User Menu with Lock RRENE T,

3 OnEBRUTRERS Y ELFTLFT7
S HYIVEA I ERT,
Ea—771 Y I—BEEOERM, IEEES
ANEEYYEDYET,

4 gmomssrhT3.
0000 ~ 9999 D AHTDEEBMA N TEZ
J, #EA{EIZ0000& A >TVWET,
BIEEAAL. RERY SV ELFTILFT 7
VT avILVILERTE, H—YILHR
DHTICBE L%,
FRTOHAEAALLES. H—VILASETIC
BHLET,
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5 sggovsrrwiszorossaveq

VILZRT,
AADHEELET.

TIWAZ 21— DBIEAE

BRENET LAY E—IHRRRIN,
UserAZa—RRNICYIVEDYET,

AZa—0Ov I %fERT S

1 wuzorvrvaveaqviamians

5 sgtovsrrwiszoryssavey

YILEIRT,

ANHDHEELET,
AZa—AOvILIEEFDRBIHESEAA
LEBSH—BLIEES. OvIHERT
FZEDAZI-RRICYIVEDYET,

[TEE]

MENURY > & R#RLT 3. .

2 UserAZ a—®MMenu Settings®User

Menu with Lock%#iR9 3,

[TEE]

MENURY > OHERIFLLTEEDIIAZ 2—%
FRLKEIBA. TechnicalAZa—®dMenu Settings
IZIZUser Menu OnlyWRREINET M, YILFT7
272 aVIALVILERLGNSMENURY VA E#H
Ld3&. User Menu with LockhRREINE T,

Off & BIRLTRERY VE 2 ITILF T 7
22 aAvILYILERT,
Ea—TJ714 V9 —BEOERRN. BEiIES
AAEEICTIVE DY ET,

AZa—%0OvILIEEDESEANT
3,

BEEZANDL. RERIVEREETILFT7
2T AVIALVILERTE, H—VILHR
DOHTICHELET,
TRTOHTEAALRES, h—VYILHSetIc
BEILET,

AZa—%#0v I LIESDBAFESEANLLEESH
A—BOGZEE. OvIZ@ERTEERA.

BAHESIE. TNEETDeH. FRICERBRERITIL

ZHEOHLET, TNEFTFY-—EXROCEBVWE
pELETV,
TROTIWAZ1—DAZa1—-IEH%ZUserA Za—[c&
BETICAZa—2OvILERE. RREETYCF
TIURIVICRET B LB TEEREA,
TROWEEATYAFTILRI Y CTHA VLTV
Bl AZa—%20YILEBRTFHIFTILORE

TIAZ2—DAZa—
15H

FHAFTTILRG >
DR

INAZ2—DAZa—
s

FHAFTILRGT >
DERAZ

Shooting>Focus>
AF Transition Speed.
Shooting>Focus>
AF Subj. Shift Sens.

AF Speed/Sens.

Monitoring>Gamma
Display
Assist>Setting

Gamma Display
Assist

Shooting>Focus>
Focus Area

Focus Area

Shooting>Focus>
Focus Area(AF-S)

Focus Area(AF-S)

Shooting>Focus>
Face/Eye Detection
AF

Face/Eye
Detection AF

Monitoring> Peaking
Peaking>Setting

Monitoring> Zebra
Zebra>Setting

Audio>Audio Volume

Output>Volume

Shooting>Focus>
Push AF Mode

Push AF Mode

Technical>Touch
Operation>Setting

Touch Operation

Technical>Handle
Zoom>Setting

Handle Zoom

HEaHIBICOfflc Y £ g,

Network>Wireless NFC
LAN>NFC

Network>File Auto Upload
Transfer>Auto (Proxy)
Upload (Proxy)

User User Menu

INAZaA—DAZa— FHAFTILIKI>
HH DFERAL
Shooting>ISO/Gain/ Base ISO/
El>Base Sensitivity.,  Sensitivity
Shooting>ISO/Gain/

El>Base ISO

Shooting>Auto AGC
Exposure>AGC

Auto ND Filter

Shooting>Auto

Auto Shutter

Exposure>Auto

Shutter

Shooting>Auto Auto Exposure
Exposure>Level Level
Shooting>Auto Backlight
Exposure>Mode

Shooting>Auto Spotlight

Exposure>Mode

Shooting>White>
Preset White

Preset White
Select

Shooting>S&Q S&Q Motion
Motion>Setting

Shooting> SteadyShot
SteadyShot>Setting

Technical>Rec Rec Review
Review>Setting

Thumbnail>Set Clip  Clip Flag OK
Flag>Add OK

Thumbnail>Set Clip  Clip Flag NG
Flag>Add NG

Thumbnail>Set Clip  Clip Flag Keep
Flag>Add KEEP

Technical>Color Color Bars
Bars>Setting

Monitoring>Display  Lens Info
On/0Off>Lens Info
Monitoring>Display  Video Signal
On/0Off>Video Signal Monitor
Monitor

Monitoring> Marker
Marker>Setting

Monitoring>VF VF Mode

Setting>Color Mode
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UserA”=a1—

BAZ1-—TEEBLUNIS T 2EEEFUTDES YT,

User

AZa1-—I8H

AE

Base Setting

Project > Base Setting® A,

Focus Shooting > Focus®OA A,

S&Q Motion Shooting > S&Q Motion®OARA,
LUT On/Off Shooting > LUT On/OffO A,
Simul Rec Project > Simul RecOARA,
Proxy Rec Project > Proxy RecODRA,
Interval Rec Project > Interval RecDAA,

Assignable Button

Project > Assignable Button®R A,

Assignable Dial

Project > Assignable Dial DA,

Multi Function Dial

Project > Multi Function Dial DA,

All File

Project > All File®d A A,

Clip Name Format

TC/Media > Clip Name Format®OR A,

Format Media

TC/Media > Format Media® N &,

VF Setting Monitoring > VF Setting® W&,
Zebra Monitoring > Zebra® A&,
Zoom Technical > ZoomDA A,

Menu Settings

Technical > Menu SettingsORA.

Edit User Menu

Edit UserAZa1—%&RRT 3,

[TE=E]

UserA=a—I[tEditUserA = a—IC £ o TAZ 21— IBHDBMPHIRHATEE T,

RETETZREMG 20N LRETT,
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Edit User A= 1—

UserA = a1—TEdit User Menu%:&iR9 3 &, Edit UserAZa—HEIREEBICRRINET,

Edit User
AZa1-—I8H B LB EE AA
Add Item UserAZa—(CE2MEEBOER B

UserAZ1—IEH®EM

EEGH

Customize Reset
UserA—a—IEH®DY
vk

UserAZ1—DEFRIEB%Z TIHHE
BDIREICRET,

REPIGEIRLIEE2ME  Delete
BnIER

UserAZa—IcERLIE 2B DIA
BaHIFRT 3,

Move

UserAZ 1—[CERULEIBEER2 LAY
Z5.

Edit Sub Item

UserAZa1—[cEF L EIRBEDIE
BIcE I 2B % mEER - HIFR) o
5,
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ShootingAZ=1—

EAZ1-THHOWES LUREMERIUTOESY TT,

TimhErR OFHAREMEIF. AXF(H):18dB) TRLET.

Shooting>ISO/Gain/El
TAVICEATEREETVET,

Shooting>ISO/Gain/El
TAVICEATEREETVET.

AZa—1HH MBEEREE

RS

AZa1—-IBH MIBLHREE ABE
Mode ISO/dB TAVREE-—RZ2BEIRT 3,
ISO/ SREERICDVWTELLIE, TISO/Gaint  #o4>DF )ty ME<H>%2RET 3,
Gain<H> Za—OREBEEHAE (106R-) %
TERETW,
ISO/ FREBEBICDWVWTEELLIE. TISO/GainA TA4oDF) Yy ME<M>%ERET 3.
Gain<M> Za—-OFRFEEEAEE (106R-) &
BT,
ISO/Gain<L> SREBEHICDWTEELLIE. TISO/GainA TAODT) Yy ME<L>%RET 3.

Za—-OREBEEHAE (106R—-) %
BT,

Exposure
Index<H>

Base ISOAISO 800 &+
200El / 4.0E
250El /7 4.3E
320El / 4.7TE
400El / 5.0E
500El / 5.3E
640El / 5.7E
800EI / 6.0E
1000El / 6.3E
1250El / 6.7E
1600El / 7.0E
2000El / 7.3E
2500El / 7.7E
3200El / 8.0E

Base ISOHISO 12800 & F
3200El / 4.0E
4000El / 4.3E
5000El / 4.7E
6400El / 5.0E
8000EI / 5.3E
10000EI /7 5.7E
12800El / 6.0E
16000El / 6.3E
20000E1/ 6.7E
25600El / 7.0E
32000El / 7.3E
40000El /7 7.7E
51200El 7 8.0E

Exposure Index<H>%RET 3.
Cine EIE—REOHBEMTT.

Exposure
Index<M>

R EfEIFExposure Index<H>¢RLTT,
Base ISOAYISO 800 &
1000E! / 6.3E
Base ISOAISO 12800 & F
16000El / 6.3E

Exposure Index<M>%E&E 9 3.

Exposure
Index<L>

SR EfE[FExposure Index<H>¢RL T,
Base ISOAISO 800 & F

800EI / 6.0E
Base ISOAISO 12800 &+

12800EIl / 6.0E

Exposure Index<L>%3RE ¥ 3.

Shockless
Gain

On / Off

N

>

IwILRTA VREARON/Off T %,
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Shooting>ISO/Gain/El
TAVICEATEREETVET.

Shooting>Shutter
Bf vy y—DEFRGEEZRELET,

AZa-IHH MBEEREE

AE

AZa—1HH MBEEREE

RS

Base High / Low SDR/HDRE—RANEEREZRET
Sensitivity 3.
Base ISO IS0 12800 / 1SO 800 Cine EIE—FRADEEISOREZRET

%,

Shooting>ND Filter
NDTZAIIWY—DT )ty MEZRELET,

AZa—-I6H MEEREE

RE

Preset1 1/4/1/8/1/16 /1/32/1/64 /1/128 NDTAIILY—DF Uty MOERRET
2.

Preset2 1/4/1/8/1/16 /1/32/1/64 /1/128 NDTAIILT—DF Iy N 2DERRET
2.

Preset3 1/4/1/8/1/16 /1/32/1/64 / 1/128 NDTAIILY—DF )y R3DERRET

%,

Shooting>Shutter
BF vy I —DOEEREEZRELET,

AZa1—-1RH MBEREE

RE

BEFIvvI—DE—REEIRT 3,

BT ORVHEEFREEBICIRELEVGS
BEICFERTZ, BRTIvvI—RES

RETBSpeed(ZE—R) E—REHAE
TIvvd—BEERETSANgle(BE)

E—-RAERIRT 3.

Mode Speed / Angle
Shutter On / Off
Speed

On/Off

SpeedE— REIREFOTENIFE &,
Shutter Speed DEREMEICRESMTILEN
ICTZNEHRET S,

Shutter
Speed

64F ~1/8000
REEF. BIREINTVWBET AT+ —T
NOTL—LRBARBICL>TERYVET,
59.94P:
64F / 32F /16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F /1/50/1/60 /1/100 /
1/120 /1/125 /1/250 / 1/500 /
1/1000 /1/2000 / 1/4000 / 1/8000
50P:
64F / 32F /16F / 8F / 7F / 6F / 5F /
4F /3F/2F/1/50/1/60/1/100 /
1/120 /1/125 /1/250 7/ 1/500 /
1/1000 /1/2000 / 1/4000 / 1/8000
29.97P:
64F / 32F /16F / 8F / 7F / 6F / 5F /
4F /3F/2F/1/30/1/40/1/50 /
1/60 /1/100 /1/120 /1/125 /
1/250 /1/500 /1/1000 / 1/2000 /
1/4000 / 1/8000
25P:
64F / 32F /16F / 8F / 7F / 6F / 5F /
4F /3F/2F/1/25/1/33/1/50/
1/60 /1/100 /1/120 /1/125 /
1/250 /1/500 /1/1000 / 1/2000 /
1/4000 / 1/8000
24P/23.98P:
64F / 32F /16F / 8F / 7F / 6F / 5F /
4F /3F/2F/1/24/1/32/1/48 /
1/50/1/60/1/96 /1/100 / 1/120 /
1/125 /1/250 /1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000

SpeedE—RNZEREF, Yvvy—IE—RK
ERET D,

Shutter
Angle

64F / 32F /16F / 8F / TF / 6F / 5F / 4F /
3F / 2F 7/ 360.0° 7/ 300.0° / 270.0° /
240.0° / 216.0° 7 210.0° / 180.0° /
172.8° /150.0° / 144.0° /120.0° /
90.0° /86.4° / 72.0° / 45.0° / 30.0° /
22.5°/1.25° / 5.6°

Angle®—R #EiRF HAEAZRTETS.

ECS On/Off On / Off

Extended Clear Scan®RE%On/Off ¥
3.
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Shooting>Shutter
BF v vI—OEERGERELET,

Shooting>Auto Exposure
BEIBHAROREEZTVET.

AZa-—18H MBEHREE ABE AZa-—1H MBEHREE AE
ECS 23.99 ~ 8000 ECSE—N #IRbE. ECSEBEARTET S, Auto On /7 Off A—hovwyd—0>bhO—)LiEEEAON/
Frequency SBREEIF. BIRINTVWIET AT+ -7 Shutter off93,
NDOTL—LERBICE>TRAVET, A.SHT Limit  1/100 /1/150 /1/200 /1/250 / 172000 #—b>vyv9 —tSEORES v vI—2
VHERUATOEEYTT, P—REBETS,
59.94P:60.00 - N N
i A.SHT Point F5.6/F8/F11/F16 F—ho vy I —EBIETBIBHZ TR
50P:50.00 T OFEERETS
29.97P:30.00 — = - =
23.98P:23.99 Clip High On/ % SIEEROREEEHFALT. SBECNT
24P:24.02 Detect 1/2/3/4/5/6/ Custom WEAROHEZ T ICERLTEHAEEAE
; Window IERNEEEEIRT 2. (BHAFHHA
Shooting>Auto Exposure BUTND & * (L)
BHEHARORELZITVET, - — -
— E—— — Detect On / Off RIS EEE DO FR~%EONn/Off 93,
AZa1-THE MECREE NE Window o
Level +3.0/+42.75/+42.5/+42.25/+2.0/ BEIMRE LB IS T 3B L X)L 2R Indication
+1.75/+1.5/+1.25/+1.0/+0.75/ E?%c N = A SN
~ RIS EE D184 S .
+0.5/+025/£0/-0.25/-0.5/ S\;lettohm 40 ~ 999(500) AXEEOBZRET S
-0.75/-1.0/-125/-1.5/-1.75 / —— S
-2.0/-2.25/-2.5/-2.75/-3.0 Euétim 70 ~999(500) AXBEOTTZRET 5.
Mode Backlight / Standard / Spotlight BEELALROMEE—RERET 3. eight - — P ——
Backlight: CustomH —479 ~ +479(10) RIFEEOKEMUERZRET S,
Ny 754 RNE— R EHZHEN Position
MEXDEE, BEHEBRTZIE— Custom V —464 ~ +464(*0) RNEEHOEEMNERZRET 3.
K) Position
Sta;mggi:_'s Shooting>White
Spotlight: RIA RSV ZOBREEFTVET,
2Ry 5o R E—R(BDERBEE *=a1-THE MECHEE e
EIZZRY b4 MhYoTWBE Preset 2000K ~ 15000K(3200K) RTA NS Z2DT )y MERRET
T HENEBEHTZIE-N) White %,
Speed —99 ~ +99(2) BEBEHAROHABEIE—RERET 3, Color Temp 2000K ~ 15000K(3200K) AEY — AICREINIEARTA NSO
AGC On / Off AGC(A—R41 > hO—)L) ke <A> EREZRET D,
On/0ff9 3, (2352
AGC Limit  F|/EEBRICDWTEHEHLLIE, TAGCLIMitA AGCHEEDRAYS 1 >ARET S, Color Templd. R/B Gaini{FEFIC2000K+
Za—-OREBEEYEAE (108R-Y) & 15000KTY JwFEN B, R/B GainfEd
TEBLLRETW, FRERColor TempfEx RRTERVIEEHHY
AGC Point  F2.8/F4/F5.6 AGCHEENOND &, AGCEEIFS tH4 9.

HBT7A)ZADFEZRET 3.
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Shooting>White
RO MNSVRDOBREEITVET,

Shooting>White Setting
RIOA NSV ROAREITVET,

AZa-IHH MBEEREE

RE

AZa-1HH MBEEREE

S

Tint<A> —99 ~ +99(+0)

RTA AT — ALRESNIARTA BN
SVRADTINEZRET 3.

[ZFE]

Tintld. R/B GainiR{FBIc+99T/ Vv SEh
3fz%. R/B GainfEDERKLTINtER RN TE
BRWEEHABYET,

ATW Speed 1/2/3/4/5

ATWE-FRORISEEZRET 2.
1: BB RISEEHEL,

White Memory / ATW
Switch<B>

WHT BALZA v F%#BICERELIzEFIDE
RENBKRTA NS OABE—RAE
RT3,

R Gain<A> —99.0 ~ +99.0(+0.0)

AT = AICREITNIRTA RS VZD
RTAVERRET 3,

B Gain <A> —99.0 ~ +99.0(+0.0)

AT = AICRETNIRTA RS VD
BYA U iE%RET B,

ColorTemp 2000K ~ 15000K(3200K)

AE— BILRTFINIKRTA MNSVRD

Filter White On / Off
Memory

NDT ALY —ZEITRTA MNSVIAE
) —BigE B E T B 1AEZ On/Off 93,
On:ND7ANI—ZEICKRITARNTV

AEU-ZRET S,

[*E]

Tty hE—ROLEFCLEAR/1/2/304

<B> BEEARTETD. . NUFTILE-ROEEFCLEAREON
L OABERVET,

(3R] Off : END T ALY —THRTA RSV ZA
Color TemplZ. R/B Gain®{EmIC2000Kd EY—(FHE,
15000KTH 1w FE N3, R/BGainfad
EReAColor TempfEx RRTEHWEAHEHY Shooting>0Offset White
4 RIAMNSYVZDA T Y EDFEETVET,

Tint<B> —99 ~ +99(+0) RIA MAEY— BICRBEINARTA RN AZa-IEH #MBEHREE RE

SUADTINHERRET 5.

[TEE]

Tintld. R/B GainiR{FEFICE99 TV v TEN
%7z, R/B GainfEQERATINtEZRTRTE
BWMEAEHBHYET,

Offset White On / Off
<A>

AEY—ADKRTASNSVRCHA T Y~
&% £33 %(0n) HMEhlL 7EVH(OFf) %
BEiRT 3.

R Gain<B> —99.0 ~ +99.0(+0.0)

A= BILRFINIARTA MNSVRD

Offset Color —99 ~+99(+0)
Temp<A>

Offset White <A>HONDIZEIC. AE
)— ADRTA NSV ICHINT2EE
EAEO4 7ty h%2RETS,

Offset —99 ~4+99(+0)
Tint<A>

Offset White <A>HOnDIFEIC. AE
)— ADKRTA RS VRIS BTintA
BOFA Tty ERETS,

RIA U MERERET S,
B Gain<B> —99.0 ~ +99.0(£0.0) AEY—=BIZRTFEINLKRTA NSV AD
B A U MERRET D,
Shooting>White Setting
RO NSO ROAREITVET,
AZa1-1REH MBEREE nE

Offset White On / Off

<B>

AEY)—BOKRIA NS VRICHATEY S
&% T 3(0n) hFADLEVWM(OFf) &
HEIRT 3,

Shockless off/1/72/3
White

ROA NS VRE—RYIVEZEORT A

MSUZECEERRET 3.

Off : BB ICEIWE D 3.

1~3: HEAATVEFED KWL ED
5,

Offset Color —99 ~+99(+0)
Temp<B>

Offset White <B>HhOn®DIZEIC. AE
1)— BORTA SNSRI NT ZER
EAEOA 7ty ERET S,

Offset —99 ~+499(+0)
Tint<B>

Offset White <B>HOnDIFEIC. AE
1)— BDRTA MN\SURIAAINTBTintA
BOF Tty N ERET S,
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Shooting>0Offset White
RIARNNSOZADATEYRDREETVET,

Shooting>Focus
T4+ —hADFREZITVET,

AZa—-1HH MBEEREE

RE

AZa—1HH MBEEREE

RS

Offset White On / Off

<ATW>

ATWORD A MNSVRICH T Y MEE
4109 %(0n) KAl & W(OFf) % iR
¥5.

Offset Color

—99 ~+99(+0)

Offset White <ATW>HOnDIFE .

AF Assist On / Off

ONnCRETBE. A—hT4—HREEF, —
BHICFEHTIA—HREEhERCEN
TE3,

Shooting>S&Q Motion

Z20—&JAYIE—YavE—ROBREEITVET(52R—),

AZa-1EH MEEREE

S

Temp ATWORT A MRSV ICHNT 2ERE
<ATW> ABROA Ty NERET S,
Offset —99 ~+99(+0) Offset White <ATW>H0OnDIFE .
Tint<ATW> ATWDRTA SNSRI MT 3TintA
BOZA Ty ERET S,

Shooting>Focus

TA—HADFEZTVET,
AZa—-IEH MELHREE NE

Setting On / Off

20-& A4y I7E—3a>E—-KR&0n/
Off93.,

OnDEF, UTOHBENEINICARVET,
* F—rFPAUR

* F—RJ#+—HZX

Frame Rate 1fps ~ 60fps / 100fps / 120fps /

150fps / 180fps / 200fps / 240fps

20—-&TAVIE—YaviReBEOTL —
LL—NERET S,

[TEE]

HREBOEHHEG. BRITNTWVWEIIITFLEARE
PI-Fvy, EFZFT+—TvhcLo>TERY
7.

Shooting>LUT On/Off
LUTOREETTVET,

AZa1-IBH MIBELREE nE

SDI/HDMI MLUT On / MLUT Off SDIE L UHDMIE AR ICMonitor LUT
EEAT2HEIRT 3.

VF/Proxy/  MLUT On / MLUT Off VF. Proxy® & U'Stream®d i ARIEIC

Stream Monitor LUT#ER T2 H&EIRT 3,

Internal Rec  MLUT On / MLUT Off

A SCERIRIK (CMonitor LUTRERT3
M&ERT 3,

Shooting>Noise Suppression
A XY T LADEEEITVET,

[XE]

Setting(Custom)&Level(Custom) D& EfElFEFNFNTarget DisplayDsREICRM T NE I (110R—),

AZa—-1HH MBEEREE

RS

AF 1(Slow) /2/3/4/5/6/7(Fast) F—RT7 2 —HRPDEEGRNB YL DS
Transition BOT4—hZABHORS EZH/ET 3.
Speed
AF Subj. 1(Locked On)/2/3/4/5(Responsive) #—hr7#—hIXRDEEAHDEYFEY) K
Shift Sens. |
Focus Area Wide / Zone / Flexible Spot F—hTH—hR. Fy>az—kTx—2h
Z(AF) ORRETZEIERE T (39
~R—3),
Wide:
MBS T+ —hREEHEZ M
BxET,
Zone:
BELEY-—VRMSEETIA—HR
EEhEIRERT.
Flexible Spot:
RIEDIEELLMUEICTA—HREE
b3,
Focus Area  Flexible Spot Ty a7d—hT4—HhR(AF-S) OFFHRE
(AF-S) TRREERET S,
Face/Eye Face/Eye Only AF / ERREAFO BN/ BN ERET 2.
Detection Face/Eye Priority AF / Off
AF
Push AF AF / Single-shot AF(AF-S) TV aA—RNIA—HhIADE—RERET
Mode %,

Setting On / Off CustomE— RN/ 1 XY 7L X HHE
(Custom) On/0Offg 3,
Level Low / Mid / High CustomE—REO /A XY TFLRDLA

(Custom)

W %ZRET S,
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Shooting>Noise Suppression
A XY TLADHRERITVET,

[AE]

Setting(Custom)&Level(Custom) DR EfEIEZNZFNTarget DisplayD R EICKBETNET(1M10R—-),

AZa—IFH HMBEEREE

RE

Setting On / Off Cine EIE—RBEO/ A XY T LR
(Cine EI) On/Off¥ %,

Level Low / Mid / High Cine EIE—RED /I X TLIADLAIL
(Cine EI) HHRET D,

Shooting>Flicker Reduce
7y h—HEDEREZTVET,

AZa-1EH MBEEREE

RE

Mode Auto / On / Off

T)wH—RIEE—R2RET 3.

Frequency 50Hz / 60Hz

7y H—DRE 722 REBDEIRERE
ZRET B,

Shooting>SteadyShot

FILBEDREETVET,
AZa—-IEH MBLHREE AE
Setting Active / Standard / Off FILHEMERRTET S,
[TEE]

HWISL Y TEEROHRETETET,
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Project AZa1—

EAZ1-THHOWES LUREMERIUTOESY TT,
TimhErR OFHAREMEIF. AXF(H):18dB) TRLET.

Project>Rec Format
KBTI —VYNOREEITVET,

AZa—-1HH MBEEREE RS

Project>Base Setting

A S NET \F/(i)?emc;t Frequencthodec@E&?‘fl:FﬁU‘CE#)Z% BRETA+—VvNERET S,
A—1-FH MELRTE e Frequency Codec IR
Shooting  Custom / Cine EI BT RARETSE, (25~—) 29.94 RAW  —

Mode B RAW & 4096 2160P
Target SDR(BT.709) / HDR(HLG) CustomE— REEDIR/EAD S xR XAVCT 3840x2160P
Display EI 3, XAVC-I 4096X2160P
Project>Rec Format 3840X%2160P

SR ITA—VYNDREETVET, 1920X1080P
AZ 21— MBEFREE AE XAVC-L 3840X2160P
Frequency 59.94/50/29.97/25/24/23.98 2T LEAREEEIRT 3, 1920X1080P 50
Imager Scan FF /S35 BERzHH LA E(EER/ME) & A A— 1920x1080P 35
Mode T —YA ZBEEMEHEDEN SERT 50 RAW  —

3 ] RAW & 4096 2160P
Codec )F((ﬁ://VC/LRAW & XAVC-1 / XAVC-1 / % BET-NARETS. XAVC-l  3820%X2160P
RAW Output Frequency&CodecDREICRLTE LS, AHERAWLI—Y—TiRBITZ7+—T v XAVCIL - 4096x2160P
Format Frequency Codec  ®IRES hERET 2. 3840 2160P
59.94/ RAW 4096X%X2160 [TEE] 1920x1080P
50/ 38402160 CodecHRAW & XAVC-IDEF (2, Video XAVC-L  3840x2160P
;2./97/ RAW &  4096X2160 ;ngr:)a;f;l:{AW Output FormatiZ#EE LTIy 13;8i1822§ gg
23.98 XAVC 3840%2160
29.97 RAW —
24 RAW _ 4096x2160 RAW &  4096X2160P
2’2\"/"5 40962160 XAVCl 3840%2160P
XAVC-| 4096X2160P
3840X2160P
1920X1080P
XAVC-L 3840X2160P
1920X1080P 50

1920%X1080P 35
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Project>Rec Format

Project>Simul Rec

RBEIA—VYRDEREETVET. R ROBREETVET(53R-Y),
AZa1-IBH MIBLHREE AE AZa1—-IBH MIBELSREE NE
Video 25 RAW — Setting On / Off AIRFEBFECIRIERE D ON/OFfE SRR EA
Format RAW &  4096X2160P FA4 TP H—ERET S,
XAVCl 3840%2160P Project>Proxy Rec
XAVC-l  4096X2160P TOFSERE—RORELEITVET,
3840X%2160P AZa—1HE HMBEHKEE AE
1920%1080P Setting On / Off TOFVEHFE—REON/Off T3,
XAVC-L  3840X2160P Audio CH1/CH2 / CH3/CH4 TOFVF—YCRBTBA—FAF v
1920%1080P 50 Channel VX EEIRT S,
1920X1080P 35 Project>Interval Rec
2398 RAW — A2 —=NILLY I DREETVET(53R-),
RAW &  4096x2160P *=a-IRB MBELRES e
XAVC-l  3840%2160P Setting On / Off A9 —=NNILLy T E—R%0On/OffF 3,
(COFEHEONICT B E. fDFFTREEER
XAVC-l 4096 2160P T ROREHOF 5. )
3840x2160P Interval 1/2/3/4/5/6/7/8/9/10/15/ Interval RecDBRENONDIEEIC. 1>
1920X1080P Time 20 /30740 /50 (sec) A — LIRS ORBERIR(1 >49—/VL)
XAVC-L  3840X2160P 1/2/3/4/5/6/7/8/9/10/15/ %RET3,
1920 1080P 50 20 /30 /40 /50 (min)
1/2/3/4/6/12/ 24 (hour)
1920X1080P 35 - N
Number of  1frame / 2frames / 3frames / Interval RecOEREMNONDIFHIC, 1>
24 RAW — Frames 6frames / 9frames / 12frames F—=IVLIRFFEDIB DR T L —L#E
RAW &  4096x2160P BIRENTVWBETH 74—V vhDTL— RETS.
XAVC-| LERBIZL>TREBENERYET,
XAVC-I 4096X2160P 59.94P/50P:
; - ; 2frames / 6frames / 12frames
Project>Cine El Setting 29.97P/25P/24P/23.98P
Cine EIE—FOREZITVET. 1frame / 3frames / 6frames /
AZa-—18H MBELHREE AAE 9frames

Color Gamut S-Gamut3/SLog3/
S-Gamut3.Cine/SLog3

Cine EIE—RIFOBIHARET 3.
S-Gamut3/SLog3:
Cine EIE—RBFO@IFEAS-Gamut3
ICERET .
S-Gamut3.Cine/SLog3:

Cine EIE—REFD&IEAES-Gamut3.

CinelcERET 3,

Pre-Lighting Off / 2sec / 5sec / 10sec

A9 =INILL Y VIR HBRICET S
A EARTSE2IEE AR RTEE
ZhERIRT 3,

[XE]

HVL-LBPC(RIZE) RO HBMERETT.




85 | 6E AZa—KRINEFMFRE : ProjectAZa—

Project>SDI/HDMI Rec Control
SDI/HDMIGEEEHEDEREEITVET,

Project>Assignable Button
FHAFTILRY ARV Y TEREEITVET,

AZa—-1HH MBEEREE

RE

AZa—1HH MBEEREE

RS

Setting Off / SDI/HDMI Remote I/F / Parallel
Rec

SDI/HDMIHAES IC L B9 BRI Scilss D

R/MFLERIEERET S,

Off:

UE—RHIELZW,

SDI/HDMI Remote I/F:
AEICAT 4 P HEIBALTVEVIREE
T. HNEBIEfGTEES DR /FIEHIEA
aJEE, AEDATAPETL—LBET
FIHAL AR,

Parallel Rec:
AEICAT 4 P HBALTVWBIRET.
SEBIE TR 2R DL R /F L HIE AV AT
BE. AEDAT A FETL—LBEETH
93,

[TEE]
HDMIHAES [ L2 EHZITSHEEIF. TILA
Za1—0DTC/MediaXZa1—>HDMI TC Out®
Setting(91R—) ZOnICREL T LTV,

<1> ~ <9>,
Focus Hold
Button

Off / Base ISO/Sensitivity / AGC /
Push AGC / ND Filter Position / Auto
ND Filter / Push Auto ND / Auto

Iris / Push Auto Iris / Auto Shutter /
Auto Exposure Level / Backlight /
Spotlight / Preset White Select /
ATW / ATW Hold / AF Speed/Sens. /
Focus Setting / Focus Area / Focus
Area(AF-S) / Face/Eye Detection AF /
Push AF Mode / Push AF/Push MF /
Focus Hold / Focus Magnifier x3/x6 /
Focus Magnifier x3 / Focus Magnifier
x6 / S&Q Motion / SteadyShot /

Rec / Rec Review / Clip Flag OK /
Clip Flag NG / Clip Flag Keep / Color
Bars / Tally [Front] / DURATION/
TC/U-BIT / Display / Lens Info /
Video Signal Monitor / Marker / VF
Adjust / VF Mode / Gamma Display
Assist / Peaking / Zebra / Volume /
Thumbnail / Touch Operation / Handle
Zoom / NFC / Auto Upload (Proxy) /
Direct Menu / User Menu / Menu

FHAFTILIRY VICHBEREIY Y TS,
Base ISO/Sensitivity :
AA=I I —-—DREEREDOYIVEZ
AGC:
AGCHEEDON/OfftIUE X
Push AGC:
R VEBLTVWSE. AGCHBEAE
T3
ND Filter Position:
NDT7«ILF—DYIVER
Auto ND Filter:
Z—KND 7 1LY —®DOn/OffENEFY]
WEZ
Push Auto ND:
R VEBLTWSE. 27—KND7«
LY —tREEE BT S
Auto Iris:
A ZHEEDON/OffIWE X
Push Auto Iris:
R VEBLTWVWBE., A—rFPAUR
WEEEBMICTS
Auto Shutter:
A= v w5 —EEDON/OffIUEZ
Auto Exposure Level:
Auto Exposure LevelD 41 L7 kA
Za—%HBR/MRTTS
Backlight:
Backlight/Standardt]W &z
Spotlight:
Spotlight/Standardt]v &z
Preset White Select:
RIARNSUZ Ty R E—RED
IDE= V4
ATW:
ATWHEEDON/OfftNWE X
ATW Hold:
ATWHREDENER —BFR—IL R
AF Speed/Sens.:
AFRNS YT aVREDRE EAFEY
BUREDOREDOTIVEZR
Focus Setting:
TH—HAIVTFDREEITD
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Project>Assignable Button
THAFTILRY OADEEEEIY B TEREEITVET,

Project>Assignable Button
FHAFTILRY ARV Y TEREEITVET,

AZa—-IEH MELHREE NE AZa-IEH MELEEE NE
<1> ~ <9>_ Focus Area: <1> ~ <9>_ Clip Flag Keep:

Focus Hold
Button

AF, 7v>a1 AFREO74#—hIXITU7
DEREETTD
Focus Area(AF-S) :
Ty AFAF-S)ED 7 #—HZ T
TOEREEITD
Face/Eye Detection AF:
BR/IERHAFOREETVEZS
Push AF Mode:
Push AFDE—REBEZVIVERS
Push AF/Push MF:
T4 —HIE—RHMFE, Ry %]
LTWBREIFAFICHS
T —HhRE—RHAFE Ry V%
LTWBRIEMFICTE3
Focus Hold:
T —HhRXE—RHAFE. Ry >%H
LTWBE 74 —hRE2EET S
Focus Magnifier x3/x6:
Focus Magnifier x3:
Focus Magnifier x6:
EY MEK#EEBEDON/OffHIWE X
S&Q Motion:
20—&TAYIE—avEEEDON/
OffgIuE x
RIFLTERERBFOIL—-LL—FDE
E
SteadyShot:
Active / Standard / Offflu &z
Rec:
SERORMBEIFEL
Rec Review :
LyZJLEa2—DOn/OffIWEX
Clip Flag OK:
Add OK&ZE{TT 3
2[5 13T g &Delete Clip Flaga=
793
Clip Flag NG:
Add NGEZETTS
2%+ TH I & Delete Clip Flagx=®
793

Focus Hold
Button

Add Keep%ZEfT93
2%+ T g & Delete Clip Flagx =

793

Color Bars:
HS—I\—D0On/OffJUEZ

Tally [Front]:
SCER/9 ) —S>F(Front) D=NT. =
BEERED ON/OffIVE X

DURATION/TC/U-BIT:
Time Code/Users Bit/Durationt]¥
Bz
Display:
BEERROON/OfftIWEZ
Lens Info:
BERRERTROYWVER
Video Signal Monitor:
BGESEZY— (REEZY -1 L)
ORTYIVEZ
Marker :
J—H—HEEDON/OffIWE X
VF Adjust:
Eai—774 5 —BEEDBZ T HEH
L NILN—DFRR
VF Mode:
Ea—77/4 > —BEDHS—/E/
sOfIWER
Gamma Display Assist:
HIVRRT I NEEDOYIVEZ
Peaking:
E—F > HEEDON/OffIWEZ
Zebra:
YT S#EEDON/OffIW EZ
Volume:
Ay RRVIEFE S UREREZE—
H—DEZY-BELRILEZFAETS
Thumbnail :
HLAXAILVEEORB/HRT
Touch Operation:
Yy FEEDOON/OffPIUE R
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Project>Assignable Button

FHAFTILRY A OHEERVE TREEITVET.

Project>Assignable Dial

FHAFTINIAVILAOHEERV LT, BEAROREEITVET.

AZa—18H MBEHREE ABE AZa-—1H MBEHREE nE
<1> ~ <9>, Handle Zoom: Handle Dial Off /1SO/Gain/El / ND Filter / IRIS / INYRILPHAFTILGLVILICHEER SV
Focus Hold INYRILZ—-LEMEDEIVE X Auto Exposure Level / Audio Input LT3,
Button NFC: Level / Multi Function Dial ISO/Gain/El:
NFCH%RED EIT T4 VFIZEIZRAMTS
Auto Upload (Proxy): ND Filter:
Z7OF> 771 )LOBEERZEDON/Off NDZsILY—%FEI TS
X IRIS:
Direct Menu: FAUREFETS
FALYIMAZ 21— DFAA/IRT Auto Exposure Level:
User Menu: BEIBEHLANILEHRETS
UserAZa—DORKR/ET Audio Input Level:
Menu: BELARILEFRHTS

TILAZa—DORBR/MRT

Project>Assignable Dial
THAFTILIALVILADOKREEIY YT, BEARORELTVET.

Multi Function Dial :
WIWFT7oI2a>FA4vILELTE
93

AZa-—18H MBEHREE AE
Grip/ Off / ISO/Gain/El / ND Filter / IRIS / TV T PHAFTILIALVILICKREREY)
Remote Dial Auto Exposure Level / Audio Input LT3,
Level ISO/Gain/El:
T4V EIEIZRAMNTS
ND Filter:
ND7 1LY —% R8T 3
IRIS:

FAIR%RETS
Auto Exposure Level:

Handle Dial Normal / Opposite
Direction

INYRIVPHAFTILILYILOEERAE
ERETS.

Normal : lEAMICEERT %

Opposite : EAMAICEET 2

Project>Multi Function Dial

NIVFT72I2 3L VILAOEEEEIY S TREZTVET,

AZa1-1RH MBEREE

RE

BHEIBHLANILEHRETS
Audio Input Level:
BELANILERANHTS
Grip Dial Normal / Opposite GV TTPHALFTILICLVILDOEEAE
Direction ERET S,

Normal : |EA M ICEI#RT S
Opposite : WA RAICEERT 2

Default Off / IRIS / ISO/Gain/El / Auto
Function Exposure Level / Audio Input Level

TIWFT72023>FA4VILDOFTI4ILE

HaeEElWL TS,

IRIS :
A RERET B

ISO/Gain/El:
A VFISEIZRAMTS

Auto Exposure Level:
BFMEHLANILERMTS

Audio Input Level:
BRELANILERHTS
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Project>User File
YT 7L OBRFICEATIRELZITVET,

AZa—-1HH MBEEREE

RE

Load Execute / Cancel A—HY—T7AILDREECFexpress
Media(B) Type A/SDAH—RZOv h(B) ICEALK
AEY—H—Rh5HEHFAD,
Execute : 17
Save Execute / Cancel AT 7LD E % CFexpress
Media(B) Type A/SDAH—RZOv h(B) ICHALLK
AEY)—H—RIREFET S,
Execute : 17
File ID dA—HY—TJ7A)LDFile IDRIRETREETT
SHEHE%ZXRTNT B,
Load On / Off Load Media(B)DE{THFICUserA=a1—
Customize DBRHRYI VA X EREFHFALMED
Data MA&ERET 3.
Load White On / Off Load Media(B)DZETHRFICKRT A RS>
Data AEREFHACHESIHERET 3.

Project>All File
Al 7AILICBT 2R EZITVET,

AZa1—1RH MBEREE

RE

Load Execute / Cancel All7 7L EEGRIFHALD,

Media(B) Execute : 1T

Save Execute / Cancel A7 7ML RET S,

Media(B) Execute : 1T

File ID TP AILICRTZE T3,

Load On / Off Load Media(B)DZE{TEFIC. Network*
Network Za—-DREBFEREFRFHACNE >IN ZER
Data ETI 3.
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Paint/Look A= 1—

EAZ1-THHOWES LUREMERIUTOESY TT,

TimhErR OFHAREMEIF. AXF(H):18dB) TRLET.

Paint/Look>Reset Paint Settings
HAIL YIS DPaint/LookAZa1— DR EEEIEYRLET,

Paint/Look>Scene File
Scene7 7AILICBET BB ELZITVWET,

AZa-IHH MBEEREE

AE

AZa-—1H MBEHREE AE
Reset Execute / Cancel BRIy 7SN DPaint/Look A= 1—DE%

without Base
Look

EEDOUEY EETT S,
Execute : 17

Recall HWEAE —[CRETNTVBSceneT7 74 : -
WEBHAD. BEOBIEECERTS. | s e e s
Store REOBEEREKRERSceneT71ILEL = = =
THEAEY —CRET S, A ML i
Delete REAEU—[CREINTVBSceneT7 71 Master —99.0 ~ +99.0(+0.0) Y2 —TSvILRNILERET 3.
ILEHIBRT 3. Black
Preset Recall Shooting ModehiCustom@T, Target Tty NEE(EFRIRE) ZREOH R Black —99.0 ~ +99.0(+0.0) RISYILARILERET S,
Displayh'SDR(BT.709)De® HRECERT S, B Black —99.0 ~ +99.0(£0.0) BISwILARILERET .
S-Cinetone / Standard / Still / —
ITU709 Paint/Look>Knee
Shooting ModehiCustomT. Target Z—WEDREETVET,
DisplayA"HDR(HLG)D & & AZa—-1BH MBEREE ES
HLG Live /7 HLG Natural Setting Target DisplaymMSDR(BT.709)m & & Z—fHIEMREZON/Off T 3,

Paint/Look>Base Look
BEARNYIICEATEIREETVET,

on / Off / ---
Target DisplayhHDR(HLG)D & &
on / Off / ---

Auto Knee  Target DisplayhSDR(BT.709)m & * Z—hZ—1#8E%Z20n/0ff 93,
On/ Off / ---
Target DisplayMHDR(HLG)D & *
Oon / Off / ---
Point 75% ~ 109%(90%) Z—RAVNERET B,
Slope —99 ~+99(+0) ——2O0-7%%®ET 3.

AZa—-IEH MELHEEE AE
Select Shooting ModehiCustomT. Target BRIy %FEIRTS,
DisplaymMSDR(BT.709)m & &
S-Cinetone / Standard / Still /
ITU709 / User1 ~ User16
Shooting ModehiCustomT. Target
DisplayMHDR(HLG)D & F
HLG Live / HLG Natural /
User1 ~ User16
Shooting ModehiCine EIQ & F
s709 /709(800) / S-Log3 /
User1 ~ User16
Delete FIRUIEERILY I 5 HIBR T 3.
Delete All ITRTOEXRILY I %EIRT 3.
Import ERATATHSERILY I TP EGH
AL,
Input S-Gamut3/SLog3 / Select TEIRLTWVWBEKILYIDAA
S-Gamut3.Cine/SLog3 GamutzHRET .
Output BT.709 / HLG Select GEIRL TV B ERILYIDHAE
HERET S,
AE Level OEV /1/3EV /2/3EV /1EV / 4/3EV / Select C:EIRLTVWBERILY I DEHE
Offset 5/3EV / 2EV EEERET D,
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Paint/Look>Detail
T4 T—ILARDREETVET,

Paint/Look>Multi Matrix
VILFIRU I ZHEDREETVET,

AZa-—18H MBEHREE AE AZa-—1H MBEHREE nE
Setting On / Off T4 T—ILiEBERON/Off T3, Setting On / Off Multi MatrixfiE#8E% On/Off 33,
Level —7 ~+7(%0) FATF=ILLRILERET S, Reset Execute / Cancel KEoEOEHE(E1—) LEAMEYFa
Manual on / Off / --- F 15— L FEHBEMEERON/OF T 3, L—>3%) ZINTHIHECT 2.
Setting AXis B/B+/MG—/MG/MG+/R/R+/ Axis%&EIRT 3,
V/H Balance —2 ~+2(+0) F4F— L EBFEEECEE(V) /KTFE(H) YL=/YL/YL+/G=/G/ G+ /CY/
FAFLONFVRERETS. CY+/B—
B/W Typel/ Type2 / Type3 / Typed / Type5 5«5 — L FBBERCTA(B) /LA(w)  Hue —99~+99(20) Multi Matrix@iEOX R LGS EOEH
Balance FAFLONTYRERET S, (Ea-) ZRET 2.
Limit 0~7 FAF— L EBFEECFAF—ILDOYSy Saturation —99 ~+99(+0) Multi MatrixfIEDQXI R &3 2EOEMNE
RLALERET S, (BFaL—>a>v) #BET3.
Crispening 0 ~7 FAT—ILFBRABECIITZVIL
NILVEBRET 3.
High Light 0~4 FATF-ILFEAREECRBERSOT ¢
Detail F=ILLRNILEERET B,

Paint/Look>Matrix
IR ZHEDREEITVET,

AZa—-IEH MBLHREE NE

User Matrix On / Off A—H—T MY X EHEERONn/Off g
%,

User Matrix —99 ~+99(+0) MESBOBORT(VFaL—>av) &

Level HET S,

User Matrix —99 ~+99(+0) MGEeEoeEaWNT7I—X) #FH¥T 3,

Phase

User Matrix —99 ~+99(+0) R-GHA—H—-TRJIREFERICRET

R-G %,

User Matrix —99 ~+99(+0) R-BOI—H—-TKNJIZREEFECHKRET

R-B 3.

User Matrix —99 ~+99(+0) G-ROA—H—-T M) I 2EFEBICRET

G-R 5.

User Matrix —99 ~+99(%0) G-BOA-—H -V RUIZEFERICHRET

G-B %,

User Matrix —99 ~+99(+0) B-ROA—Y—ZR)IZAFEICKRET

B-R %,

User Matrix —99 ~+99(+0) B-GOA—HY -V KNI ZEERICKRET

B-G %,
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68 AZa—FRREFHMRTE

TC/MediaAZ=Z1—

EAZ1-THHOWES LUREMERIUTOESY TT,

TimhErR OFHAREMEIF. AXF(H):18dB) TRLET.

TC/Media>HDMI TC Out

HDMIFI DY A LD — R AT 2REZTVET,

TC/Media>Timecode
HSALT—RDBREEITVWET,

AZa-1HH MBEEREE

S

AZa-IHH MBEEREE

AE

Setting On /7 Off

HDMIZFIAL T, tOEBAKSRCI A
LO—REHATEIDNESHZRET S,

Mode Preset / Regen / Clock

GALI—ROSEE-RERET 3.
Preset(Z’Utwhk) :
BREINEHNSHHET S,
Regen(UTzX) :
ROy TDYALD—RICEKITTSES
T3,
Clock(#Ow%) :
NERStEY A LO—RELTHERT
5.

TC/Media>Clip Name Format
Iy TOLMPHIBRICETZREEITVET,

AZa-1HH MBLREE

S

Run Rec Run / Free Run

Rec Run: iCEREDH ST 3,
Free Run : SeRICEFRLELEICHHET S,

Setting

YALI—RZERDEICRET S,
SET:RE

Reset Execute / Cancel

44 L31—K#%00:00:00:001CUtw kT
N
Execute : 17

TCFormat  DF/ NDF

HAALI—RDT#—T v NERET B,
DF: ROvZ7L—LA
NDF: />ROvZIL—A4

TC/Media>TC Display
GALT —IRTDHFELITVET,

AZa-IHE MBLREE

mE

Display
Select

Timecode / Users Bit / Duration

GALT—IDRTZTNIEZS,

TC/Media>Users Bit
1Y -EvhcEIZREEITVET,

AZa-1HH MEEREE

RE

Mode Fix / Time

A—HY—-EvrDE—REZRET 3.

Fix: a—H—EyMNEBEOEEE:ER
g3,

Time: 1—Y—EvNCREORK M & F
Bd3,

Setting

A—Y-EyvrEERDEICRETS.

Title Prefix  nnn_(nnnlg> U 7ILES DO T3H7)

(BRKRTXFERR)

)y TADI A MLED (4 ~ A6XF) &
RET 3.
XFIOAHEEZFULT.

XFHDOANEEDIERK

XFEIRT7(317) :
Title Prefix TU 7 DA —VILNIECHF
ATBIXFEFEIRT S,
1#$%()+.-.;=@[ ]*_~0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVW
XYZ

H—=VILRET) 7(147) :
Space: H—VILIEILAR—-IZHEA
EE-R
— H=VILEEICRETS,
— h—=VILEGILEET S,
BS: h—VILAIEDEDXFZHIFRT
%,

Title PrefixTU7(117) :
FANLEANTZIVT,

A RNLERETBICIE

1. QILFELIY— (IR=-) &fF>
T. XFEIRT) 7 H5Title PrefixT
TP DH—YVILIEIC ANBXF %8R
(1S54 bERTR) L. YILFELIY—
DRTERY VEHT, (BRLEXEN
AW, B=VILHEICBEITS.,)

2. FIE1EZEYERL. Y1 NLERET S,
(BRERRLT, BSEERT3,)

3. 914 NILADRENED /5, Done
EFEIRLTCXEINOAHEEEFHL 3.
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68 AZa—FRRNEFHMERE  TC/MediaXZa—

TC/Media>Clip Name Format
Iy T OLMPHIBRICETZEREEITVET,

AZa-IEH MBEEREE

RE

Number Set 0001 ~ 9999

)y TROBREDESED (4HT) ZRE
EE:H

TC/Media>Update Media
AE—H—RNAOEBI7IIILEEHFLET,

AZa—-IEH HMEELHERE NE
Media(A) Execute / Cancel 20vMADAEY—H—RROEET 741
IWEEFHTS,

Execute : 17

Media(B) Execute / Cancel

Z20Y RBOAEU—H—RROEET 74
ILEBHT S,
Execute : T

TC/Media>Format Media
AE—H—RZHHALLET,

AZa-IHH MEEREE

RE

Media(A) Full Format / Quick Format / Cancel

20v RADAE) —H—REHHRLT S,

Media(B) Full Format / Quick Format / Cancel

Z20v rBOAEU—H—REHH{T 3,
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68 AZa—FRREFHMRTE

MonitoringX—a1—

EAZ1-THHOWES LUREMERIUTOESY TT,

TimhErR OFHAREMEIF. AXF(H):18dB) TRLET.

Monitoring>Display On/Off
BEXRNEEOREEZITVET,

Monitoring>Output On/Off

BRRHADREZITVET,
AZa-—HE MBLREE RE
SDI On / Off SDIEA1%On/Off ¥ 3,
HDMI On / Off HDMIE 1% On/0Off 3 3,

Monitoring>Output Format
HATA—IYROREETVET,

AZa-IEH MBEHREE nE

SDI BEBEEICDOVWTEHLLIE, THADT7#+—  SDIEHDMIEADBEEREEZT 3.

HDMI Iy hEFIRRT (1MeR—) 2B

(AN
Monitoring>Output Display
HAESDEREEITVET,

AZa—-IEH MBEHREE nE

SDI On / Off SDIEAEBSADAZ1—DPRXTF—YRE
BOREEZRTT 3.

HDMI On / Off HDMIEHEBADAZ1—PRFT -9 2
BEEOREERTT S,

AZa—-1RE HMBEEREE nE
Network On / Off Ea—-J7(4 9 —BEHICKRRTSEE%
Status BIRT 3,
File Transfer On / Off
Status

Rec/Play On / Off
Status

RAW Output On / Off
Control

Status

Tally On / Off
Battery On / Off
Remain

Focus Mode On / Off
Focus On / Off
Position

Focus Area  On/ Off
Indicator

Focus Area  On/ Off
Ind.(AF-S)

Face/Eye On / Off
Detection

Frame

Lens Info On / Off
Imager Scan On / Off
Mode

Rec Format On/ Off
Frame Rate On/ Off
Zoom On / Off
Position

UWP RF On / Off
Level

SteadyShot On / Off
Base Look/ On/ Off
LUT

SDI/HDMI  On / Off

Rec Control
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Monitoring>Display On/Off
BEERXNEEOREZITVET,

Monitoring>Marker
N—H—RROBREZITVET,

AZa-IEH MBEHREE NE AZa-IEH MBELHREE NE

Gamma On / Off Setting On / Off TRTOV—H—KRNZFEHTON/OFf Y

Display %,

Assist Color White / Yellow / Cyan / Green / J—h—DESEEEIRTS,

Proxy Status On / Off Magenta / Red / Blue

Base ISO/ On / Off Center 1/2/374/0ff oy —T—h—%EIRT 3.

Sensitivity Marker

Media On / Off Safety Zone On / Off t—T774—Y—-rY—H—%0n/0ff T3,

Status Safety Area 80% / 90% / 92.5% / 95% T—T7F4—V—UT—h—DOkFT(EE

Video Signal Off / Waveform / Vector / Histogram BRICH T BHER) 5#IRT S,

Monitor Aspect Line / Mask / Off FARYT NI—H—DrEEIRT 3,

Clip Name  On/ Off Marker

White On / Off Aspect 0 ~15(12) V—A—MIDEFTHESOL NI ZRE

Balance Mask EE:R

Scene File  On/ Off Aspect On / Off FARGMNE=T T4V —-VI—H—%

Focus On / Off Safety Zone On/0ff9 3.

Indicator o Aspect 80% / 90% / 92.5% / 95% FARGNE—TF4 =V =27 —H—DK

Auto On / Off Safety Area FT(EEERCHTILE) 2 HIRT 3.

Exposure o Aspect 11/4:3/13:9/14:9/15:9/16:9/ FARGKNI—=H—2RRTBEFOE—R

Mode Select 17:9/1.66:1/1.85:1/2.35:1/ 2.39:1/ ERET S,

Auto On / Off Custom

Exposure Custom FEOERA$HT3(01.00:01.00) FART N EEROEICERET 2.

Level Aspect (555

Timecode On / Off Ratio Aspect SelectTCustom%;&RLIBAIC. &

ND Filter On / Off DERENEHMICAYET,

Iris On / Off Guide On /7 Off HARTL—LEKT%ZOn/OffF 3,

ISO/Gain/El On / Off Frame

Shutter On / Off 100% On / Off 100%~<v—#1—%0n/0ffg 3,

Level Gauge a/ Off Marker —— —

Audio Level _On/ OFf User Box On / Off A—Y—Ry I AI—H—D&KR%Z0On/Off

Meter _ User Bo 3 ~ 479(240) i%:f Ry I 27—h—OtE(FRLMSE
. X ~ — U=y —7]— =1 ]

:,’\;jf:irf;"e' On/0ff Width o il E T ARET 3.

Clip Number On 7 Off User Box 3 ~269(135) J—E—Trf‘yd%7—7;3—®%‘é'(¢lt\b\5

: — Height IRimETORER) 2RET S,
Rlnc:sf:ge On /Off UserBoxH  —476 ~ +476(0) 21— =Ry J 27— H— O OKFAL
Position BERET S,




6&F AZa—KRRNEFMERE  MonitoringAZa—

Monitoring>Marker
N—H—RTOREEITVET,

AZa-IEH MBEEREE

RE

UserBoxV  —266 ~ +266(0)
Position

A—HF—Ry I 27— H— OO EBL
BARET .

Monitoring>VF Setting
Ea—T7/4 25 —DREETVET.

AZa1-1RH MBEREE

RE

Brightness 1~ 15(8)

E1—T74 V9 —RIGOAZ T ERFET
3.

Color Mode Color / B&W

E-ERR/EBROEI—T 7109 —-DF
TE—RERERT S,

Monitoring>Gamma Display Assist
HIIRRTIANDREEITVET,

AZa-IHH MBEEREE

RE

Setting On / Off

CustomE— K TTarget Displayh
HDR(HLG)E D H > TRRT7 2 Mikes
On/0Off¥ 3,

Monitoring>Peaking
E—F2JDREETVET

AZa-1EH MBEEREE

RE

Setting On / Off E—F>J#EERON/Off T3,

Peaking High / Mid / Low Ho—E—F2IDESLARILERET S,
Level

Color B&W / Red / Yellow / Blue HS—E—F2IDEFEEREIRT S,

Monitoring>Zebra
IS/ DFREETVET,

AZa-1HH MBEEREE

RE

Setting Off / Zebral / Zebra2

TISRROBHE(OM, €731, €752)
=BIRT 3,

Zebral Level 0% ~ 109%(70%)

CTISNERTTELANILERET S,

Zebral 2% ~20%(10%) CTIS1DOTFNR—F v —LRILERET 3.
Aperture

Level

Zebra2 0% ~ 109%(100%) TIS2BRRTBLANILERET S,

Level
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68 AZa—RREFEMETE
AudioA_—a1—

BEAZ1-TEHOBES LS UREMERIUATOESY T,
TiHHARE QMR EMEIE. XXF() :18dB) TRLE T,
r70wo484v 45 S5h1 (13MR=) #HETITELRE TV,

Audio>Audio Input

Audio>Audio Input

BEANDEREETVET,
AZa—-IEH MELHREE AE
CH1 Input INPUT1 / Internal MIC / Shoe CH1 SEECHICN T2 ANTEYIVER S,
Select
CH2Input  INPUT1/INPUT2/ Internal MIC / Shoe ESE8CH2ICHTBANTEYIVEZ 3.
Select CH2
CH3 Input  Off / INPUT1 / Internal MIC / Shoe CH1 E#CH3ICHTB3ANhTEYIVEZ 3,
Select
CH4 Input Off / INPUT1/ INPUT2 / Internal MIC / SEEE8CHAICHITZAANTEYIVEZ S,
Select Shoe CH2
INPUTTMIC —80dB/ —70dB/ —60dB/ —50dB/ INPUTIHOSDXLRIYAIAAICT TS
Reference  —40dB/ —30dB TPLYZLRNILERET 3.
INPUT2 MIC —80dB/ —70dB/ —60dB/ —50dB/ INPUT2HSDXLRYAIAAICKTSB)
Reference  —40dB/ —30dB T7LYALRILERET 3.
Line Input +4dB / 0dB / —3dB / EBUL INPUT1/INPUT2 21y F DEREMLINED
Reference FEDEEANLANILEEIRT S,
Reference  —20dB /—18dB / —16dB / —12dB / HEAALARILDOTKHZIEEEDZELANIL
Level EBUL wERT S,
CH1 Wind On / Off SEEECHICH T 2REEB T 1ILY — %]
Filter b
CH2 Wind On / Off FCERCH2ICX T BRAFER 7Y —%5%
Filter b
CH3 Wind On / Off SCERCH3 I T2 RAFER 7 1ILY —%5%
Filter ET 3,
CH4 Wind  On/ Off SRCHAICKH T ZREEER T 1ILY —% 5
Filter b
CH3 Level  Auto / Manual EBRCHIDBEFAALRILABRZEEICT
Control 2h. FEICTZIN%ERET 3.

[ZEE]

CH3 Input Select. CH4 Input SelecthiEE5
Hinternal MICIZERE TN TV RIHEF. ANGF
EIEEHLTCHADBE - FEbIUBDYET,

BEEANDOEREEITVWET,

AZa-—1H MBEHREE AE

CH4 Level Auto / Manual SLERCHADBEANLANILGAREABHEICT

Control 2h. FEICTZHN%ERET 3.
[TFE]
CH3 Input Select, CH4 Input SelecthEs5
Hinternal MICIZEREINTWVWSHE X, CH3
Level Control DR EICEEFLTCHADBEE) - F
BFEUUEDYET,

CH3 Input 0~ 99(@) SCERCHIDAALARNILEZRET S,

Level

CH4 Input 0~ 99(@) SRCHADA AL RNILERET B,

Level

Audio Input 0~ 99 EEAALRNILERETS.

Level CH1 Level ~ CH4 Level DR EICREST.
J2Y—Ra—LELTHERTEEY,

Limiter Off / —6dB/ —9dB/ —12dB / —15dB / F—F A ZAALRNILOFHAGHHOLE

Mode —17dB BESICHTEZIIvY 4545 EIRT S,

CH1&2 AGC Mono / Stereo SCERCHIEEERCH2OEF L ANIILARE—

Mode R&ERETS, StereolcFEINTVNBE
T, CHEITAGCHEENT B,

CH3&4 AGC Mono / Stereo SLERCHIEERRCHADOBFLANILAEE—

Mode R&EERET S, StereolcfREINTWVWBE
F(F. CHRETAGCHEHHT B,

AGCSpec ~ —6dB/ —9dB/ —12dB / —15dB / AGCH 1% BIRT 3.,

—17dB

1kHz Tone ~ On / Off H5—N—FRTHD1 kKHZOEEEEES

on Color %#0n/0ff93,

Bars

[TEE]

OnlcE&EI S &. CH3 Input Select. CH4
Input SelecthOFfDIZETE. 1kHzOEHES
FES%CRCH3, BBCHAICELET,
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Audio>Audio Input
BERANDEREEITVET,

Audio>Audio Output
BEHADORELZTVET,

AZa-IEH MBEEREE

RE

AZa-1HH MBEEREE

S

CH1 Level XLR7Y 79 —-AAH%L
Audio Input Level / Side /
Level+Side
XLR74 745 —AH&HY(50R—)
Audio Input Level / Through

SERCHIOBBRAALANILAROESFED
TERET S,

[T5EE]

Sideld A M EDAUDIO LEVEL(CHT) 51+
ILEIELET, Level+SideZRELIEETIE
Audio Input LevelEZREDEIG LI VILERED
ZEEHFEDEIEEIBRELARILICKEYET
(131R—2),

Headphone Mono / Stereo
Out

Ay Rk ViEF%E/SIL(Mono) HAIC
F3h. AFLA(Stereo) BAlcTZh%E
EIRT 3,

Alarm Level 0 ~7(4)

EETDEEZRETS.

HDMI CH1/CH2 / CH3/CH4
Output CH

HDMIICH AT NBZEEF v XILO#EH
AbEERET S,

CH2 Level XLR74 F9—AAH%L
Audio Input Level / Side /
Level+Side
XLR7Y 745 —AH&HY(50R—)
Audio Input Level / Through

SEERCH2OBEAALANILVAZROHESED
BEERET S,

[ZFE]

Side (3 A##BIEmDAUDIO LEVEL(CH2) 41+
ILEIELET, Level+Side#RELIEFIE
Audio Input LevelsREDEIGEF A VILERED
EEEHTEDLERFEHBRELANILCHEYET
(131R—2),

CH3 Level XLR74 F9—A A% L
Audio Input Level / CH3 Input
Level / Level+CH3 Input Level
XLR7Y 75 —AHHY(50R—)
Audio Input Level / Through

SKERCHIDEFEAALANILHEOHESE
DEERET S,

CH4 Level  XLR74 79 —AH%L
Audio Input Level / CH4 Input
Level / Level+CH4 Input Level
XLR74 F5—AHHY(50R—-)
Audio Input Level / Through

SEERCHADEBRA AL ANILFHBEOBHE
bEERET S,

Audio>Audio Output
BERHADOREEITVET,

AZa-IHH MBEEREE

AE

Monitor CH CH1/CH2 / CH3/CH4 / MIXALL / CH1/
CH2/CH3/ CH4

AY RRVIHEFE LSUANBAE—D—ICH
NIBBEF v XILEERT B,

[TE=E]
BEFvORILOEEZRAKENT2REEZ
BRUISES R, FENLBVESICRF YR
LOEALNILETFTEENEAINE T,

Volume 0~50

Ay RKRVIEFELIURBAE—H—DE
ZH—BRILNIILEFAETS,
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68 AZa—-FRNEFHFMERTE

ThumbnallAZ 31—

BEAZI-THEOWES S UREBRIUATOLESYTY.
TR QYR EMEE. AXF(f:18dB) TRLET,

Thumbnail>Transfer Clip
gy T RERLET,

[ZERE]
Network X = a—®Access Authentication®Password ks EDZE. Transfer Clipl$EETETE A,
Za1-1aH MBEEETEE AE
All Clips Iy ThE—EERXT 3,
[TEE]

X TE37 Uy TOLERIZ2004 T,

Thumbnail>Transfer Clip (Proxy)
IO+ 7y T RERELET,

Thumbnail
AZa-IEH MBEHREE nE
Display Clip Iy FEMEREmEERL,
Properties
Thumbnail>Set Clip Flag

IV T ISTDREETVET,
AZa-IEH MBEHREE NE
Add OK OKZ7 57 &AF1+3.,
Add NG NGT SV %&fF1+3,
Add KEEP Keep7 345 % {1133,
Delete Clip ITRTDT ST %HT,
Flag
Thumbnail>Lock/Unlock Clip

Iy TORERERTVET,
AZa-IEH MBEHREE NE

Select Clip

RE/REREIFTZI Uy THEBIRLTE
193,

(T3]
Network A= a—®Access Authentication®PasswordhREEDIZFE. Transfer Clip (Proxy)lFsRETE £
‘A,
AZa-—1H MBEEHREME AE
Select Clip FROIVyFICHISLTWE IO+
VT REET S,
All Clips Iy FICRIS TR 7OF 7 )y TE—

BEXT 3,

==y
EXTE37)yTOLERIZ2004TT,

Lock All TRTDI )Y T#RET B,
Clips

Unlock All ITRTDY )y TR RERERT B,
Clips

Thumbnail>Filter Clips
RNTBIVYTOREETVET,

AZa1-1HH MBEREE

S

Thumbnail>Delete Clip
Iy THHEIBRLET,

AZa-IHH MBEEREE

Pz

Select Clip

EROV )y TEHIRT S,

All Clips

9y T=—1EHIFRT 3,

Thumbnail>Transfer Clip
Iy THERERLET,

[TEE]

Networkx=1—®MAccess Authentication®Password ks EDH A, Transfer CliplFRETTFE A,

OK OKZSH DD\ )y TDHERRT S,

NG NGTZ ST DD\ )wTDHERRT B,

KEEP Keep7 557 DDW)wTDHERRT
%,

None TSTDDODVTVWIEWI Uy TDH%ERR
EE-D

All IS5 DHBYIELICLET. TRTDI Uy

TERRT S,

AZa—1RE MBEHREE

RE

Thumbnail>Customize View
HLAXAEEORTEYIVEZ XY,

Select Clip

FEEDIVY TH=EET B,

AZa-1EH MBEEREE

S

Thumbnail Date Time / Time Code / Duration /
Caption Sequential Number

YLXABEETORTABRZTVER
3,
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TechnicalAZa1—

EAZ 1 -THHOWES SUREBRIUTOESYTY,
TimhErR OFHAREMEIF. AXF(H):18dB) TRLET.

Technical>Zoom
Z—LDBREEITVET,

Technical>Color Bars
HS—N—DREETVET,

AZa-1HH MBEEREE

S

AZa—-IFH MBEHREE NE
Setting On / Off HZ—/\—=%0n/Offg 3.

Type ARIB /100% / 75% / SMPTE HT—N\—OEEREIRT 3.

Technical>ND Dial
ND VARIABLES A V)L DRIEICBET 2R ELAITVWET,

Optical Zoom Only / On(Clear Image
Zoom)

Zoom Type

ZA—-LDOBHEERET 3.

Optical Zoom Only:
LYX%&EIMT T EIcLY. PN
ZA—=L%ETD

On(Clear Image Zoom):
EEHEADEV, BEFHNLEI-L%
15

AZa-1HH MBEEREE RE

CLEAR with  On / Off ND VARIABLEY 1 V)L DIEFETNDDIK
Dial HEET(CLEARSON) ZTHTHEICT M ES
MRET 3.

Technical>Handle Zoom
INYRILZ—LOBREEITVWET,

AZa1-1HH MBELREE

RE

Technical>Tally
/IS TOREEITVET,

AZa1—IFH MBERTEE AE
Front On / Off sCiR/49')—5>F(Front) 20n/0ff3 3,

Rear On / Off sC8R/49')—S5>F(Rear) #0n/0ff 33,

Technical>HOLD Switch Setting
R=ILRZA Y FOREEITVET,

Setting Off / Low / High / Variable INYRILZA—LRAE—REFRET S,

High 1~ 8(8) Y RILZ—LZE—RHighZIRE, /\>
RILZ=LLN—HBLIEEFTDI—LR
E—R&EHRET 3,

Low 1~8(3) INYRILZ—=LRE—RLow#EiREE, /\VR

WZ—LLN=% LI EETFDI—-LRE—
RZ2RET 3.

[TE=E]

ZA—LZE—RMERDEFICA-I 2T ICT5
Nz ehBHYET,

Technical>Menu Settings
AZa— (BT RREETVET.

AZa—-THH MBELEEE NE

with Rec On / Off $REISTART/STOPRY > & R—ILRDXFR
Button T ZMIERRICTZINERET S,

with Hand  On / Off Iy FVEIVIC LB BEFEAR—ILROXS
Grip Remote RICTIDIERRICTEINERET S,

AZa—1EH MEEREE

S

Technical>Touch Operation
Sy FREICETEIREZITVET,

AZa-15H MBELHEE NE
Setting On / Off 4y FBEEZON/OFfT 3,

Technical>Rec Review
Ly LEa1—DREEITVET.,

AZa—-IFH HMB&EEREE RE

Setting 3sec / 10sec / Clip Ly LE1—CERICERLEZIVY %

BET2RREZ#EIRT S,

User Menu  On / Off AZa—%RRLIEEETIC, UserAZa—

Only EI3ERRTZNO0N), AZa—UZXr%E
KRRTBW(Off) ZRET 3.

User Menu On/ Off AZa—FRRICOVIEMIFTT, Usert

with Lock Za—FEIFORRICTEINESHERET

%,

[TEE]
BEOAZ1-RTEFTRRERINERA. A
Za1—-RTOBEAER, 13R-IEZTEL
ZEW,




6% AZa—FRRNEFMETE : TechnicalAZa—

Technical>Fan Control
T7UHIHE-ROREETVET,

Technical>Video Light Set

EFZF 54 hORITARERELET, HVL-LBPC(RITE) ERROHEMERETT.

AZa-IEH MBEHREE NE AZa-IEH MBLHREE NE
Setting Auto / Minimum / Off in Rec AEOT 7 UHIHE—RZRET 2. Video Light Power Link / Rec Link / Rec Link + Stby WILFA >4 —T 11— a—ICEYFIF3
i Set ETZ 514 NORITARERET S,

Offin Rec&BIRLTWVWTEH. AEORERRE
N—EREZBZ3L77HEELET.,

Technical>Lens
LYX IR 38R EEATVET,

Power Link:
AEOEROAN/YEHLTCESTAS
A ORI/ TS5,

Rec Link:
A ORERB/ R T IEFHLTET
54 MRUAT/HETT 3,

Rec Link + Stby :
AHORBERB/IRTIEELTET
54 MRRIT/ 2 VA RIT T 3.

Technical>APR

APRZZEITLET.
AZa-TH MBEELHREME S
APR Execute / Cancel APR(Auto Pixel Restoration : 1 A—<

oY —-DOBEEAE) XTI 3.
Execute : 17
[TEE]

ETMCHT LT vy TEEBLTLETL,

AZa-IHH MELREE NE
ZoomRing  Left(W)/Right(T) / Right(W)/Left(T) ZA=LI VI DBRIFARZRET D
Direction N
[L;IE\J
A=K7 OBREABYIVEZICHISLIZET
DN ERRBOHRETETET,
Shading Auto / Off BERELIXEMIEZON/Off T3,
Compensation
Chroma Auto / Off BEMERENEMEZON/OffT 3,
Aberration
Comp.
Distortion  Auto / Off BHEFEHINEMEEZON/OffT 3,
Comp.
Distance Meter / Feet LYZXBRETA—HZRI P a>DRR
Display HMUAEET S,
Zoom Focal Length / Number / Bar A—LIBOXRTHEREHRET 3.
Position
Display

Technical>Camera Battery Alarm
NyF)—DEEBETEEDREZTVET,

AZa-1EH MEEREE

S

Low Battery 5% /10% /15% / .../ 45% / 50%

Ny T )-—BRERTEESERTIS%ESE
RETB(5%ZIH).

Battery 3% ~ 7%
Empty

Ny FT)—INELEEZRTTBZELRTE
5,

Technical>Camera DC IN Alarm
ANBEELSOREETVET,

AZa-1EH MBEEREE

S

DCINANDANEEDETESERTTS
BEZRET S,

DC Low 16.0V ~ 19.0V(16.5V)
Voltagel
DC Low 15.5V ~ 18.5V

Voltage2

DCINADANBEDRRE LR ZRT 3
BEARTTS.
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Network XA — 11—

EAZ1-THHOWES LUREMERIUTOESY TT,

TimhErR OFHAREMEIF. AXF(H):18dB) TRLET.

Network>ST Mode Settings

RAT—Y3VE-—RTCOERICETEIRELEITVET,

Network>Access Authentication
RELICRATAREERTVET,

AZa-1HH MBEEREE

S

AZa-IHH MBEEREE

AE

User Name

FIERRADIHDA-F—-2ERET
3.

Password

FPUOCRBADHD/INAT—RERET
3.

Network>Wireless LAN
JAVLALANER CEATZREXTVET,

AZa-THH MEEREE

mE

Setting Access Point Mode / Station Mode / JA v LZLANEGOEEFE— R%&®%IRT
Off 5.
WPS Execute / Cancel WPS(Wi-Fi Protected Setup) I &3
HiE xR 3.
Execute : 17
NFC Execute / Cancel NFC(Near Field Communication) I &
BEGREAHRKT S,
Execute : 17
MAC AKEOTAVLALANA VI —T1—XD
Address MACP7 RLZA&RRT 3.

Network>AP Mode Settings

FPIEARA YN E-—RTCOESICEATIREETVET,

AZa-IHH MEEREE

S

Camera Enable / Disable AT—=2aVE—RTAEETIVLR

Remote LANEEHR I NTVWBTNNI 25D E—

Control RO RO—-ILAEFRITEINESHERTE
ER

Connected BHEPROTAVYLALANXY RD—0 (7Y

Network TRRA VK BRRT B,

SSID

BT EARA Y hOSSIDERTRT
%

Security

ERAETI ARV OEF2)To1E
REXRTYT S,

Password

BSEATIEIRA VRO IT—RER
=93,

TEa)F o HWEP/WPARS : *H*xkxx
tF+aF o HNonebF : =4

DHCP

DHCPOEZN(ON). E#(Off) ZRTT 3,

IP Address

DHCPAOffD & FICAMDIPP RLRER
=Y 3,

Subnet Mask

DHCPHOffO LT ICAEDY TRy AR
VERTT B,

Gateway DHCPHOffO & FICABD T T AL —
RoTA%FRRT S,
DNS Auto DNSEEIEFDOON/OFF%2 XT3,

Primary DNS Server

DNS AutoMOffQ & FICAD TS5 1<
I)— DNSH—N—%&RTT 3.

Secondary DNS Server

DNS AutoMOffQ & FICAEDEHV S
I)— DNSH—N—%&KRTT 3.

Channel Auto(5GHz) / Auto / CH1/ CH2 / CH3/ TDAVLALANOFv XL ARET 3.
CH4 /CH5/CH6/ CH7/CH8/CHY9/
CH10 / CHNM

Camera SSID AHEDSSIDE /X ZAT—RERRT B,

& Password

Regenerate Execute / Cancel

RAD—REBERT 3.

Password Execute : 17

IP Address KEOTIEIRA VN E—RTDIPPRL
ARG B,

Subnet EEOTFICIRA Y NE-—RTOYT

Mask RYRIRATHRRT S,
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Network>ST Mode Settings

RAT—Y3aVE-—RTCORRICEATEIRELITVET.

Network>ST Mode Settings

RAT—Y3VE-—RTCOERICETEIRELEITVET,

AZa-IEH MBEEREE

RE

AZa-1HH MBEEREE

S

Scan
Networks

TAVLZALANRY RO —0(FUEZRA
VR) BREL. YRNRTRT B,
UZ S BiEfEEERL. BHRd 5.

SSID BTV ERRA U MOSSIDERRT
%,

Security BRET7IVER RV OEFa)TATE
AERTT S,

Password BHREETIVEARAVADNRIT—REA
HT3,

DHCP DHCPOEZN(ON). |3N(Off) 2_ET 3.

On / Off
IP Address DHCPHOffO & FICABDIPT KL% A

EES

Subnet Mask

DHCPHOOFfD & F(CAEDO Y TRy hT R
VEANT B,

Gateway DHCPHOffO L FICAED T T AL KT —
ROTAHANT S,
DNS Auto DNSE#E{F%0n/0ff9 3,
On / Off

Primary DNS Server

DNS AutoMOffO & FICHAED TS 17
1)— DNSH—N\—%AAHT3,

Secondary DNS Server

DNS AutoMOffo & FIcAEDEHV S
1)— DNSH—N\—%AHT 3B,

Manual
Register

FORIRA Y N EFBERT S,

SSID BHEET7IERAVRDSSIDEAAT
N
Security BRET7IEARAIVbOEFIVTAE

None / WEP / WPA

AZRET S, EHEEPIEIRAIVED
tFa2) T ERIHNWPAZZIZWPA20DI5
Bal3. WPAZEIR,

Password BREAETIVEARAVMDIIT—REA
NI3,
DHCP DHCPOERN(ON) . F#H(Off) 2R ET 3.
On / Off
IP Address DHCPHAOffO & FICAMDIPFT KL% A

EES

Subnet Mask

DHCPHOOFfO & FCAEDY TRy AT R
DEANT B,

Gateway DHCPMOffOEFICF 7A4IL MDD -k
DIA(EANT S,
DNS Auto DNSEEES % 0n/0ff 33,
On / Off

Primary DNS Server

DNS AutoMOff@ &FICT 51T —
DNSH—/\—% AHT 3,

Secondary DNS Server

DNS Autonoffo&Eictthr4 1) —
DNSH—N\—%AHT 3,
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Network>Wired LAN
ERLANEGICBI TR EAITVET,

Network>File Transfer
T 7ML DEXICEATZRERITVET,

AZa—-IEH MELHREE NE AZa-IEH MELEEE NE
Setting On / Off BRRLANZON/Off g3, Auto Upload On / Off FOF> 7 7L OBEEREZON/Off T
Camera Enable / Disable A EBRLANERGEINTWS T/ ZAh (Proxy) %o
Remote SOUE—NIV O—ILEHFTTEINES Default TP DEEFEY —N—%R8IRTSZ, Z
Control MEFRET S, Upload CTERLEY—/N—F. 7OF>T74
Detail BSLANEEO RS TEAETS, Server ILOBBEXE. BLUTLRCILERD
Settings - P = S5DT 7AIEREF DY —/\—ICf33,
DHCOPn ot DHCPDEZ(ON). FE2H(Off) 2KRET 3. Server Settings 1 ~ 3T&7 LDisplay
4 - = — Name%&RY 3.
IP Address DHCPAOHOLZZRROIPT KL2EA Clear Execute / Cancel BRXRETEHOIIATEIINDSIUT
HT 3.
: . Completed 5.
Subnet Mask DHCPAIOFf D& FICABEDY TRy b X Jobs Execute : 17
O%Ajj‘?é" . . Clear All Execute / Cancel TRTOBREIITZIIDSIITT
Gateway DHCPHOFfDLELTTAIL DT - Jobs 2.
DIMEANT S, Execute : T
DNS Auto DNSE#EEA0n/0ff 93, View Job XT3 T—EAERTS,
On / Off List

Primary DNS Server

DNS AutoMOffo&FIcTFS17 U —
DNSH—/\—% AT 3,

Secondary DNS Server

DNS AutoMOffo&Fictth>4)—
DNSH—/\—%AH19 3,

Network>Modem
USBTHU>/ DERICETZREEZTVET,

AZa—-IEH MELHREE AE

Setting On / Off A — T AV EROBE(ON). FESH(OF)
EHRET B,

Camera Enable / Disable 27— k74> TDOCBM(Content

Remote Browser Mobile) 77t 2 D& AI G %

Control RET S,

Device 27—k7#>®Device Name%& &R

Name %,

IP Address AI—KITAVDIPPRLRZERRT S,

Subnet AI—RTAVDY TRy NIRRT

Mask %,
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Network>File Transfer
T7AIVDEXRICREATRREEITVET,

AZa-IEH MBEEREE

RE

Server Display Name ERAEREDAZ1—LORTREEANT
Settings1 %,
Service H—N—-DBHRERTT 3.
m
Host Name R —N—DRANEERET B,
Port(1 ~ 65535(21)) EXEY-—N—DOR-— ESERETS.
User Name BXEY - N\—ERoRAR1I-—Y 4%
BET .
Password RS Y — /R OFREL /N AT — R &5
b
Passive Mode PASVE—K7%ZON/Offg 3,
On / Off
Destination Directory EEEDTALIN)—2BEANT S,
Using Secure Protocol T+ a1 P IHRFTPEX(FTPSDEXplicit
On / Off Mode : FTPES) Z175H(0n). 1THAL
MOff) 2EBET 3.
Root Certificate T2 PRFTPERRI=HDIL— NEAZE D
Load / Clear / None FHiAS. HIFREERET 3.
Root Certificate Status LF a1 PRFTPEX =) DIL— NERAZE D
Loaded / No Certificate FHAHREERTT S,
Reset Server Settings DR E%VHMBICR T,
Execute / Cancel Execute : 1T
Server Server Settings 1£@ L
Settings2
Server Server Settings 1R L
Settings3

Network>Network Reset
KRNI DFREE)EYRLET,

AZa-IHH MEEREE

AE

Reset

Execute / Cancel

XYRD—IDFREE ) EYRT S,
Execute : 17




MaintenanceX_—1—

EAZ1-THHOWES LUREMERIUTOESY TT,

Maintenance>Hours Meter

S

BEFERRB(U Y NRE) 2RRT 3,

BEGERARE() Y M) 2R7T 3,

Hours(Reset) ®R&0IC) Ly T3,
Execute : 1T

S

TIZHERFOYHAR EMEE. AXF(HI:18dB) TRLF T, BHEEEBAERRLET,
. AZa-—1H MBEEHREE
Maintenance>Language
ERTBEEARELET. Hours
— — — (System)
AZa—-IEH MELHRERE S
= R Hours
Select im?égﬁg%ﬁﬁﬁjéa (Reset)
SET- X147 Reset Execute / Cancel
Maintenance>Clock Set
Wﬁﬂ%ﬁ’r(:ﬁﬁ?’éﬁ_’x‘m%ﬁb\i?} Rl e Gl
AZa2—18H HMBEREE RnE N=o a3 ERRLET,
Time Zone  UTC-12:00 ~ UTC +14:00 UTCH S DEEER300 BN TRET 3. AZa-1H MBEHREME
Date Mode YYMMDD / MMDDYY / DDMMYY FAHORTRARZREIRT 3. Version VXXX
YYMMDD : £AH®D|E Number

AEDY TR T TPN—TavaERRT B,

MMDDYY : BHEODIE

DDMMYY : B BEDIE Version Up  Execute / Cancel

12H/24H 12H / 24H

KlORRERZRIRT 3.
12H : 2R RE&R R

KigEN—-Ta 07y T3,

Execute : 17

*N=TIvTPYTREAEOV IR IITET Y
TF—NTBHEETT.

24H : 2485 &R~ Lens Version Vxx

EXOYRLYZDY IR FPN—T30F
BHERRNT S,

Date REOCHGZFRET 3. Number
SET:RE

Time REORFZZHRET 3.
SET:RE

Maintenance>All Reset

TIZHEROKRREICUEYRLET,

AZa-—18H MBEHREE AE

Reset Execute / Cancel TIZHEROREADU LY NEEITT
%,
Execute : 17
[TEE]
Paint/Look A= a1—®Base Look®Import
(89R—%) TA Y R—KL#3DLUT 77 1)L
IFHIBR I NEBA, 1V R—KLE3DLUTT 7
1L %I T 215 E 1%, Paint/LookA=a1—
MBase Look®dDelete AllZE{TLTLETW
(89~—3),

Reset Execute / Cancel Network A Z 2 =BT OFREZFRL oA

without Za—REEEIIGHERECEY N

Network %,
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68 AZa—FRREFHMRTE

ShootingA— 21— D&%

ISO/GainA = 21— DR E(E L ¥EAE

axX AE '1 C\:*]JH\H'f [CDWT

Mode. Target Display. Base Look®Select. Base Sensitivity®&REICL>T. ISO/GainA=a1— (7T7TR—) OREHBEEVHENELRVYET, JL—OEENREFRELIETT,
ModehISOD & F
Target Display SDR(BT.709) HDR(HLG) SDR(BT.709). HDR(HLG):@

Base Look®Select

S-Cinetone / Standard / ITU709 / Still

HLG Live / HLG Natural

User1 ~ User16

Base Sensitivity

Low

High

Low

High

Low

High

1SO 320

ISO/Gain<L>#]HA1&

I1SO 400

I1SO 500

ISO 640

ISO/Gain<M>#]E3{&

1ISO 800

ISO/Gain<L>#H31E

I1SO/Gain<L>##31&

1ISO 1000

1SO 1250

ISO/Gain<H>#]HAfE

1SO 1600

I1SO/Gain<M>#HA1&

1SO/Gain<M>#HA1&

I1SO 2000

I1SO 2500

I1SO 3200

ISO/Gain<H>#]HAE

ISO/Gain<H>#]#A1E

ISO 4000

ISO 5000

I1SO/Gain<L>#]#A1&

I1SO 6400

ISO 8000

1ISO 10000

1SO/Gain<M>#]HA1&

1SO 12800

ISO/Gain<L>#8A1&

ISO/Gain<L>#]HA1&

1SO 16000

1SO 20000

1SO/Gain<H>#H31E

1SO 25600

ISO/Gain<M>#]HA &

ISO/Gain<M>#]E3{&

1SO 32000

1ISO 40000

I1SO 51200

ISO/Gain<H>#]HA1&E

ISO/Gain<H>#]HAE

ISO 64000

1ISO 80000

1SO 102400

1SO 128000

1ISO 160000

I1SO 204800

I1SO 256000

1ISO 320000

1ISO 409600
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ModehdBmn & F*

5% E &
—3dB
—2dB
—1dB
0dB ISO/Gain<L>#]Hi{&E
1dB

2dB
3dB
4dB
5dB
6dB ISO/Gain<M>#]HA &
7dB
8dB
9dB
10dB
11dB
12dB ISO/Gain<H>#]HA{&E
13dB
14dB
15dB
16dB
17dB
18dB
19dB
20dB
21dB
22dB
23dB
24dB
25dB
26dB
27dB
28dB
29dB
30dB
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6T AZa1—RREFHMERTE  ShootingAZ 21— DREBEEHEEICDOVT

AGC LImitAZa—o

R EMEEHIHAE

Mode, Target Display. Base Look®Select. Base Sensitivity®s&E(CL>T. AGCLIMitAZa— (79R—) OREEHE MHENREYET, JL—DOEENRETRELETT,

ModehISOD & F

Target Display

SDR(BT.709)

HDR(HLG)

HDR(HLG)

SDR(BT.709). HDR(HLG)t&@

Base Look®Select

S-Cinetone / Standard / ITU709 / Still

HLG Live

HLG Natural

User1 ~ User16

Base Sensitivity

Low High

Low

High

Low

High

Low High

ISO 400

I1SO 500

ISO 640

I1SO 800

1ISO 1000

1SO 1250

1SO 1600

ISO 2000

#IHAfE

I1SO 2500

I1SO 3200

ISO 4000

ISO 5000

#IHAfE

HHE

#HHAE

I1SO 6400

ISO 8000

1ISO 10000

1SO 12800

1ISO 16000

I1SO 20000

1SO 25600

1SO 32000

#IHAfE

1ISO 40000

I1SO 51200

ISO 64000

1ISO 80000

¥IHAfE

#HHAE

#IHAfE

1SO 102400

1SO 128000

1ISO 160000

ISO 204800

I1SO 256000

1SO 320000

1ISO 409600
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ModehdBmn & F*

REHHE
3dB
6dB
9dB
12dB
15dB YIHAfE
18dB
21dB
24dB
27dB
30dB
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B E—NZEOBEEICETHREREDRFICDOVT

EECETZHREEER. UTOREE-—R(24R-) ZLCREORTERENRIFIINE T, BET—RE2UVERZ L VIWVBZROBREE—RHIRIGIIRTRENBERINET,
e CustomE—R®OSDR(BT.709)
e CustomE—KR®DHDR(HLG)
e Cine EIE—K
BEHEICETEREREIREE—RIEICUTOLSCREINET,
Yes : REINFET
No: REINEHA

REEE REE
CustomE—F‘ Cine EIE—R
SDR(BT.709) ‘ HDR(HLG)
ShootingAZa— ISO/Gain/El ISO/Gain Yes" No
Exposure Index No Yes
Base Sensitivity Yes No
Base ISO No Yes
White Preset White Yes Yes
LEUH Yes
White Setting Yes
Offset White Yes No
LUT On/Off No Yes
Noise Suppression Setting(Custom) Yes Yes No
Level(Custom) Yes Yes No
Setting(Cine El) No Yes
Level(Cine El) No Yes
Paint/LookAZa1— Base Look Select Yes Yes Yes
Input? Yes
Output? Yes
AE Level Offset? Yes
Black Yes Yes No
Knee Auto Knee Yes No No
RS Yes Yes No
Detail Yes Yes No
Matrix Yes Yes No
Multi Matrix Yes Yes No

1) ISOREICDWTIE. CustomE—R®DSDR(BT.709). HDR(HLG) TR EMEHERICREINZHZEHHYET,
2) &R EfEIEBase LookZ L IREFINTH Y. FREE-—RICIHKELEZEA.
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RET— Y DRI
RET—4

TIAZa—DREHNB . KHEDCFexpress
Type A/SDA—KRZOv N B) ICEALEAE
J—H—RIRETZIENTEET, 2OFT—
SEFESTEYGEY NPy TIREATIEDL<E
WTEFET,

BET—YIE. ROLSCHFEINTHRETN
¥7.

User File(A—Y—771)L)

HAIIA X LIcUserdA —a— DR EEEERE
F—9EFRELET,
AEV—H—RICOAEFETRETZIELNTE
E3

ZOTFANERBEOAT) —CFHRMMHAL &I
&Y. UserAZa—%HhHR9I1 X LIIREEIC
TyNPYTITRIENTEET,

All File(ALLZ 7)L)
EAZI-DBEF—IEREFELET, AEU—
H—RIC6MBETRETZZENTTET,
[TFEE]

BREEOT—Y (BB CHENVERYI—FT (VY
PHALRIERE) BREINE A,

1A I+

dA—Y—TJ7A4)L, ALL7 74
W REFETS

1 AE—hH—K%CFexpress Type A/SD
H—RZ20OvkB) (6/R—) ICELRA
L,
o CFexpressh—RDIFEIFSNILEEIC
EE:R
e SDA—RDFHIFSINILEAEIC
REBETICT 2,

Lo

2 1-Y-I7(LOBAE. INAZa—
DProject A Za1— >User File®Save
Media(B)(88 RX—) T. Execute% 3
RT3,

ALLZ 7MIILDFZEIE. TILAZa1—0D
ProjectX = a1—>All File®Save Media(B)
(88/R—3) T. Execute®:&ERT 3,
T7ALVOREFLAEBEANEZRINET,

3 REEEEONO Filed 5 RIRT 3.
File DA I NTVBTARRT B L.
ZDT AL LBESNET,
File IDEEBIMICA T SNET A,
BTLLTEET,

EEY

4 wemEEOExecutes BIRT 3.

dA—Y—TJ7A)L. ALLT7 74
L FFHIAD

T sr1nzgELrrsU—p—r%
CFexpress Type A/SDA—RzOv k(B)
(6R—Y) ICZELAL,

o CFexpressh—RDIFEIESNILEEIC
g3,

¢ SDA—RDFEIEIRNILERIC
REBETICT 3,

Lo

2 1-H-TrLOBAR. TIAZI—
MDProjectAZa— >User FiledLoad

Media(B)(88 R—) T. Execute% 3
RT3,
ALLZ 7ML DHZEIE. FILAZa1—0D

ProjectX = 21— >All File®Load Media(B)

(88 —3) T. Execute%ERd 3,
TF7AIILO—EEENKRRIINET,

3 FRAGTILERRT S,
SEENERINET.

4 ExecuterBRT 3.

[TEE]

o MET—YEFHFHATE., AEIEBNICHESHIN
E 8

o JJLAZa—DProjectAZa— >All FiledLoad
Network DatahlOffdizE (X, NetworkAZa—d
BEBEBEBRVEALLT 7ML A5 HAH T,

File IDZZEE T 5ICIE

T a—v—oroman. suxza-
DProject A= a1—®User FileT. File ID
(88R—2) 2 #EIRT 3B,

ALLZ 7ML DGFEIF. TIAZ1—D
Project A= a2—®All FileT. File ID(88
R—I) #&EIRT 3,

File DOMGREBENKTINET,

2 TAFELII— (17—Y) FTld7IL
FIPI2aVFALVILGER—I) T
XZEHFRL. IIILFELIYI—DRERY
VERECILFTI VI AV VI
ER

3 FEArBYUET

A wspAAHET LI5S, Donek BIRT 3.
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TE SRS R

NEBE Y — L= EZ &t I 5

S8R BEEBENBEI—CRTTERLEE
(. AgEOHAESEREIRL., ERTZ2EZS—
ICISCERT—TILAFERLTETV,
VTRIGEDEREEZERLT. AEOHAE
BHERTZIEETEET,
NBEZY—ICE2—T7A VY- LEIKRDERE
2T = AEROA 21— HEERRIEBRE
NTEXYT, EZY—ICHATBRESITHLT.
Monitoring 25 —4 Z®Info. Disp.(15R—
D). £rETIAZ 2—DMonitoringA=a—
@ Output Display(93R—<) Z0nICEREL
TLIET W,

SDI OUTi#H+(BNCEY)
MonitoringA=a— (93R—) T. HAD
On/Off P AT+ - v b ERELET,

BRCEMRO7T5QEE T —TILEFERLTLE
T,

[TEE]
AR ENTHBOBOT—INBEICEINTVWS L
zHELTHS, EBREANTILEL,

(T5QRE#7 —TIL =R Llci(c. FENE
WEDEREANS I L2HEHLET.)
PUERF/Y. BEREBARETHRHSEZERT
BimEE. 15SQRET —T L& SR ER (C R
LIicRIC, AfEERLTIET VL,

Ak EBFICH B ES TR iRz FtR
gBICE

SDUEBSHARFIE., TILAZ 21— DProjectA
—a1—>SDI/HDMI Rec Control(85~<_—

) MSetting%SDI/HDMI Remote I/FE /1
Parallel ReclCE&E T3 &. SDI OUTIHF (T
BeL N33 (CRECR U H—{EB 2N T3
ElC&oT. AEEEBLIERERMNATREC AW E

[TEE]

o EFELIAEMESINRECK U A —ESICHIELTVAWN
AEILEMELE A

o AFATHBATNTVLEWVEEFE, RECRUH—ES
OHEAENET,

HDMI OUT#:HType A%
74 —)

TILAZa—dMonitoringA=—a1— (93—
) T HADON/Off PHAT+—T v &R
EFLET,

Ak EBFICH BRI ES TR iR Z FtR
gBICE

HDMIESHA1B%(E. ZILAZ2—0DTC/Media
A= a— >HDMI TC Out®Setting(91R—

) #0nlc LT, ProjectA=a— >SDI/HDMI
Rec Control®Setting(85—<) #SDI/
HDMI Remote I/F¥fzIZParallel RecIZE&E
g5&. HDMI OUTifRF(C 3T Uiz A EBiER I
RECANUAH—ESEE AT R LCLoT. Kk
EEEALEERMATREIC AR Y £ T,
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TE SRS R

A4 LI—REEHES

AEEOIALD—REMECEHDERZZENTE
x7.

DY« LI—KRICOyy
T3

SALD—RERTRERZHERIE. 9/L0—-R
HANEHFRINBE—R(Free Runt>Clock) I
RELTLT L,

T snxza-oTc/Mediax=2-0
Timecode(91R—) XD LS ICRTE
I3,

Mode : Preset
Run : Free Run

2 DURATION/TC/U-BITH#EENEIY YT SN
e PHAFTILRY > (51R—) 2L
T. BAICYAILI-RERRTES,

3 TCIN/OUTEIWEZ XA v F(AR—)
MINRICIE>TWBZ &E&REEEL. TCIN/
TCOUTIRFIC. AMD>ZTLEFEIC
EHAL B LTI— REMIET 3,

INTEABOIALI—RI TR —Y—HiE%EE
Y4 L0—-RicOyvs L. BE@EICTEXT-LKI &%
REINET,

Ov7 LTHhofMI0MRBELEIF. NS
DOEESALTD—-ROERZALTD. SOy
JREFRIENET,

[TEE]

o ABOVIDEFETZE. 9L RIIBREFICHER
DYALT—RicOvs L, MBYALI—-FDEERL
EDNY A LT —IRTREBICHETH, §14L40—-KIx
XL—F—NRETZFTOHRMEIL. CREBBLA
WTLETW,

o EEHSALI-ROFRBEREOT L —LBAREHE
LThRVE, ELLOYITEY. AEDNEFECEIET
FTEBA. COBE. YL —-RBAEOYALO—
RIZIELLOvITEEEA.

o HEHSALI-RICHLIBEETIZL-—LTNZHEH
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1920X%1080i

3840%2160P

1920X1080P

1920X%1080i

1920X1080P

1920%1080i

1920X1080P

1920X%1080i

1920X%1080i
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1920X1080P 1920X1080P
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1920X1080i 1920X%1080i
3840X 2160 RAWEAEY — 3840X2160P
1920X1080P
1920X1080i
1920X1080P
1920X1080i
1920%X1080P
1920X1080i
1920%x1080i
RAWH AL 3840X2160P 3840X2160P
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1920%X1080i
1920X1080P 1920X1080P
(Level A)
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1920X1080P 1920X1080P
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1920x1080P 1920x1080P  1920X1080P
3840x2160P  3840x2160P 3840%2160 RAWHIABY — 3840 2160P
1920X1080P 1920X1080P
1920X1080? 1920X1080? 1920X1080P
2352;’)"1080' 1920x1080i RAWHAEL  3840x2160P  3840%2160P
3840X 2160 RAWHAHEY — 3840X%X2160P 1920x1080P
1920X1080P 1920X1080P 1920X1080P
1920X1080P 1920X1080 RAWH AL 1920X1080P 1920X1080P
1920X%X1080i
RAWHAHEL 3840X%2160P 3840%X2160P
1920%X1080P
1920X1080P 1920%X1080P
1920X1080i 1920X1080i

(PsF)
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High H—RER{TEH. BEHNTHZETH—ROE
AEHIELT TV,
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IBELRE<SSID>D XY hT—2(FUEXRA > N) OFEFEREEIC
LHMLELE,
NZAT—RGERELKERELTVWAMERLTIEEW,

Media Error
Cannot Use Media(A)"

AEV—A—RHRELTCERLBELTERBRYE L
AETHMRAELBADT, DD —RICKIRLTILETW,

Media(A)"Error
Recording Halted
Playback Halted

AEY—H—RICEEHRELH. BRELEIBEINFLEL
FLI.
BREICEIZHERICIE. AEV—H—REZRLTRET W,

An IP address conflict has
occurred. Please check the
network settings.

TAVLZLANEBRRELANDUSBF UV I EEDORY NT—2
FRLZDBERLTWVWET,

FPRLZZFHTEETEIH. BEVDORYLT—-TIL—-5—-D
REEEBELTETY,

Media Reached Rewriting Limit
Change Media(A)"

AEU-hH-—RoFaNTFELL.

Ny I FyTrey) BPOHMIRIBLTETW, #ELTERT
d&. ERICEKR BETTRVHRELNSBYET,

FLLE, AR —H—FORRHBAELZSRLTIETL,

The IP address of the Wireless
LAN Access Point Mode has been
changed due to an IP address
conflict.

TAVLIALANT 7 EZRA > M E—REFHRLAN, F£7zIFUSB
THIYIDRY RI—I P RLIADNMERLIcfeéh. T1V LR
LAN7ZEZRA YR E—RDIPPRLAEZEELFLE,
IPPRLRZHRLTIIET W,

The specified address is invalid.

EBELEZRLADEE>TVET,
ELERELTVWANEESEL TRV,

Cannot Use Specified Port
Number

EBELA-FMESHEESTVET,
ELSERELTWSHHEERLTIRE L,

Fan Stopped

AEROT 7o MELELTVET,
BRETTOFERAZET, EBREY>TYI—0Y—EBYEC
EIRLTETW,

1) 20v kBIZANT=H—RDIFE1Z(B)
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T7A4ILICRIFEINS

— - LEVEL1 LEVEL 2 LEVEL 3 All File  Scene

TIAZa1—Ic LB 15H File

Shooting Auto Exposure Level Yes No

Yes : TP AIICREFINET Mode Yes No
No: 77AILICRETNE A

— TP ALICREE NE A (— B BEA = 1) Speed Yes No

LEVEL 1 LEVEL 2 LEVEL 3 AllFile  Scene AGC ves  No

File AGC Limit Yes No

Shooting 1SO/Gain/El Mode Yes No AGC Point Yes No

1SO/Gain<H> Yes No Auto Shutter Yes No

1SO/Gain<M> Yes No A.SHT Limit Yes No

1SO/Gain<L> Yes No A.SHT Point Yes No

Exposure Index<H> Yes No Clip High light Yes No

Exposure Index<M> Yes No Detect Window Yes No

Exposure Index<L> Yes No Detect Window Indication Yes No

Shockless Gain Yes No Custom Width Yes No

Base Sensitivity Yes No Custom Height Yes No

Base ISO Yes No Custom H Position Yes No

ND Filter Presetl Yes No Custom V Position Yes No

Preset? Yes No White Preset White Yes No

Preset3 Yes No Color Temp <A> Yes No

Shutter Mode Yes No Tint<A> Yes No

Shutter Speed On/Off Yes No R Gain <A> Yes No

Shutter Speed Yes No B Gain <A> Yes No

Shutter Angle Yes No Color Temp <B> Yes No

ECS On/Off Yes No Tint<B> Yes No

ECS Frequency Yes No R Gain <B> Yes No

B Gain <B> Yes No

White Setting Shockless White Yes No

ATW Speed Yes No

White Switch<B> Yes No

Filter White Memory Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File  Scene LEVEL1 LEVEL 2 LEVEL 3 All File  Scene
File File
Shooting Offset White Offset White <A> Yes No Project Base Setting Shooting Mode Yes —
Offset Color Temp<A> Yes No Target Display Yes —
Offset Tint<A> Yes No Rec Format Frequency Yes No
Offset White <B> Yes No Imager Scan Mode Yes No
Offset Color Temp<B> Yes No Codec Yes No
Offset Tint<B> Yes No RAW Output Format Yes No
Offset White<ATW> Yes No Video Format Yes No
Offset Color Temp<ATW> Yes No Cine El Setting Color Gamut Yes —
Offset Tint<ATW> Yes No Simul Rec Setting Yes No
Focus AF Transition Speed Yes No Proxy Rec Setting Yes No
AF Subj. Shift Sens. Yes No Audio Channel Yes No
Focus Area Yes No Interval Rec Setting No No
Focus Area (AF-S) Yes No Interval Time Yes No
Face/Eye Detection AF Yes No Number of Frames Yes No
Push AF Mode Yes No Pre-Lighting Yes No
AF Assist Yes No SDI/HDMI Rec Control Setting Yes No
S&Q Motion Setting Yes No Assignable Button <1> Yes No
Frame Rate Yes No <2> Yes No
LUT On/Off SDI/HDMI Yes No <3> Yes No
VF/Proxy/Stream Yes No <4> Yes No
Internal Rec Yes No <5> Yes No
Noise Suppression Setting(Custom) Yes No <6> Yes No
Level(Custom) Yes No <7> Yes No
Setting(Cine El) Yes — <8> Yes No
Level(Cine El) Yes — <9> Yes No
Flicker Reduce Mode Yes No Focus Hold Button Yes No
Frequency Yes No Assignable Dial Grip/Remote Dial Yes No
SteadyShot Setting Yes No Grip Dial Direction Yes No
Handle Dial Yes No
Handle Dial Direction Yes No
Multi Function Dial Default Function Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File  Scene LEVEL 2 LEVEL 3 All File  Scene
File File
Project User File Load Media(B) — — Detail Setting Yes Yes
Save Media(B) — — Level Yes Yes
File ID No No Manual Setting Yes Yes
Load Customize Data Yes No V/H Balance Yes Yes
Load White Data Yes No B/W Balance Yes Yes
All File Load Media(B) — — Limit Yes Yes
Save Media(B) — — Crispening Yes Yes
File ID Yes No High Light Detail Yes Yes
Load Network Data No No Matrix User Matrix Yes Yes
Paint/Look  Scene File Recall — — User Matrix Level Yes Yes
Store — — User Matrix Phase Yes Yes
Delete — — User Matrix R-G Yes Yes
Preset Recall — — User Matrix R-B Yes Yes
Base Look Select Yes Yes User Matrix G-R Yes Yes
Delete — — User Matrix G-B Yes Yes
Delete All — — User Matrix B-R Yes Yes
Import — — User Matrix B-G Yes Yes
Input Yes Yes Multi Matrix Setting Yes Yes
Output Yes Yes Reset — —
AE Level Offset Yes Yes AXis No Yes
Reset Paint Settings  Reset without Base Look — — Hue Yes Yes
Black Master Black Yes Yes Saturation Yes Yes
R Black Yes Yes
B Black Yes Yes
Knee Setting Yes Yes
Auto Knee Yes Yes
Point Yes Yes
Slope Yes Yes




125 | 8& I : IJ7AILICREINBIRE

LEVEL 1 LEVEL 2 LEVEL 3 All File  Scene LEVEL1 LEVEL 2 LEVEL 3 All File  Scene
File File
TC/Media Timecode Mode Yes No Monitoring  Display On/Off Network Status Yes No
Run Yes No File Transfer Status Yes No
Setting No No Rec/Play Status Yes No
Reset — — RAW Output Control Status Yes No
TC Format Yes No Tally Yes No
TC Display Display Select Yes No Battery Remain Yes No
Users Bit Mode Yes No Focus Mode Yes No
Setting No No Focus Position Yes No
HDMI TC Out Setting Yes No Focus Area Indicator Yes No
Clip Name Format Title Prefix Yes No Focus Area Ind.(AF-S) Yes No
Number Set No No Face/Eye Detection Frame Yes No
Update Media Media(A) — — Lens Info Yes No
Media(B) — — Imager Scan Mode Yes No
Format Media Media(A) — — Rec Format Yes No
Media(B) — — Frame Rate Yes No
Monitoring  Output On/Off SDI Yes No Zoom Position Yes No
HDMI Yes No UWP RF Level Yes No
Output Format SDI Yes No SteadyShot Yes No
HDMI Yes No Base Look/LUT Yes No
Output Display SDI Yes No SDI/HDMI Rec Control Yes No
HDMI Yes No Gamma Display Assist Yes No
Proxy Status Yes No
Base ISO/Sensitivity Yes No
Media Status Yes No
Video Signal Monitor Yes No
Clip Name Yes No
White Balance Yes No
Scene File Yes No
Focus Indicator Yes No
Auto Exposure Mode Yes No
Auto Exposure Level Yes No
Timecode Yes No
ND Filter Yes No
Iris Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File  Scene LEVEL1 LEVEL 2 LEVEL 3 All File  Scene
File File
Monitoring  Display On/Off ISO/Gain/El Yes No Monitoring  Zebra Setting Yes No
Shutter Yes No Zebral Level Yes No
Level Gauge Yes No Zebral Aperture Level Yes No
Audio Level Meter Yes No Zebra2 Level Yes No
Video Level Warning Yes No Audio Audio Input CH1 Input Select Yes No
Clip Number Yes No CH2 Input Select Yes No
Notice Message Yes No CH3 Input Select Yes No
Marker Setting Yes No CH4 Input Select Yes No
Color Yes No INPUT1 MIC Reference Yes No
Center Marker Yes No INPUT2 MIC Reference Yes No
Safety Zone Yes No Line Input Reference Yes No
Safety Area Yes No Reference Level Yes No
Aspect Marker Yes No CH1 Wind Filter Yes No
Aspect Mask Yes No CH2 Wind Filter Yes No
Aspect Safety Zone Yes No CH3 Wind Filter Yes No
Aspect Safety Area Yes No CH4 Wind Filter Yes No
Aspect Select Yes No CH3 Level Control Yes No
Custom Aspect Ratio Yes No CH4 Level Control Yes No
Guide Frame Yes No CH3 Input Level Yes No
100% Marker Yes No CH4 Input Level Yes No
User Box Yes No Audio Input Level Yes No
User Box Width Yes No Limiter Mode Yes No
User Box Height Yes No CH1&2 AGC Mode Yes No
User Box H Position Yes No CH3&4 AGC Mode Yes No
User Box V Position Yes No AGC Spec Yes No
VF Setting Brightness Yes No 1kHz Tone on Color Bars Yes No
Color Mode Yes No CH1 Level Yes No
Gamma Display Assist Setting Yes No CH2 Level Yes No
Peaking Setting Yes No CH3 Level Yes No
Peaking Level Yes No CH4 Level Yes No
Color Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File  Scene LEVEL1 LEVEL 2 LEVEL 3 All File  Scene
File File
Audio Audio Output Monitor CH Yes No Technical Color Bars Setting No No
Volume No No Type Yes No
Headphone Out Yes No ND Dial CLEAR with Dial Yes No
Alarm Level Yes No Tally Front Yes No
HDMI Output CH Yes No Rear Yes No
Thumbnail Display Clip — — HOLD Switch Setting  with Rec Button Yes No
Properties with Hand Grip Remote Yes No
Set Clip Flag Add OK - - Touch Operation Setting Yes No
Add NG — — Rec Review Setting Yes No
Add KEEP — — Zoom Zoom Type Yes No
Delete Clip Flag - - Handle Zoom Setting Yes No
Lock/Unlock Clip Select Clip — — High Yes No
Lock All Clips — — Low Yes No
Unlock All Clips - - Menu Settings User Menu Only Yes No
Delete Clip Select Clip - - User Menu with Lock No No
All Clips — - Fan Control Setting Yes No
Transfer Clip Select Clip - - Lens Zoom Ring Direction Yes No
All Clips — _ Shading Compensation Yes No
Transfer Clip (Proxy) ~ Select Clip - - Chroma Aberration Comp. Yes No
All Clips - - Distortion Comp. Yes No
Filter Clips OK - - Distance Display Yes No
NG — — Zoom Position Display Yes No
KEEP - - Video Light Set Video Light Set Yes No
None — _ APR APR — —
All — — Camera Battery Alarm Low Battery Yes No
Customize View Thumbnail Caption Yes — Battery Empty Yes No
Camera DCIN Alarm  DC Low Voltagel Yes No
DC Low Voltage2 Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File  Scene LEVEL1 LEVEL 2 LEVEL 3 All File  Scene
File File
Network Access User Name No No Network ST Mode Settings Camera Remote Control Yes No
Authentication Password No No Connected Network
Wireless LAN Setting Yes No SSID — —
WPS — — Security — —
NFC — — Password — —
MAC Address — — DHCP — —
AP Mode Settings Channel Yes No IP Address — —
Camera SSID & Password — — Subnet Mask — —
Regenerate Password — — Gateway — —
IP Address — — DNS Auto — —
Subnet Mask — — Primary DNS Server — —
Secondary DNS Server — —
Scan Networks
SSID — —
Security — —
Password No No
DHCP Yes No
IP Address Yes No
Subnet Mask Yes No
Gateway Yes No
DNS Auto Yes No
Primary DNS Server Yes No
Secondary DNS Server Yes No
Manual Register
SSID Yes No
Security Yes No
Password No No
DHCP Yes No
IP Address Yes No
Subnet Mask Yes No
Gateway Yes No
DNS Auto Yes No
Primary DNS Server Yes No
Secondary DNS Server Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File  Scene LEVEL1 LEVEL 2 LEVEL 3 All File  Scene
File File
Network Wired LAN Setting Yes No Maintenance Language Select Yes No
Camera Remote Control Yes No Clock Set Time Zone Yes No
Detail Settings Date Mode Yes No
DHCP Yes No 12H/24H Yes No
IP Address Yes No Date No No
Subnet Mask Yes No Time No No
Gateway Yes No All Reset Reset — —
DNS Auto Yes No Reset without Network — —
Primary DNS Server Yes No Hours Meter Hours(System) — —
Secondary DNS Server Yes No Hours(Reset) — —
Modem Setting Yes No Reset — —
Camera Remote Control Yes No Version Version Number — —
Device Name — — Version Up — —
IP Address — — Lens Version Number — —
Subnet Mask — —
File Transfer Auto Upload (Proxy) Yes No
Default Upload Server Yes No

Clear Completed Jobs

Clear All Jobs — —

View Job List — —

Server Settings1/Server Settings2/Server Settings3
Display Name Yes No
Service Yes No
Host Name Yes No
Port Yes No
User Name No No
Password No No
Passive Mode Yes No
Destination Directory Yes No
Using Secure Protocol Yes No

Root Certificate

Root Certificate Status

Reset

Network Reset

Reset
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PHAFTILRY U IC LB TEIERB

Yes : J7AIIREINET
No: 77AIICRETNE LA
—  IPANEREINECA(—BFMEEA Z21—)

T YA FTILIRG > DEIRFE All File Scene File
ND Filter Position Yes No

Auto Iris Yes No

ATW Yes No

Focus Setting Yes No
Display Yes —

VF Adjust Yes —
PHAFTILIAVILIC LB EER
Yes: 77AIILICREFESNET

No: 77AILICREINE A
— IR EINEBA(—BMBEIEAZ21—)

FHAFTILIAVILDFEIRE All File Scene File
IRIS Yes No

ND Filter Yes No

Audio Input Level Yes No
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Audio Input (CH3&CH4)
NYRILEEROTOYIIAVYISLTY,

[1kHz Tone on Color

[Color Bars]

0~99

[CH3 Input Level]

(.
[CH3 Level]

Level+CH3 Input Level

Audio Input Level
Through

CH3 Input Level

]
U

7

[CH3 Level
Control]*
Auto
Manual

\

Mono
Stereo

[Limiter Mode]
Off, -6dB,

xl
——————

[Audio Input Level]

0~99

[CH4 Input Level]

Level+CH4 Input Level

CH4 Input Level
Through

Audio Input Level

[CH4 Level]

[CH4 Level
Control]*
Auto
Manual

[CH3 Wind Filter]

[CH3 Input Select]
Internal MIC

INPUT1
Shoe CH1

OFF

INPUT1
INPUT2
Internal MIC

Shoe CH1

Shoe CH2

[CH4 Input Select]
Internal MIC

INPUT2
Shoe CH2

0~99

-9dB, -12dB,
-15dB, -17dB

BTYUET,

r

* XLR74 F9—-h5sDBEBEAANS 2L EEManuall
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Audio Output

CH1 o N
CH2 >
SDI OUT
CH3 >
CH4 I T y > <
8\¢\¢ ( )
I HDMI OUT
Y ] "\ J

N /

[HDMI Output CH]
CH1/CH2, CH3/CH4

v

Internal Speaker

Headphone

CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

]
1
1
1
1
\

[Alarm Level] [VOLUME]
0~7 0~50
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JATVXICDWVWT

MPEG-4 AVC Patent
Portfolio LicenselcDWT

AERIE. MPEG LA, LLCAS 1tV 5EE %
fToTWBAVC PATENT PORTFOLIO LICENSE
DT, ROBRICBRYSAEVRAINTVET:
(i) HBEHNBANZLIMMORMEZZ T TV
WERBE®NT. MPEG-4 AVCERRICAEL
EFFES AT, AVCVIDEOEVLWWET)
CI>a—-R¥3zE,

(i)AVC VIDEOGHE & HME AR E Tz (2t DR
AZIFTTOWEVWERNTIYO-RLEL D,
EHLLIIMPEG LAKYS A2 #EB L
FONAS—NI>I—-RLEEDICESNE
9)EFTI-—Rg3zL,

BHE. ZOMORARICEALTIEZIEYIEINT
WEtHA, 7O0E—>a>, BENCFIATSS
EICREAT MR BRICDOFTFELTIE. MPEG

LA, LLC.OR—LAR—SHZSBIET W,

GPL/LGPLERY 7 kD7
DAFICDWVT

AERIEGPL/LGPLERDOY 7oz 7% ER
LTHY. BERICIE. cNSOYTRIIT7D
V—2I—ROAF. WZE. BERADEFHHS
ZEEBHRSELET,

b (YONESY Su B NS @2 B S N Ly S e
hodo>0-RFZZENTAEETT. UTO
URLIZZZ AT NIE. EAFRMGSTI>O-RD
HENDMB LSO TVET.,

http://www.sony.net/Products/Linux/
common/search.html

BH. V-AOA—ROHBHICDODVWTOEBWLED
BRITEEBLIETW,

SAtEYIZAB(E) ICEALTIE. REDOREA
EJ-RNICEBINTVET,

AL NYVIAVEIZ AN —TiEEL.
TPMHOME, - TLICENSEIRICH 27 7L %S
—ZL< TV,

MackZERDZEIF. AiED'PMHOME] -
TLICENSEJ [C PV ERTEFRVWZ ENBYET,
TP EFUERIEMacBA 2 BEVWELC
. FEEURLIEPVEALTI7 7L AT EER<
TV,
https://oss.sony.net/License/ILME-FX6/

END USER LICENSE
AGREEMENT

IMPORTANT:

BEFORE USING THE SOFTWARE CONTAINED IN THE
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS
END USER LICENSE AGREEMENT (“EULA") CAREFULLY. BY
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony
Corporation ("SONY"). This EULA governs your rights
and obligations regarding the software of SONY and/or
its third party licensors (including SONY's affiliates) and
their respective affiliates (collectively, the “THIRD-PARTY
SUPPLIERS") contained in the wireless adapter, together
with any updates/ upgrades provided by SONY, any

printed, on-line or other electronic documentation for
such software, and any data files created by operation of
such software (collectively, the “SOFTWARE").

Notwithstanding the foregoing, any software in

the SOFTWARE having a separate end user license
agreement (including, but not limited to, GNU General
Public license and Lesser/Library General Public License)
shall be covered by such applicable separate end user
license agreement in lieu of the terms of this EULA to
the extent required by such separate end user license
agreement (“EXCLUDED SOFTWARE").

SOFTWARE LICENSE

The SOFTWARE is licensed, not sold. The SOFTWARE is
protected by copyright and other intellectual property
laws and international treaties.

COPYRIGHT

All right and title in and to the SOFTWARE (including,
but not limited to, any images, photographs, animation,
video, audio, music, text and “applets” incorporated into
the SOFTWARE) is owned by SONY or one or more of the
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE

SONY grants you a limited license to use the SOFTWARE
solely in connection with the wireless adapter and only
for your individual use. SONY and the THIRD-PARTY
SUPPLIERS expressly reserve all rights, title and interest
(including, but not limited to, all intellectual property
rights) in and to the SOFTWARE that this EULA does not
specifically grant to you.

REQUIREMENTS AND LIMITATIONS

You may not copy, publish, adapt, redistribute, attempt to
derive source code, modify, reverse engineer, decompile,
or disassemble any of the SOFTWARE, whether in whole
orin part, or create any derivative works from or of the
SOFTWARE unless such derivative works are intentionally
facilitated by the SOFTWARE. You may not modify or
tamper with any digital rights management functionality
of the SOFTWARE. You may not bypass, modify, defeat
or circumvent any of the functions or protections of the
SOFTWARE or any mechanisms operatively linked to

the SOFTWARE. You may not separate any individual
component of the SOFTWARE for use on more than one

wireless adapter unless expressly authorized to do so
by SONY. You may not remove, alter, cover or deface

any trademarks or notices on the SOFTWARE. You may
not share, distribute, rent, lease, sublicense, assign,
transfer or sell the SOFTWARE. The software, network
services or other products other than SOFTWARE upon
which the SOFTWARE'S performance depends might

be interrupted or discontinued at the discretion of

the suppliers (software suppliers, service suppliers, or
SONY). SONY and such suppliers do not warrant that the
SOFTWARE, network services, contents or other products
will continue to be available, or will operate without
interruption or modification.

EXCLUDED SOFTWARE AND OPEN SOURCE
COMPONENTS

Notwithstanding the foregoing limited license grant,
you acknowledge that the SOFTWARE may include
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE
may be covered by open source software licenses
("Open Source Components”), which means any
software licenses approved as open source licenses by
the Open Source Initiative or any substantially similar
licenses, including but not limited to any license that,
as a condition of distribution of the software licensed
under such license, requires that the distributor make
the software available in source code format. If and to
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list
of applicable OPEN SOURCE COMPONENTS included in
the SOFTWARE from time to time, and the applicable
terms and conditions governing its use. Such terms
and conditions may be changed by the applicable
third party at any time without liability to you. To the
extent required by the licenses covering EXCLUDED
SOFTWARE, the terms of such licenses will apply in lieu
of the terms of this EULA. To the extent the terms of the
licenses applicable to EXCLUDED SOFTWARE prohibit
any of the restrictions in this EULA with respect to such
EXCLUDED SOFTWARE, such restrictions will not apply
to such EXCLUDED SOFTWARE. To the extent the terms
of the licenses applicable to Open Source Components
require SONY to make an offer to provide source code
in connection with the SOFTWARE, such offer is hereby
made.


http://www.sony.net/Products/Linux/common/search.html
http://www.sony.net/Products/Linux/common/search.html
https://oss.sony.net/License/ILME-FX6/
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USE OF SOFTWARE WITH COPYRIGHTED
MATERIALS

The SOFTWARE may be capable of being used by you

to view, store, process and/or use content created by
you and/or third parties. Such content may be protected
by copyright, other intellectual property laws, and/

or agreements. You agree to use the SOFTWARE only

in compliance with all such laws and agreements that
apply to such content. You acknowledge and agree

that SONY may take appropriate measures to protect
the copyright of content stored, processed or used by
the SOFTWARE. Such measures include, but are not
limited to, counting the frequency of your backup and
restoration through certain SOFTWARE features, refusal
to accept your request to enable restoration of data, and
termination of this EULA in the event of your illegitimate
use of the SOFTWARE.

CONTENT SERVICE

PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE
DESIGNED TO BE USED WITH CONTENT AVAILABLE
THROUGH ONE OR MORE CONTENT SERVICES (“CONTENT
SERVICE"). USE OF THE SERVICE AND THAT CONTENT IS
SUBJECT TO THE TERMS OF SERVICE OF THAT CONTENT
SERVICE. IF YOU DECLINE TO ACCEPT THOSE TERMS,
YOUR USE OF THE SOFTWARE WILL BE LIMITED. You
acknowledge and agree that certain content and
services available through the SOFTWARE may be
provided by third parties over which SONY has no
control. USE OF THE CONTENT SERVICE REQUIRES AN
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY
SERVICES

You acknowledge and agree that access to certain
SOFTWARE features may require an Internet connection
for which you are solely responsible. Further, you are
solely responsible for payment of any third party fees
associated with your Internet connection, including

but not limited to Internet service provider or airtime
charges. Operation of the SOFTWARE may be limited

or restricted depending on the capabilities, bandwidth
or technical limitations of your Internet connection

and service. The provision, quality and security of such
Internet connectivity are the sole responsibility of the
third party providing such service.

EXPORT AND OTHER REGULATIONS

You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country
in which you reside, and not to transfer, or authorize

the transfer, of the SOFTWARE to a prohibited country
or otherwise in violation of any such restrictions or
regulations.

HIGH RISK ACTIVITIES

The SOFTWARE is not fault-tolerant and is not designed,
manufactured or intended for use or resale as on-line
control equipment in hazardous environments requiring
fail-safe performance, such as in the operation of nuclear
facilities, aircraft navigation or communication systems,
air traffic control, direct life support machines, or
weapons systems, in which the failure of the SOFTWARE
could lead to death, personal injury, or severe physical or
environmental damage (“HIGH RISK ACTIVITIES"). SONY,
each of the THIRD-PARTY SUPPLIERS, and each of their
respective affiliates specifically disclaim any express or
implied warranty, duty or condition of fitness for HIGH
RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE
is at your sole risk and that you are responsible for use
of the SOFTWARE. The SOFTWARE is provided “AS IS,”
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as
“SONY") EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING,

BUT NOT LIMITED TO, THE IMPLIED WARRANTIES

OF MERCHANTABILITY, NONINFRINGEMENT AND
FITNESS FOR A PARTICULAR PURPOSE. SONY

DOES NOT WARRANT OR MAKE ANY CONDITIONS

OR REPRESENTATIONS (A) THAT THE FUNCTIONS
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B)
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL

NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER

THAN THE SOFTWARE) UPON WHICH THE SOFTWARE'S
PERFORMANCE DEPENDS WILL CONTINUE TO BE
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND
(E) REGARDING THE USE OR THE RESULTS OF THE USE
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS,
ACCURACY, RELIABILITY, OR OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN
BY SONY OR AN AUTHORIZED REPRESENTATIVE OF SONY
SHALL CREATE A WARRANTY, DUTY OR CONDITION OR
IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY.
SHOULD THE SOFTWARE PROVE DEFECTIVE YOU ASSUME
THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR
OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW
THE EXCLUSION OF IMPLIED WARRANTIES, SO THESE
EXCLUSIONS MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as
“SONY") SHALL NOT BE LIABLE FOR ANY INCIDENTAL

OR CONSEQUENTIAL DAMAGES FOR BREACH OF ANY
EXPRESS OR IMPLIED WARRANTY, BREACH OF CONTRACT,
NEGLIGENCE, STRICT LIABILITY OR UNDER ANY OTHER
LEGAL THEORY RELATED TO THE SOFTWARE, INCLUDING,
BUT NOT LIMITED TO, ANY DAMAGES ARISING OUT OF
LOSS OF PROFITS, LOSS OF REVENUE, LOSS OF DATA,
LOSS OF USE OF THE SOFTWARE OR ANY ASSOCIATED
HARDWARE, DOWN TIME AND USER'S TIME, EVEN IF ANY
OF THEM HAVE BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. IN ANY CASE, EACH AND ALL OF THEIR
AGGREGATE LIABILITY UNDER ANY PROVISION OF THIS
EULA SHALL BE LIMITED TO THE AMOUNT ACTUALLY
PAID FOR THE PRODUCT. SOME JURISDICTIONS DO NOT
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL
OR CONSEQUENTIAL DAMAGES, SO THE ABOVE
EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL
INFORMATION, LOCATION DATA, DATA
SECURITY

You acknowledge and agree that SONY and its affiliates,
partners and agents may read, collect, transfer, process
and store certain information collected from the
SOFTWARE, including but not limited to information
about (i) the SOFTWARE and (ii) the software

applications, contents and peripheral devices that
interact with your wireless adapter and the SOFTWARE
("Information”). Information includes, but is not limited
to: (1) unique identifiers relating to your wireless adapter
and its components; (2) performance of the wireless
adapter, the SOFTWARE and their components; (3)
configurations of your wireless adapter, the SOFTWARE
and the software applications, contents and peripheral
devices that interact with the wireless adapter and the
SOFTWARE; (4) use and frequency of use of the functions
of (x) the SOFTWARE, and (y) the software applications,
contents and peripheral devices that interact with the
SOFTWARE; and (5) location data, as indicated below.
SONY and its affiliates, partners and agents may use
and disclose Information subject to applicable laws in
order to improve its products and services or to provide
products or services to you. Such uses include, but are
not limited to: (a) administering the functionalities

of the SOFTWARE; (b) to improve, service, update or
upgrade the SOFTWARE; (c) improving, developing and
enhancing the current and future products and services
of SONY and other parties; (d) to provide you with
information about the products and services offered by
SONY and other parties; (e) complying with applicable
laws or regulations; and (f) to the extent offered,
providing you with location-based services of SONY
and other parties, as indicated below. In addition, SONY
retains the right to use Information to protect itself and
third parties from illegal, criminal or harmful conduct.

Certain services available through the SOFTWARE may
rely upon location information, including, but not limited
to, the geographic location of the wireless adapter. You
acknowledge that for the purpose of providing such
services, SONY, the THIRDPARTY SUPPLIERS or their
partners may collect, archive, process and use such
location data, and that such services are governed by the
privacy policies of SONY or such third party. By reviewed
the privacy policies applicable to such services and
consent to such activities.

SONY, its affiliates, partners and agents will not
intentionally use Information to personally identify the
owner or user of the SOFTWARE without your knowledge
or consent. Any use of Information will be in accordance
with the privacy policies of SONY or such third party.
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Please contact applicable contact address of each area or
country for SONY's current privacy policy. Please contact
applicable third parties for privacy policies relating

to personally identifiable and other information you
provide when you use or access third party software or
services.

Information may be processed, stored or transferred

to SONY, its affiliates or agents which are located in
countries outside of your country of residence. Data
protection and information privacy laws in certain
countries may not offer the same level of protection

as your country of residence and you may have fewer
legal rights in relation to Information processed and
stored in, or transferred to, such countries. SONY will
use reasonable efforts to take appropriate technical and
organizational steps to prevent unauthorized access to
or disclosure of Information, but does not warrant it will
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE

From time to time, SONY or the THIRD-PARTY SUPPLIERS
may automatically update or otherwise modify the
SOFTWARE, including, but not limited to, for purposes
of enhancement of security functions, error correction
and improvement of functions, at such time as you
interact with SONY's or third parties’ servers, or
otherwise. Such updates or modifications may delete
or change the nature of features or other aspects of the
SOFTWARE, including, but not limited to, functions you
may rely upon. You acknowledge and agree that such
activities may occur at SONY's sole discretion and that
SONY may condition continued use of the SOFTWARE
upon your complete installation or acceptance of such
update or modifications. Any updates/modifications
shall be deemed to be, and shall constitute part of, the
SOFTWARE for purposes of this EULA. By acceptance of
this EULA, you consent to such update/maodification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY's privacy policy, each as amended
and modified from time to time, together constitute the
entire agreement between you and SONY with respect
to the SOFTWARE. The failure of SONY to exercise or
enforce any right or provision of this EULA shall not
constitute a waiver of such right or provision. If any part
of this EULA is held invalid, illegal, or unenforceable,

that provision shall be enforced to the maximum extent
permissible so as to maintain the intent of this EULA,
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION

The United Nations Convention on Contracts for the
International Sale of Goods shall not apply to this EULA.
This EULA shall be governed by the laws of Japan,
without regards to conflict of laws provisions. Any
dispute arising out of this EULA shall be subject to the
exclusive venue of the Tokyo District Court in Japan, and
the parties hereby consent to the venue and jurisdiction
of such courts.

EQUITABLE REMEDIES

Notwithstanding anything contained in this EULA to the
contrary, you acknowledge and agree that any violation
of or noncompliance with this EULA by you will cause
irreparable harm to SONY, for which monetary damages
would be inadequate, and you consent to SONY
obtaining any injunctive or equitable relief that SONY
deems necessary or appropriate in such circumstances.
SONY may also take any legal and technical remedies
to prevent violation of and/or to enforce this EULA,
including, but not limited to, immediate termination of
your use of the SOFTWARE, if SONY believes in its sole
discretion that you are violating or intend to violate

this EULA. These remedies are in addition to any other
remedies SONY may have at law, in equity or under
contract.

TERMINATION

Without prejudice to any of its other rights, SONY may
terminate this EULA if you fail to comply with any of its
terms. In case of such termination, you must: (i) cease
all use, and destroy any copies, of the SOFTWARE; (ii)
comply with the requirements in the section below
entitled “Your Account Responsibilities”.

AMENDMENT

SONY RESERVES THE RIGHT TO AMEND ANY OF THE
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED
BY YOU, BY PROVIDING NOTICE AS PART OF THE
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF

NOTICE. If you do not agree to the amendment, you
should promptly contact SONY for instructions. Your
continued use of the SOFTWARE after the effective date
of any such notice shall be deemed your agreement to
be bound by such amendment.

THIRD-PARTY BENEFICIARIES

Each THIRD-PARTY SUPPLIER is an express intended
thirdparty beneficiary of, and shall have the right to
enforce, each provision of this EULA with respect to the
SOFTWARE of such party.

Should you have any questions concerning this EULA,
you may contact SONY by writing to SONY at applicable
contact address of each area or country.

Copyright © 2012 Sony Corporation.

A—TIV—ZAVTRITTD
A4 ICDWNT

ARBICE. BENZOBEEELDOS Y
ZAEHCEIETFERALTVBY IO 7HEE
INTVET.

YUY IRNIITOEFIEBOERICED T, K
HIFTNEORBEBERICBMTZEBEH D
YEY,

SAtEYZRAB(FEN) (CELTIE. DR A
EV-—HNICERINTVET,
ALYV EIZX AN —TERL.
TPMHOME; - TLICENSE | RIC$ 37 71L&
—BKIET W,

Macz ZEROHZEEF. AEDOTPMHOME] -
FLICENSE] [Z PV ERATERWVWZENBYET,
TP EFRCERIEMacAA 2B EVWETEL
M. FEURLIZFZI7EALTI 7L EZERL<
TV,
https://0ss.sony.net/License/ILME-FX6/


https://oss.sony.net/License/ILME-FX6/

FREEELT7 79— —EX

RELE

e ZNHBICIHRIAZENFMAINTVETOT,
SEVLETOBRSRIFRYS T,

s IENFRDEASLULHANBEHHEN S
DI5Z. KYICRELTLRET W,

7II—H—EX

AFHBEVNETEFETFIVvI%

COHBEZLSI—ETEICH>THANES
L,

ZNTHEGHEBVEER

SEVLTFOE, FFVI—oME#KRBROCS

BT,
RELHAR R OEE L

RAZOELBRBICEDVWTEETETVER
FTFT, FLLRRIASLETELLT,

RELHARE B DIEET

ERICLOTHREN I TETZIHE. JTREIC
JYBERMEEIETVEREET.



139

8E I

(AR5

olAY
X

=

fein

#1890 g(FiFDH)
#12.59 kg(SEL24105GL > X, LYXT—R,
Nw51)— (BP-U35), Ea—77
A= N\VRIL T TEED)
FASIA B
141R—I 808
DC19.5V(18.0V ~20.5V)
HEEAH
#118.0 WA, LY X, XAVC-I QFHD
59.94PE R, Fa—Tr71V4—
BUTEE, SNEREEESIESEL)
#136.0 W(AR, L Xff, XAVC-I QFHD
59.94PECERMF(S&Q120fps) .
Ea—774 249 —RT8. HDMI,
SDI. ShERgRsiEstinF% F M)
}ERE
0°C~40°C
RERE
—20 °C~+60 °C
R e
#110543 (BP-U35{ FHE)
(Afk. L>Zft. XAVC-I QFHD
59.94PECREE, Pa—Tr71V4—
BUTEE, SMERBEESIESEL)
/I —IYNNETH)
XAVC Intra
XAVC-| 4K/QFHDE—NR:
CBG. |AEYkL—k
600 Mbps.
MPEG-4 AVC/H.264
XAVC-| HDE—NR:
CBG. |AEYkL—k
223 Mbps. MPEG-4 AVC/H.264

XAVC Long
XAVC-L QFHDE—K:
VBR. RAKEw kL —HM50 Mbps.
MPEG-4 H.264/AVC
XAVC-LHD 50 E€—K:
VBR. sKEw kL —K50 Mbps.
MPEG-4 H.264/AVC
XAVC-LHD 35F—R:
VBR. &KEwhkL—K35 Mbps.
MPEG-4 H.264/AVC
BRI+ —IYNF—FT1F)
LPCM 24Ew ., 48 kHz, 4F+v>xIL
s/ IL—LL—b
XAVC Intra
XAVC-l 4KE—RK:
4096X2160/59.94P, 50P,
29.97P, 25P. 24P, 23.98P
XAVC-l QFHDE—R:
3840X2160/59.94P, 50P,
29.97P, 25P, 23.98P
XAVC-|HDE—K:
1920X1080/59.94P, 50P,
29.97P, 25P, 23.98P
XAVC Long
XAVC-L QFHDE—K:
3840X2160/59.94P, 50P,
29.97P, 25P, 23.98P
XAVC-LHD 50 E€—K:
1920X1080/59.94P, 50P,
29.97P, 25P, 23.98P
XAVC-LHD 35&—R:
1920X1080/59.94P, 50P,
29.97P, 25P, 23.98P
iR - BAERR
XAVC Intra
XAVC-l QFHDE—R:
59.94P
#1304 (CEA-G160T{E FIB%)
XAVC-|HDE—K:
59.94P
#1789 (CEA-G160THE FIB%)

XAVC Long

XAVC-L QFHDE—R:

59.94P

#1115 (CEA-G160T/E FRB)
XAVC-LHD 50 E—R:

59.94P

#1155 (CEA-GSOTHE FB%)
XAVC-LHD 35E—R:

59.94P

#1210 (CEA-G8OTHE FB)

[TFE]
SBREARREIE. FRAREFPATY-OFERECLY.
SVORENELZEENBYET, Fi. iR - BER
Bk, 170y FELCERRRLIETOBRETY, i
I20)wTRICL>TIHEHOREE LWIE<ZZH/BEN
HYUET,

HASER
RERT
3I5Smm7ILE A ZHEHERCMOSAA -t
-Ij—_
[FE:

12.9M(total)
10.2M(effective)
F—hT7#—hHR
BREAR  AMEEREAN/OY NS MRE
AR
REND 7 1LY —
CLEAR : OFF
1:1/4ND
2:1/16ND
3:1/64ND
1)Z78[ZND : 1/4ND ~ 1/128ND
ISOREE
ISO 800/12800(Cine EIE— K, D55 Light
source)
LYZXIovk
EZI>k

FT4Fa1—R
15+ stops
DAL AP Sl N
64F ~1/80007(23.98PH})
Sy H =7 I
5.6°~360°, 2 ~ 64frame
20—-& A4y 7E€—>3>
XAVC QFHD : 1 ~120 fps
XAVCHD :1~240 fps
XAVC 4K : 1~ 60 fps
XAVC HD(S35) :1~120 fps
RIARINSUR
2000 K~15000 K
gAY
—3 dB ~+30 dB(1 dBEifi)
BEARILwY
S-Cinetone. Standard. Still. ITU709,
s709. 709(800%). S-Log3.
HLG Live. HLG Natural

Zr—F 4 ZER
YoV TRKE
48 kHz
BT
24w~
EprEesd
AAEXLRAAMICE— RBF : 20 Hz ~ 20 kHz
(3 dBLLA)
AMEXLRA ALINEE— KB : 20 Hz ~ 20 kHz
(3 dBLLA)
FAFZvILVY

AAEXLRAAMICE— KBS : 80 dB(Typical)
AAEXLRAALINEE — RBF : 90 dB(Typical)
UTHE
AEXLRAAIMICE—RBEF : 0.08% AT
(AALARIL—40 dBukF)
AEXLRAFILINEE—RBEF : 0.08% AT
(AALARIL+14 dBuUB%)



140

8E iR {tix

RERE—h—
€/
AAERE 1Y
€/
INYRILAEY ALY
EIEEEZTLAILI LY OV T oY —
A7

[Z5EE]
INY RILEBRFI/N\Y RILRBRA I OHFNBEMICIEY £
ER

A 7188

AA
INPUT 1/2:
XLREY, 3>, [
LINE / MIC / MIC+48VY]v) & Z AT &E
MIC : Reference —30 dBu ~—80 dBu
TCIN:
BNCH!

7

SDI OUT:
BNCE, 12G-SDI. 6G-SDI.
3G-SDI(Level A/B). HD-SDI
AYRRU(ZAFLAZTZTIvvY) -
—16 dBU(B#EL NI)LEAH, EZY—KRUa—LA
RBA. 16 QEHE)
HDMI :
TypeA. 19E>
TCOUT:
BNCH!

ZF D1t
DCIN:
EIAJIZ#, DC18V ~20.5V
IWNFAI—TI1—Aa—:
BEH2EY
REMOTE :
2503224947
)y ) EIVIFF:
3.5¢p 4fBstereo mini¥v v (EEINZ S
Yy FYEIVERIRIY-)
USB-C:
USB3.2 Gen1
USB/VILF:
2.0MMBEEMT X Z S L — Y EmicroB& 1 7 (1)
VF:
HRH40EY

RINED

Ea—77414>4— (LCD)
BEEYCX

%$£58.8 cm(3.58)
TR

16:9
BEHRE

1280(H) X720(V)

—_—

AF 4720w REB

CFexpress Type A/SDA—RZ20Owv ~(2)

TAVLZLAN

KOS
IEEE 802.11a/b/g/n/ac
ERRBRRE T
2.4 GHz#®/5 GHz
tFal7a
WEP/WPA-PSK/WPA2-PSK
gEHRAN
Wi-Fi Protected Setup™ (WPS)/<¥=a7)L
TIEZIAR
AVISANIVFv—E—R

FEm

ACPST9— (1)
BRI—R()

NV RIL()

LCDEZ9— (1)
USB-C—FIL(1)
g)wF)EIV()
LCDZ7—R()
J—-IILRYa—Fv k(1)
(A=ILRYa— (1), Ya—/n=x1).
LyZI9vhFvvr(1)
NV RILIEFREF v (1)
CHERAICHBEIZ()
REEZE(1)

Ez(4))

AFRBLUNEL. RBRDHTFERKEET
BENBYETH, TTEET W,

o WEBRICEBTIAMEITV., ERICREHRY
NTVWBZEHEERLTI TV, KD
BATATREAERDP, AI—ZNSOFRE
BILLUERBRINLED SEIHEDEEERETD
REICDOVWTIE., TERCETW,

o BEWICLEZHIC., BT EEESEAIToT<
BTV, MEZ0MICHESEZE LORRIE
KF (RIS S S URAHHARZBEREIC
hhbh5d, HEFVELIMETOTTT
AT,

o REBAFRALECEICLZBERKR. £Z
FE=FEDNSOWHEZFERICOVTH, Hit
F—vInEFEEVINET,

o AN, BBRATAPECERINLT—4
DEX. BE BROBZFEVNNRET,

o HEBICLZARRICEETZH—EIDE
k. FFCOVT, —YIoEEEEVHRE
ER




141 | 8F {I&R: {i#k

A=

BAfiL : mm
252525
N 8-UNC'/,-20
J\‘ﬂr:lc—- ITJ% -
143 0 0L i
K= M 60 (114
IR Ny 7
Lﬁ) [@fe] 4
] >
2-UNC"/,-20 e
258
2-UNC/,-20 UNC'/,-20

228
116 : @
:
153
UNC '/,-20 UNC 3/4-16

‘\ﬁﬁ’ —

/ m)}

= 7

o2 = g
28

M EISBIEIETT.



142

8E iR {tix

BIEICDW\WT

e X BV _—HKARHOEIETT.,

o "XAVC"E LU FYZ-KASHOER
BIETY,

e HDMI. High-Definition Multimedia
Interface. BLUHDMIOTF. KEH
LUZDMOEICHFBHDMI Licensing
Administrator, Inc. OEIEF 2. EREE
TY.

e Microsoft. Windowsld. Microsoft
Corporation®KES LU ZDMOEICHF
BEREBRELEIHEETT.

e Mac. macOSIZApple InCOXEH LUZ
DHOEICETZ2EREIFECT.

e “Catalyst Browse". “Content Browser
Mobile”. “Content Browser Mobile"O3d
FBY %A OBEEEIEREIZTT.

o iOSIE REYZIOEFL L FERBIFECTT.

e Android. Google PlaylZGoogle Inc.O&
BEEEEEEIETT.

e Wi-Fi, Wi-FiDd. Wi-Fi PROTECTED
SETUPI(ZWi-Fi Alliance DEEIE £ 7= (X B &RiF
T T,

o IBYAT—4111F. RASUANTTRIE
DEFEIRTT.

e N¥—%(ENFC Forum,Inc. DKEE LUZFD
HMOEICHT2EFEH D VIEEREIRTT,

e SDXCOIXSD-3C,LLCOEIETT.,

e CFexpress Type A0, CFexpressld
CompactFlash AssociationDEETT,

roMOsHAs VSR aongy  LoXMOr =R XAVC

BRERBIBIRETY. BH. AXPTE™, °7—

JRBRLTVE YA, Holmil ==r

\

CF

express

7 A



	目次
	1章　概要
	システム構成例
	各部の名称と働き
	タッチパネルの使いかた
	画面表示

	2章　準備
	電源の準備
	機器の取り付け・調整
	本機の基本動作を設定する
	メモリーカードを使う

	3章　撮影
	基本操作手順
	ズームを調節する
	フォーカスを調節する
	明るさを調節する
	自然な色合いに調節する（ホワイトバランス）
	収録する音声を設定する
	便利な機能
	プロキシ記録をする
	好みのルックで撮影する
	ポストプロダクションでルックを調節する前提で撮影する
	RAW動画を記録する

	4章　ネットワーク機能
	デバイスとLAN接続する
	インターネット接続する
	ファイルを転送する

	5章　サムネイル画面
	サムネイル画面
	クリップの再生
	クリップ操作

	6章　メニュー表示と詳細設定
	フルメニューの構成と階層
	フルメニューの操作方法
	Userメニュー
	Edit Userメニュー
	Shootingメニュー
	Projectメニュー
	Paint/Lookメニュー
	TC/Mediaメニュー
	Monitoringメニュー
	Audioメニュー
	Thumbnailメニュー
	Technicalメニュー
	Networkメニュー
	Maintenanceメニュー
	Shootingメニューの設定値と初期値について
	撮影モードごとの画質に関する設定状態の保存について
	設定データの保存と読み込み

	7章　外部機器接続
	外部モニターや記録装置を接続する
	タイムコードを合わせる
	コンピューターでクリップ管理・編集する

	8章　付録
	使用上のご注意
	出力のフォーマットと制限
	トラブル時の対処
	エラー/警告表示
	ファイルに保存される項目
	ブロックダイヤグラム
	Eマウントレンズのソフトウェアをアップデートする
	ライセンスについて
	保証書とアフターサービス
	仕様




